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Google and Google AdWords 

Google and Google AdWords

Objective: Learn about Google search and Google AdWords, and see how 
AdWords relates to the concepts of Internet search engines and keyword 
advertising. 

About Google Search

As a search engine, Google gathers and organizes a multitude of 
information from the Internet, then makes this information available to 
online searchers throughout the world. 

Users can simply visit the Google homepage or other Google domains, 
enter a search query (terms related to information they'd like to find) into 
the search field, and click Google Search. Google returns a variety of 
search results — including lists of files, articles, documents, and websites 
— that are all highly relevant to the query. (If a user clicks I'm Feeling 
Lucky, the user goes directly to the first website or document in the 
Google search results.) Users can also search for results within Google 
Images, News, and other specialized Google services. 

Search results appear on the left side of the page. It's important to note 
that Google doesn't accept payment to place websites or documents in 
search results. However, advertisers can purchase Google AdWords ads, 
which appear on the right side of the page, and sometimes above the 
search results. 

About Google AdWords

Google AdWords is Google's advertising program. AdWords lets you 
create simple, effective ads and display them to people already searching 
online for information related to your business. So how is it possible to 
show your ads only to the most relevant audiences? The answer is 
keyword-based advertising. 

When a searcher visits Google and enters a query — say, good beginner 
guitars — Google displays a variety of relevant search results, such as 
links to articles containing guitar purchasing advice, or websites dedicated 
to novice musicians. Google also displays AdWords ads that link to online 
businesses selling guitars, music lessons, or other products and services 
related to the query. 

For example, imagine that you own a music store carrying a large 
selection of guitars. You could sign up for an AdWords account and create 
ads for entry-level guitars in your inventory. For each of your ads, you 
might select keywords (single words or phrases related to your ad's 
message) such as beginner guitars or entry-level guitars. 

Once you activate your account, your ads would be eligible to appear. That 
is, the AdWords system would constantly seek out search queries related 
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to the keywords you've selected, then display your ads to highly targeted 
audiences. In short, you'd be advertising directly to an audience already 
looking for you. 

About Google AdWords Ads

Google AdWords offers a variety of ad formats. The most common 
format is text ads, followed by image (and animated) ads. Additional 
formats available include video ads, local business ads, and mobile ads.

A typical AdWords text ad looks like this: 

Try Google AdWords 
Maximize your ROI. Attract 
new customers. Sign up today. 
adwords.google.com

Text ads generally contain the following four lines: 

Headline (25 characters, including spaces): The title attracts 
users who might be interested in your products or services.

■

Description (two lines of up to 35 characters each, including 
spaces): These two lines contain your product, service, and other 
details (such as promotions). The content in these lines should be 
clear enough to communicate your intent and compelling enough 
to convince the user to click your ad and visit your site.

■

Display URL (35 characters, including spaces): This line indicates 
which website the user will visit if he or she clicks your ad. 

■

Destination URL (up to 1024 characters): This is the actual page 
where users land when they click your ad. The URL won't appear 
in your ad. Many advertisers link their ads to particular destination 
pages within their website, but use the simpler URL of their 
homepage as the display URL.

■

Certain wide characters and double-byte characters will reduce the 
number of characters permitted per line.

To learn about other ad formats, review the Using Different Ad Formats 
lesson. 

Basic AdWords Features 

Basic AdWords Features

Objective: Learn some basic AdWords terminology. Understand the 
benefits of the Google Network, language and location targeting, and 
placement targeting.

About the Google Network

With Google AdWords, your ads are eligible to appear on the Google 
Network — comprising thousands of high-quality search and content sites 
and products across the web — in addition to Google search results 
pages. Electing to show your ads on the Google Network can greatly 
expand your marketing presence to customers you might not have 
reached on Google alone. 

The Google Network is divided into the Google search network and the 
Google content network. Advertisers can choose to show their ads on 
either or both of these networks.
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Google search network: Includes Google search pages, search 
sites, and properties that display search results pages, such as 
Froogle and Earthlink. AdWords ads can appear alongside or 
above search results, as part of a results page as a user navigates 
through a site's directory, or on other relevant search pages.

■

 
Google content network: Includes news pages, topic-specific 
websites, blogs, and other properties - such as Gmail and The New 
York Times. AdWords ads can appear on a webpage if the content 
and URL of that page relate to the ad. 

■

To learn more about the Google Network, see the Search and Contextual 
Targeting lesson.

Basic AdWords Definitions

Using Google AdWords for the first time may introduce you to some new 
terminology. Here are a few of the most commonly used AdWords terms. 

Cost-per-click (CPC): Under its cost-per-click (CPC) pricing model, 
AdWords charges you for each click your ads receive. You won't incur any 
costs if your ad is displayed for a search query and users don't click it. 

Quality Score: Quality Score is the basis for measuring the quality of your 
keyword and ad and determining your cost-per-clicks (CPCs). Quality 
Score is determined by your keyword's clickthrough rate (CTR), relevance 
of your ad text, historical keyword performance, and other relevancy 
factors. The higher your Quality Score, the lower the price you'll pay per 
click.

First page bid estimates: You can find a first page bid estimate for each 
of your keywords on the Keyword Analysis page. This metric estimates the 
cost-per-click (CPC) bid needed for your ad to reach the first page of 
Google search results when the search query exactly matches your 
keyword. The first page bid estimate is based on the Quality Score and 
current advertiser competition for that keyword. 

Clickthrough Rate (CTR): Your clickthrough rate (CTR) is a metric that 
helps show how your ads are performing. The more relevant your ads are, 
the more often users will click on them, resulting in a higher CTR. The 
system calculates your CTR as follows: Number of ad clicks/number of 
impressions x 100. 

To learn about more common terms, visit our full Glossary.

About Language and Location Targeting

A significant benefit of AdWords is the ability to target your ads to almost 
any language and location worldwide. For example, you can target your 
ads to Spanish speakers in California or to Portuguese speakers in Brazil.

This language and location targeting functionality lets you tailor your ads 
and promotions to increase your business's appeal to a variety of 
audiences.  
 
To learn more, see the Language and Location Targeting lesson. 

About Keyword and Placement Targeting

AdWords offers two ways to target ads: 

With keywords ■
With placements ■

Keyword targeting is Google's traditional advertising model, whereby 
advertisers select keywords that can trigger their ads to appear on Google 
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search pages and on the Google content network. (Unless specified, most 
of the content in the Learning Center focuses on keyword-targeted 
advertising.)

Placement targeting lets advertisers choose individual sites in the Google 
content network where they'd like their ads to appear. A placement can be 
an entire website, or it can be a subset of pages or ad units on a site, as 
defined by site's publisher. For example, a news site might offer you the 
chance to place your ads across its entire site, only on its front page, or 
just in ad units on the upper half of its sports pages. 

Placement targeting gives advertisers even greater flexibility to control 
exactly where their ads show. Keywords and placements are both 
available in AdWords campaigns. You can target keywords only, 
placements only, or both keywords and placements to reach the audience 
you most want for your ads. 

To learn more, visit the Keyword Targeting and Placement Targeting 
lessons.

Benefits of AdWords 

Benefits of AdWords

Objective: Learn how Adwords provides a one-size-fits-all advertising 
medium.

Why Choose AdWords?

AdWords advertising lets you:

Target your ads specifically to people who are looking for your 
products or services.

■

Avoid showing your ads to users who aren't likely to purchase from 
you. 

■

Obtain the maximum return on your advertising investment.■

Reach: Each month, approximately 80% of Internet users in the United 
States (and hundreds of millions more worldwide) view AdWords ads. 
AdWords can offer you instant access to this vast audience of potential 
customers. 

Cost: AdWords is cost-effective for businesses of all sizes. 

You can choose to pay for ad clicks (CPC) or for impressions 
(CPM).

■

Because you can choose your own CPC or CPM amounts, you 
decide how much you'll pay each time someone clicks or views 
your ad. 

■

There's no minimum spending limit. In addition, you can set a 
maximum daily spend (daily budget) that the AdWords system won't 
exceed. 

■

You can edit your budget settings at any time. ■

To learn more about AdWords pricing, see the Pricing and Ranking lesson.

Timing: Google AdWords ads engage potential customers at precisely the 
right moment — when users are actively searching for information 
(keywords or content) related to your business. Your AdWords ads ensure 
that your website is only a single click away. 

Flexibility and Control: 

You can edit an existing ad, then see your updates within 15 
minutes. 

■

You can edit your account at any time, as often as you like. 
AdWords is available 24 hours a day, 7 days a week. 

■
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Ads start running for the first time almost immediately after you 
activate your account with your credit card or direct debit 
information. (Advertisers in certain countries can pay by bank 
transfer. In this case, ads run when we receive the first payment). 

■

AdWords Link Policy 

AdWords Link Policy

Objective: To learn how to create ads that comply with the link policy.

Link Policy Overview

URL stands for Uniform Resource Locator, and is commonly called a web 
address. There are two URLs associated with each AdWords ad: display 
URL and destination URL. The two types are explained below, along with 
the guidelines for each. Also outlined below are the requirements for the 
website to which your ad links. 

Display URL: AdWords ads include a display URL. For example, the 
display URL in the ad below is 'www.books.com.' 

Books 
Buy a book 
Read and become smarter! 
www.books.com

So as not to mislead users, the display URL should give users a clear idea 
of the website or landing page to which they will be taken when they click 
on an ad. Display URLs must:

Indicate who owns the destination URL, but does not need to match 
the actual destination URL of the landing page exactly. 

■

Appear to be a viable website address. It must include the 
appropriate extension such as '.com,' '.net,' and 'co.uk,' but 'www' 
and 'http://' are not required. 

■

Represent a website. The display URL also cannot be an email 
address. For example, 'flowers@flowers.com' would not be allowed. 

■

Comply with editorial policy, which will be discussed in later topics. ■

Here is an example of a correct and an incorrect display URL:

Correct: 
Destination URL: bigbookstore.com/new/a-c.htm 
Display URL: bigbookstore.com 

Clicking on the ad takes users to a page within the bigbookstore.com 
website. Even though the display URL is different from the destination 
URL, it accurately represents where the user will be taken when he or she 
clicks on the ad. 

Incorrect: 
Destination URL: http://www.amazon.com/home.html/104-7002842-259 
Display URL: bigbookstore.com 

The display URL bigbookstore.com does not accurately represent the site 
to which the user will be taken, which is a page within the amazon.com 
domain. This is improper use of the display URL. An ad with this display 
URL would not be approved. 

 

Here are some of the guidelines included in our link policy:

AdWords Policies
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Destination URL: The destination URL is the web address of the landing 
page to which an ad will actually link. The guidelines surrounding the 
destination are designed to ensure users clicking on AdWords ads will find 
what they are looking for easily and quickly. Your ad will not be approved if 
your destination URL does not meet all three of the following rules:

It must link to a working website. If a user clicks on your ad but your 
site isn't working, you are charged for a click, but you have no 
chance to convert this user into a customer. 

■

It must not link to a site that is under construction or broken. The 
site must have content. Otherwise, users will not find what they are 
looking for. 

■

It must not require a program other than the browser to view the 
landing page. In other words, the destination URL must be an 
HTML page. Some unacceptable formats of destination pages 
include Adobe Acrobat and MS Word. If your site requires another 
program to load, not all users will be able to view your site without 
loading additional software. This detracts from the user experience. 

■

Back Button: After linking to your website, the back button must work 
properly and return the users to the page on which the AdWords ad is 
located within one or two clicks. 

Pop-Ups: Pop-ups are defined as any browser window that opens in 
addition to the original window, regardless of content, function, size, or 
source. When a user enters or leaves your site, no additional browser 
window, including pop-unders, should appear. Pop-unders are browser 
windows that open behind the original browser window. This policy is 
based on research indicating that users find pop-ups distracting, leading to 
a poor user experience. 

Affiliate Policy: Affiliates get paid a commission to promote a merchant's 
website and drive traffic or create sales on that site. We allow affiliates to 
use AdWords advertising. Please note that we will only allow one ad for 
affiliates and parent companies sharing the same display URL per search 
query. 

Please review the complete list of link policies.

AdWords Product Content and Editorial Policy 

AdWords Product Content and Editorial Policies

Objective: Learn about content policies regarding the kinds of products 
and services that may be advertised through Google AdWords, and about 
the editorial standards for AdWords ads.

AdWords Editorial Policy Overview

Below is a sampling of key AdWords editorial policies. Please refer to the 
detailed AdWords Advertising Policies pages for our complete set of 
Editorial & Format policies for each ad format. 

Spacing: You should have appropriate spacing between each word and 
after punctuation. For example, 'C-h-e-a-p C-l-o-t-h-e-s' would not be 
allowed. Similarly, 'Free Shipping.Buy Now' would also not be allowed. 

Punctuation & Symbols: Punctuation cannot be used to attract a user's 
attention. It should not be unnecessary or repeated two or more times in a 
row. In addition, your ad title cannot contain an exclamation point, and an 
ad can contain only one exclamation point in total. Furthermore, all 
symbols, numbers, and letters must adhere to their true meaning; you may 
not use them in place of words. For example, 'We have a huge selection 4 
U online!' is violating this policy because '4' and 'U' are replacing words.
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Grammar & Spelling: Ads must comply with basic grammar and spelling 
guidelines, using logical sentence or phrase form as well as correct 
spelling. Appropriate grammar and spelling greatly contributes to the clarity 
and credibility of your ads. The only exceptions to our spelling policy are 
commonly misspelled words or spelling variations that the majority of users 
would recognize and understand. If you can find the word in an online 
dictionary, it's generally acceptable. 

Capitalization: A word cannot appear in all capital letters to draw attention 
to that word or phrase. For example, 'FREE' or 'NEW' would not be 
allowed. However, capitalizing the first letter in each word of your ad is 
allowed.

Repetition: Repetition should not be used in a gimmicky manner or for the 
sake of promotion. Specifically, the same word cannot be repeated three 
or more times in a row. For example, an ad with the title 'Deals, Deals, 
Deals Here' would not be allowed. The ad title should be replaced with a 
phrase like 'Amazing Deals Here' to comply with this policy requirement. 

Inappropriate Language: Ads, including the display URL, cannot contain 
language that may be considered inappropriate or offensive to some 
users. This also applies to misspellings, self-censored, or other variations 
of inappropriate language. 

Unacceptable Phrases: Certain 'call-to-action' phrases cannot appear in 
the ad text if they are not descriptive of the product, service, or website. 
For example, a generic phrase like 'click here' would not be allowed. An 
example of a good 'call-to-action' phrase would be 'Order Your Online 
Contacts Today' because it is representative of the product and the site 
content.

Superlative Claims: Superlatives are words that emphasize superiority. In 
the interest of making sure users feel they are being treated in an honest, 
credible manner, your ad text cannot contain comparative or subjective 
phrases such as 'Best' or '#1' unless verified by a third party. This 
verification must be clearly displayed on your website. 

For example, if an ad claims to be the 'Best of the Web,' the site must 
display third party verification of the claim. A Forbes Magazine seal 
indicating this site received a best of the web award would be acceptable, 
and the ad would comply with this policy. 

Competitive Claims: Competitive claims are claims that imply that your 
product/service is better than a competitor's. Competitive claims in your ad 
text must specifically be supported on your landing page. This establishes 
trust with your user and ensures that the user is finding exactly what they 
expect to find based on your ad text. 

You can offer support for your claim in a variety of ways such as a chart or 
table that compares the features of your product versus your competitor's 
product or a competitive analysis discussing why your product is superior. 

For example, ad text that states 'better than SmartFilter' would be 
considered a competitive claim and would require support on the website. 
If the landing page includes a competitive analysis of the advertiser and 
SmartFilter, this claim would be acceptable and the ad would be approved.

Offer Not Found: Any specified price, special discount, or free offer 
displayed in ad text must be clearly and accurately supported within 1-2 
clicks of your ad's landing page. Examples of offers that must be 
supported include '50% off all items,' 'Save $20 on first purchase,' 'free hat 
with purchase,' 'DVDs for $5 each' and similar phrases. Prices in your ad 
text must be accurate. Prices can also apply to bulk purchases. For free 
offers, it is acceptable if the user can infer that the product is indeed free, 
even if the word 'free' does not appear along with that product or service.

Screened Products Content Policy Overview

The goal of our Content Policy is to provide an advertising service with fair 
and consistent policies that benefit our users, advertisers, partners, and 
Google.
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To run your ads on Google or our growing network of sites, products, and 
services, you must adhere to all of our policies.

Application of our policies will always involve an element of discretion, and 
we reserve the right to reject or approve any ads. Please note that the 
decisions we make concerning advertising in no way affect the search 
results we deliver.

Ads and keywords are screened for products that:

May be subject to legal regulations and/or restrictions■
May contribute to a negative user experience■
May be contrary to Google's values or policies■

For a list of the products we currently monitor, please see our Content 
Policy.

Please be aware that these products and services are subject to change, 
as are the guidelines governing this list. Please refer to Google's online 
guidelines frequently to ensure that your ads and keywords are complying 
with these guidelines.

AdWords Image Ads Policy 

AdWords Image Ads Policy

Objective: Learn how to create image ads that comply with the image ads 
guidelines.

Image Ad Guidelines

Image ad policy regulates the type and quality of images that you may use 
in your image ads. The goal is to maintain standards for image quality and 
content, to ensure user satisfaction and your success. 

The policy covers image ads specifications, such as ad and image quality, 
unacceptable image content, and image layout.

It's important to note that: 

Your image ads must adhere to the policies that apply to text ads, 
as well as these additional policies for image ads. 

■

Image ads are available in many languages. Here is a complete list.■
Image ads are not shown on Google search results pages. Image 
ads are shown on some partner sites.

■

Guidelines summary:

Quality: Google does not allow images to be of poor quality. Images must 
be clear and readable. The content and purpose must be easy to 
understand, and all text must be clear and legible. 

Deceptive Tactics: AdWords does not allow mock animated features, 
such as mock drop down menus, search boxes, or other functionality that 
does not actually work for the user. Mock dialog boxes or error messages 
such as those generated by windows or Internet Explorer are not allowed. 
Clicking on these drop downs or boxes will be registered as a click on the 
image ad, and thus these features are unnecessary and deceptive.

Image Ad Layout: Image layout guidelines govern the size and orientation 
of your ad. Image ads have specific height and width requirements, and 
must completely fill the area of the size you choose. Otherwise, image ads 
may not look correct on partner sites since images may be much smaller 
than the format chosen. Images cannot be rotated or inverted. Images 
cannot show more than one ad at a time or the same ad multiple times. 

Image Ad User Bar: When your image appears on Google's partner sites, 
an image user bar will automatically be included. The user bar is 

Page 8 of 17خدمات تبليغات در گوگل www.BERTINA.us

خدمات تبليغات در گوگل www.BERTINA.us



comprised of a display URL, a link for users to give feedback to Google on 
the ad, and a designation that this ad is provided by Google. Since these 
features are already included by our automated system, you do not need 
to include any of them in the images you upload. Otherwise, the 
information will be duplicated. 

Image Ad Content: Just as we do for text ads, we have guidelines for 
appropriate content that can appear in images. Generally, the content of 
image ads must be family safe, meaning the images must be appropriate 
for viewing by minors. Therefore, your image ad cannot contain any adult 
material, sexual themes, or inappropriate language. Examples of ad 
content that would not be approved include an ad that promotes drinking 
alcohol, scantily clad women, and an ad for a porn site. 

Please review the complete list of image ad policies.

Google's Trademark Policy 

Trademark Policies

Objective: Understand Google's trademark policy and complaint 
procedures. 

What is a Trademark?

A trademark is a word, phrase, logo, or symbol that identifies and 
distinguishes a product or service from others in the marketplace. Multiple 
trademark owners may claim the right to the same term, as long as each 
owner operates in a different industry. Trademark ownership is location-
based, and therefore must be obtained on a country-by-country basis.

Google's Trademark Policy

With Google AdWords, advertisers may select trademarked terms as 
keywords or use them in the content of the ad. As a provider of space for 
advertisements, Google is not in a position to arbitrate trademark disputes 
between advertisers and trademark owners. As stated in our Terms and 
Conditions, advertisers are responsible for the keywords and ad text that 
they choose to use. Accordingly, Google encourages trademark owners to 
resolve their disputes directly with the advertiser, particularly because the 
advertiser may have similar ads on other sites. However, as a courtesy to 
trademark owners, Google is willing to perform a limited investigation of 
reasonable complaints. 

Google's trademark policy does not apply to search results, only to 
sponsored links. For trademark concerns about websites that appear in 
Google search results, the trademark owner should contact the site owner 
directly. 

Learn more about Google's trademark policy and copyright policy. 

Google's Trademark Policy Across Different Regions

When Google receives a complaint from a trademark owner for a region 
listed here, Google only investigates the use of the trademark in ad text. 
Google will not disable keywords in response to a trademark 
complaint in these regions.

In all other regions Google is able to investigate the use of the trademark 
at issue in ad text and/or keywords. Please note that Google's 
investigation will only affect ads served on or by Google.
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Google's trademark policy in the U.S. allows some ads to use trademarks 
in the ad text. Trademarked terms can be used in the ad text of ads that 
appear to be submitted by the following:

Resellers■
Informational sites■
Makers or resellers of components or parts for the goods and 
services related to the trademark term

■

Makers or resellers of compatible components or parts for the 
goods and services related to the trademark term

■

The product or services from resellers must be on the ad's landing page 
and must be clearly available for purchase from the ad's landing page.

The ads approved to run under the US policy which contain trademarks in 
the ad text, if not explicitly authorized by the trademark owner, will have 
limited serving, showing only in the US. The ads will not show on Google 
sites in other countries.

For more detailed information about the trademark complaint process and 
procedures, please visit Google's Trademark Complaint Procedure page.

AdWords Copyright Policies 

Copyright Policies

Objective: Understand Google's copyright policy and copyright claims 
procedure.

What is a Copyright?

A copyright is the legal right granted to an author, composer, playwright, or 
publisher to exclusive publication, production, sale, or distribution of a 
literary, musical, or artistic work. 

Google's Copyright Policy

Google's policy on copyrights pertains to website content and can apply to 
ads, search results, and Google Groups postings. Google's policy stems 
from the Digital Millennium Copyright Act (DMCA). Once a copyright owner 
submits a form with the required information, Google will investigate the 
claim per the DMCA and remove the allegedly infringing material, if 
appropriate.

In accordance with the DMCA, ads may be removed for copyright 
infringement reasons. Ad disapprovals due to copyright complaints may be 
contested through the DMCA counter notification procedure. 

Learn more about Google's copyright policy. 

Copyright Claims Procedure

For Google to investigate claims of alleged copyright infringement, the 
copyright owner must provide the following information in a signed letter on 
company stationery: 

Identify in sufficient detail the copyrighted work that you believe has 
been infringed. For example, 'The copyrighted work at issue is the 
text that appears on www.google.com/ads.' 

1.
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Identify the material that you claim is infringing the copyrighted work 
listed in item #1 above. This requires you to provide the search 
query that you used and the URL for each allegedly infringing ad. 

2.

Provide information reasonably sufficient to permit Google to 
contact you (email address is preferred.) 

3.

Provide information, if possible, sufficient to permit Google to notify 
the owner or administrator of the web page that allegedly contains 
infringing material (email address is also preferred.) 

4.

Include the following statement: 'I have a good faith belief that use 
of the copyrighted materials described above on the allegedly 
infringing web pages is not authorized by the copyright owner, its 
agent, or the law.' 

5.

Include the following statement: 'I swear, under penalty of perjury, 
that the information in the notification is accurate and that I am the 
copyright owner or am authorized to act on behalf of the owner of 
an exclusive right that is allegedly infringed.'

6.

Your signature.7.

The administrator of an affected site may make a counter notification. 
When we receive a counter notification, we will reinstate the material in 
question. To file a counter notification with us, you must provide a written 
communication that sets forth the items specified below.

Identify the specific URLs of material that Google has removed or to 
which Google has disabled access. For Google Groups, identify the 
sender, date, newsgroup, and subject matter of all the material in 
question.

1.

Provide your name, address, telephone number, email address, 
and a statement that you consent to the jurisdiction of Federal 
District Court for the judicial district in which your address is located 
(or Santa Clara County, California if your address is outside of the 
United States), and that you will accept service of process from the 
person who provided notification under subsection (c)(1)(C) or an 
agent of such person.

2.

Include the following statement: "I swear, under penalty of perjury, 
that I have a good faith belief that each search result or message 
identified above was removed or disabled as a result of a mistake 
or misidentification of the material to be removed or disabled."

3.

Your signature.4.

Where to Send Your Copyright Claim Letter

Copyright complaints, like Trademark complaints, should be mailed to the 
following address:

Google, Inc. 
Attn: Google AdWords, Copyright Complaints 
1600 Amphitheatre Parkway 
Mountain View, CA 94043 
USA 

You can also fax us your letter.  
In the US: 650-963-3255 
Outside the US: 011-650-963-3255 
Attn: Google Copyright Complaints 

Google's Invalid Clicks Policy 

Google's Invalid Clicks Policy

Objective: Learn how to define invalid clicks and explain the steps that 
Google takes to monitor invalid clicks on AdWords ads.
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What Are Invalid Clicks?

Invalid clicks are clicks generated by prohibited methods. Examples of 
invalid clicks may include repeated manual clicking or the use of robots, 
automated clicking tools, or other deceptive software. Invalid clicks are 
sometimes intended to artificially and/or maliciously drive up an 
advertiser's clicks and or a publisher's earnings. Sources of invalid clicks 
may include:

Manual clicks intended to increase your advertising costs or to 
increase profits for website owners hosting your ads. 

■

Clicks by automated tools, robots, or other deceptive software. ■

We closely monitor these and other scenarios to help protect advertisers 
from receiving invalid clicks. 

How Google Combats Invalid Clicks

The security of Google AdWords advertisers is important to Google. Our 
proprietary technology analyzes clicks and impressions in an attempt to 
determine whether they fit a pattern of use that may artificially drive up an 
advertiser's clicks. 

The goals of our system are to automatically identify clicks generated by 
unethical users and automated robots and to filter out these clicks before 
they ever reach your reports. However, if we believe you've been charged 
for invalid clicks in the past two months, we'll apply a credit to your 
account .

Google has three powerful tools for protecting clicks on AdWords ads: 

Detection and filtering techniques: Each click on an AdWords ad is 
examined by our system. Google looks at numerous data points for each 
click, including the IP address, the time of the click, any duplicate clicks, 
and various other click patterns. Our system then analyzes these factors to 
try to isolate and filter out potentially invalid clicks. 

Advanced monitoring techniques: Google uses a number of unique and 
innovative techniques for managing invalid click activity. We can't disclose 
details about the software, except to say that we're constantly working to 
expand and improve our technology. 

The Google Team: In addition to our automated click protection 
techniques, we have a team that uses specialized tools and techniques to 
examine individual instances of invalid clicks. When our system detects 
potentially invalid clicks, a member of this team examines the affected 
account to glean important data about the source of the potentially invalid 
clicks.

Identifying Invalid Clicks 

Identifying Invalid Clicks

Objective: Learn how to explain possible reasons for an increase in clicks, 
and why high click volume doesn't necessarily indicate invalid click activity.

Common Reasons for Click Increases

An ad may receive a large number of clicks for several legitimate reasons. 
The following factors may lead to an increase in clicks: 

Competitor Behavior: If a competitor has stopped running his or her ad, 
your ad may start receiving more clicks. 
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Google Network: You may see an increase in traffic if your ads have 
recently been approved to run on search and content sites and products in 
the Google Network, if you recently opted in to the Google Network, or if 
new sites for which your ads are relevant join our content network. Also, 
your ad may receive an unexpected increase in clicks if it appears on a 
site with a large audience. For example, if you run an ad for a weight loss 
product, you might see a significant increase in impressions and clicks 
when the online version of The New York Times runs a feature on weight 
loss. Please see the Search and Contextual Targeting lesson for more 
information about the search and content networks.

Seasonal Changes: Fluctuation in clicks due to seasonal promotions or 
special sales are common. Keywords popular at particular times of the 
year will also experience a higher click volume regardless of whether you 
have made proactive seasonal changes to your account content. For 
example, if you sell greeting cards, you may see a significant increase in 
clicks as a holiday approaches, even if you aren't advertising cards for that 
particular holiday. 

Budget Changes: Increasing your daily budget or maximum cost-per-click 
(CPC) may cause an increase in clicks and impressions. A higher 
maximum CPC can help to increase the position of your ad, which can 
lead to more clicks on Google and on the Google Network. 

Ad Relevancy: If your keywords are too general, your ad may accrue 
clicks and impressions but yield very few sales. To make sure your ads are 
running optimally, please refer to the Preparing to Optimize lesson.

Multiple Clicks from One Source

Even if an ad receives multiple clicks from a single source, the clicks aren't 
necessarily invalid. Be sure to consider the following possibilities if your 
weblogs show multiple clicks from a single source:

Internet service provider: an Internet provider (such as AOL, Earthlink, 
or Comcast) may assign identical IP addresses to multiple users by 
geographic area. 

Comparison shopping: individual users may legitimately click on your ad 
more than one time when comparison shopping or returning to your site for 
more information.

Identifying Invalid Clicks

If you believe your ads have been affected by invalid clicks, please follow 
the steps below before you contact us:

Identify instances of suspicious activity, such as receiving 2 or 3 
times the normal number of clicks you would receive on a single 
day. Keep in mind that you may see a sudden increase in 
impressions or clicks as a result of legitimate user activity, such as 
seasonal increases in clicks or the appearance of your ad on the 
Google Network. Google's proprietary technology works to filter out 
invalid impressions and clicks before they reach your reports. 

1.

Look at click patterns over time. Identify changes from week to 
week that aren't explained by any of the legitimate reasons for high 
click volume. See the Reports lesson to learn more about how to 
review your account activity. 

2.

Compare your weblogs to your AdWords account reports. (If you're 
not sure how to access your web logs, talk with your webmaster or 
website hosting service.) If your web logs show a higher number of 
clicks, remember that Google's technology works to filter out invalid 
clicks before they reach your reports. If your account shows a 
higher number of clicks, remember that Google relies on its own 
servers' web logs to supply site traffic data to include in your 
reports. By creating an AdWords account, advertisers agree to 

3.
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accept the Google AdWords reporting system and reported metrics 
as provided in the AdWords program Terms and Conditions. 

Investigating Invalid Clicks

If you believe that your account reports reflect clicks that are more extreme 
than ordinary user behavior or that exhibit strange patterns, please contact 
us. 

We have a team that investigates invalid click activity on a case-by-case 
basis. To expedite their time-intensive investigation, please include the 
following information in your email to us: 

The campaign(s), ad group(s), and/or keyword(s) associated with 
the suspicious clicks. 

1.

The date(s) and time(s) of the suspicious click activity. 2.
Any data in your weblogs or reports that indicate suspicious IP 
addresses, referrers, or requests. 

3.

A paragraph describing the trends in logs and/or reports that led 
you to believe the click activity is invalid. 

4.

The verification and research process can be time consuming, and we 
appreciate your patience while our investigation team reviews your 
account. Please allow 3-5 business days for us to respond. If you have any 
additional information, please be sure to let us know so we can include it in 
our review. 

AdWords Pricing 

AdWords Pricing

Objective: Learn how much AdWords costs. Understand how your daily 
budget, CPC or CPM bid, and Quality Score influence the amount you'll 
pay. 

About CPC and CPM Bids

In campaigns targeted to the search network, you set a cost-per-click 
(CPC) bid for each ad group or keyword in your campaign. Your CPC bid 
refers to the amount you're willing to pay for a click on your ad when the ad 
appears on Google or one of our partner sites. 

In campaigns targeted to the content network, you choose to make either a 
CPC bid or a cost-per-thousand impressions (CPM) bid for each ad group, 
keyword or placement in your campaign. A CPM bid refers to the amount 
you're willing to pay each 1000 times your ad appears on one of Google's 
partner sites. That means you pay when your ad shows, whether or not a 
user clicks the ad. 

Placement targeting is covered in more detail in the Placement Targeting 
lesson. CPM bidding is not available for campaigns that target the search 
network. CPM bidding is available for campaigns that target only the 
content network.

With both CPC and CPM pricing, you're in control of your bids. 
Additionally, AdWords helps keep your costs to a bare minimum with the 
AdWords Discounter and smart pricing. To learn more about these 
methods, visit the Cost Control lesson. 

Pricing and Ranking
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About Daily Budgets

Your daily budget is the amount you're willing to spend on a specific 
campaign each day. We'll show ads within a campaign as often as 
possible to meet your daily budget.

To help you set a daily budget that maximizes your ad's visibility, AdWords 
provides daily budget recommendations within your account. These 
recommendations are based on historical click data for the same or similar 
keywords that you choose for your ads, among other factors. 

If your daily budget is lower than the AdWords recommended amount, 
your ads may not show all the time. Should this happen, we'll display your 
ads intermittently throughout the day so they won't stop showing altogether 
(per standard delivery settings.)

Setting your daily budget to the amount we recommend is optional — 
you're always in full control of your AdWords account, and you can edit 
your campaign's daily budget as often as you like.

To learn more about setting your daily budget, visit the Cost Control 
lesson. 

About Quality Score and CPCs

Quality is the most important factor in determining the amount you'll pay 
when someone clicks your keyword-targeted ad. The higher your Quality 
Score, the less you pay for a given ad position, and vice versa. To improve 
your Quality Score and lower your cost-per-clicks (CPCs), try optimizing 
your account. Learn more at our Account Optimization lesson.

About AdWords Costs

AdWords doesn't have a minimum spending requirement — just a nominal, 
one-time activation fee. You set your spending limits, depending on your 
advertising goals. In addition, you pay only for clicks or impressions that 
your ad receives. You control your costs through: 

Your daily budget■
Your CPC and CPM bids ■
Your Quality Score■

Ad Ranking 

Ad Ranking

Objective: Ad rank is your ad's position on a page. Learn how we rank your 
ads and help keep your costs down.

How are ads ranked?

Ads are positioned on search and content pages based on their Ad Rank. 
The ad with the highest Ad Rank appears in the first position, and so on 
down the page. 

The criteria determining Ad Rank differ for ads on search results pages 
(which are always targeted by keywords only) and ads targeted by 
keywords on content sites. There's also a third set of criteria determining if 
an ad targeted only by a placement will appear on that placement. 
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A keyword-targeted ad is ranked on a search result page based on the 
matched keyword's cost-per-click (CPC) bid and Quality Score, which is 
calculated from its clickthrough rate (CTR) on Google, the relevance of 
your ad and keyword to the search query, and other relevance factors. 

A keyword-targeted ad is ranked on a content page based on its content 
bid and Quality Score, which is calculated by the ad's past performance on 
that and similar sites, your landing page quality, and other relevance 
factors. This is true even if you have also targeted placements in the ad 
group, and even if you have chosen 'Relevant pages only on the 
placements I target' as your content network setting. If a keyword helps 
target your ad on the content network, then the keyword-targeted Quality 
Score formula is used. 

If an ad is targeted by placement only, without keywords, its will appear if 
its Ad Rank is higher than that of all the competing ads. It will appear as 
the only ad on that page. For an ad targeted by placement only with cost-
per-thousand impressions(CPM) bidding, the Ad Rank is determined by its 
CPM bid and its Quality Score, which is derived from your landing page 
quality. For an ad targeted by placement only with CPC bidding, the 
clickthrough rate is also considered when creating the Quality Score. 

Learn more about placement targeting. 

Having high CPC and CPM bids, relevant ad text, a strong CTR, and a 
quality landing page will result in a higher position for all your ads. 
Because this ranking system uses relevance to help determine your ad's 
position, your ad can't be locked out of the top position based solely on 
price.

Content Network Pricing and Ranking 

Content Network Pricing and Ranking

Objective: Understand how cost-per-thousand-impressions (CPM) pricing 
works and how CPM ads compete with CPC ads. 

About CPM Pricing

The content network lets you bid for ad space in either of two ways: with 
the classic cost-per-click (CPC) pricing, or with cost-per-thousand 
impressions (CPM) pricing. 

With CPM pricing, you set the maximum price you're willing to pay for 
every 1000 impressions, or views, your ad receives on a given site. This 
means that you're charged whenever your ad appears, whether a user 
clicks it or not.

As it does with keyword-targeted ads on the search network, AdWords 
automatically lowers the actual CPM to the minimum price needed to win 
the auction in a given position on the content network. In many cases, 
advertisers pay a price lower than their CPM bid. 

CPM pricing can be used with keywords or with placements. CPM pricing 
is available only for campaigns that target the content network. It can't be 
used in campaigns that target the search network. 

CPC vs. CPM Page Ranking

When an ad with CPC pricing and an ad with CPM pricing enter the same 
auction, AdWords uses a system of effective CPM, or eCPM, to compare 
and rank the ads. 
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For ads with CPC bidding, the AdWords system considers the ad's bid, 
clickthrough rate (CTR), and other relevance factors, all taken across 1000 
impressions. The resulting figure is the ad's eCPM, or effective cost per 
thousand impressions.

For any available ad position, the eCPMs of ads with CPC pricing are 
compared to each other and to the bids of any eligible ads with CPM 
bidding. The highest-ranking ad wins the position and is displayed to the 
user. An image ad must outrank the eCPM of the top four keyword-
targeted text ads in order to win the space. 

No matter which type of ad wins the position, the AdWords Discounter 
monitors the competition and ensures that the winning ad is charged only 
what is necessary to maintain its ranking above the next highest ad. 

To learn more about the AdWords Discounter, visit the Cost Control 
lesson.

AdWords - Contacting Us - Help with other Google products - Change Language: English (US)  

©2010 Google - Google Home - Privacy Policy - Terms of Service - Advertising Policies 
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Complete Learning Center Path - Lesson 2 of 9 
Getting Started with AdWords 

Return to the Complete AdWords Learning Center Lesson Index 

 

Starter Edition and Standard Edition Accounts 

Starter Edition and Standard Edition Accounts

Objective: Understand the difference between a Starter Edition and a Standard 
Edition account and which account is better for you. Learn how to sign up for an 
account, how to run the most basic version, and how to graduate to Standard Edition.

Activating Your Account

After you sign up for an account, Google will send you an email asking you to verify 
your account. Your account won't be activated — and your ads won't run — until you 
verify your email address and set up your billing information.

The process is slightly different for Starter Edition and Standard Edition campaigns. In 
Starter Edition you will have created your first ad campaign already, so you'll be asked 
to submit your billing information as your next step. The process will go like this: 

Check the 'in' box of the email account you submitted when signing up for 
AdWords. You should find a verification email from AdWords. Open the email 
and click the link to visit the AdWords login page. 

■

 
Sign in to your AdWords account using the same email and password.■
 
Click the link in the red box at the top of your account page asking you to 
submit your billing information. 

■

 
Select a billing address and time zone for your account. ■
 
Choose your payment option. ■
 
Complete the activation process by agreeing to the AdWords terms and 
conditions and clicking Save and Activate on the last page.

■

If you created a Standard Edition account, you won't yet have created your first 
campaign. So the process will go like this: 

Check the 'in' box of the email account you submitted when signing up for 
AdWords. You should find a verification email from AdWords. Open the email 
and click the link to visit the AdWords login page. 

■

 
Sign in to your AdWords account using the same email and password.■
 
Decide whether you'd like to create an ad campaign or submit your billing 
information first. You can do these in either order, but you must do both things 
before your ads can begin running on AdWords.

■

To create a campaign, click the button reading Create your first campaign. 
Follow the instructions to target your audience, create an ad, and select a 
budget. When your campaign is done, you'll be returned to the main page of 
your account.

■

To enter your billing information, click the My Account tab. Then click the 
Billing Preferences link and enter your billing information, including the time 
zone for your account. Then click Save and activate.

■

In both cases, your available payment options will depend on your billing currency and 
location. Review our payment options page for more information. If you choose to pay 
by direct debit or credit card (which we recommend), your ads will run soon after you 
submit your billing information. If you opt for bank transfer, your ads will run after we 
receive your first payment (typically 10 working days after you initiate the transfer). 

With both Starter and Standard Editions, you'll be asked to choose a time zone for 
your account. This time zone determines the official "working day" for all billing, 
reporting, and statistics in your account. Choose your time zone carefully; once 
selected, it can't be reset. 

AdWords Help
Account Types, Setup and Structure
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If you chose to create a Starter Edition account, continue reading the rest of this 
lesson. If you chose Standard Edition, skip to AdWords Account Structure.

Choosing Between Starter Edition and Standard Edition

Which account is better for you? Starter Edition is usually useful for advertisers who 
want to advertise a single product or service through a single campaign. Standard 
Edition is better for advertisers who want to run multiple ad campaigns and who want 
greater flexibility. 

To help you decide, take a moment to compare the features in the table below. 

 

 Starter 
Edition

Standard 
Edition

Simplified sign-up process 
Sign up with a minimized one-page form. X  

One product or service 
Advertise a single product or service with one set of 
keywords and one or more ads. 

X  

Many products or services 
Create campaigns for multiple products or services, 
each with many sets of keywords and ads. 

 X

Multiple ad formats 
Create text ads, image ads, and other rich ad 
formats. 

 X

Basic reporting 
See a one-page overview of the impressions, clicks, 
and costs for your ads. 

X  

Advanced reporting 
See a complete library of reports for all aspects of 
your account. Create custom reports to analyze your 
costs and return on investment.

 X

Basic targeting 
Target customers in one specific region (like a single 
country or city). 

X  

Advanced targeting 
Target customers in many regions at once.  X

Advanced cost control 
Choose from many bidding options: keyword-specific 
bidding, content bidding, ad position preference, and 
more. 

 X

Advanced planning tools 
Boost your campaign performance with advanced 
features like conversion tracking, the AdWords traffic 
estimator, and helpful variations and statistics from 
the Keyword Tool.

 X

Placement targeting 
Place your ads on the specific websites that appeal 
to your customers. 

 X

Please note that, with the introduction of a new AdWords interface, new AdWords 
advertisers may no longer be given the option of Starter Edition vs. Standard Edition. 
If you don't see this option upon sign-up, you can assume that you are using the new 
AdWords interface. This Learning Center currently trains on the previous AdWords 
interface, but you can find out more about the new interface by visiting the main 
AdWords Help Center.

About Starter and Standard Edition Accounts

Google AdWords offers two types of accounts: Starter Edition and Standard Edition. 
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Starter Edition is a highly simplified version of AdWords that lets new users 
advertise a single product or service, using a one-page signup form. A Starter 
Edition account has no ad groups, rich ad formats, placement targeting, or 
other advanced features. 

■

 
Standard Edition is the more typical account, which includes multiple ad 
campaigns and ad formats, plus advanced features like ad scheduling, Google 
Analytics, and more. 

■

Most new users choose to create a Standard Edition account. Those who choose the 
Starter Edition account can later "graduate" to a Standard Edition account at any time, 
for no additional fee.

Please note that, with the introduction of a new AdWords interface, new AdWords 
advertisers may no longer be given the option of Starter Edition vs. Standard Edition. 
If you don't see this option upon sign-up, you can assume that you are using the new 
AdWords interface. This Learning Center currently trains on the previous AdWords 
interface, but you can find out more about the new interface by visiting the main 
AdWords Help Center.

Signing up for an Account

To sign up for either a Starter Edition or a Standard Edition account:

Visit the AdWords homepage, and click the button to get started. ■
Select Starter Edition or Standard Edition, and click Continue.■

The sign-up wizard will walk you through the process. If you select Starter Edition, 
you'll start by creating your ad campaign. You'll be asked to target an audience, 
create an ad, choose keywords that trigger the ad to show, and select a budget. 

If you select Standard Edition, you'll begin by entering your email address and 
password and creating your AdWords account. Then you'll be invited to create your 
first campaign. 

Here are some things to keep in mind during the sign-up process: 

If you already have a Google Account, we suggest you use it as your login 
address and password for AdWords as well. But you can also choose a 
different email address (one that you use often) and a secure password (at 
least seven characters that include both letters and numbers). This information 
is what you'll use to log in to your account in the future.

■

 
It's OK to experiment. With AdWords you can always change your ad 
campaigns and other information as you go. The only exceptions to this are the 
billing currency and time zone information for your account; you'll select these 
you first submit your billing information, and they can't be changed later. But 
those small points aside, AdWords is built for change.

■

 
The first campaign you create in Starter Edition will be a keyword-targeted 
campaign. If you set up a Standard Edition account, you will have more 
flexibility with your first campaign; you'll be able to start creating your campaign 
with either keyword targeting or placement targeting (but you can use both 
together if you prefer). See the Step-by-Step Guide for more information on the 
sign-up process. Or, read through the Learning Center to get a better idea of 
AdWords features before signup.

■

Please note that, with the introduction of a new AdWords interface, new 
AdWords advertisers may no longer be given the option of Starter Edition vs. 
Standard Edition. If you don't see this option upon sign-up, you can assume 
that you are using the new AdWords interface. This Learning Center currently 
trains on the previous AdWords interface, but you can find out more about the 
new interface by visiting the main AdWords Help Center.

Running a Starter Edition Account

The My Ad Campaign page is the first page you see whenever you sign in to your 
Starter Edition account. This page gives you information on two topics: 

The text and settings for your ad 1.
The performance statistics for your ad2.

Text and Settings

The text and settings for your ad can be seen on the side of the page, above the 
keyword table. If you have multiple ads, they can be viewed and edited by clicking the 
Ad Variations tab. 
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Click Edit settings to change the target language and location, and budget for 
your ads. 

■

Click Pause to stop your ads from running. If you pause your ads, this link will 
change to read Resume. Once paused, your ads will not appear to users until 
you click Resume. 

■

Performance Statistics

The lower section of the page shows you the performance of your current keywords. 
The Keywords tab includes impressions (the number of times your ads have been 
displayed for each keyword), user clicks on your ads, and the total cost for those 
clicks. By clicking on the Graphs tab, you'll see graphs depicting the performance of 
your keywords.

Add new keywords by clicking Add keywords. Remove any keyword permanently by 
clicking Delete in the same row. 

Near the bottom of your keyword table, the row labeled Content network shows the 
performance statistics for your ads on content sites. Click the Turn off link in that row 
to remove your ads from the content network. 

In the upper right corner of the page, the health meter shows you how your account is 
performing. If your keywords and ads are working well, you'll see the message Your 
ads are showing as they should. If an ad is disapproved or if there are other problems 
with your account, you'll be alerted in this space. 

At the very top of the page, click the My Account tab to edit the basic settings of your 
account, including your email address, your billing preferences, and other settings.

Graduating to Standard Edition

A Starter Edition user can graduate to Standard Edition at any time. Once you 
graduate to Standard Edition, you can't return to Starter Edition. (Users who created a 
Standard Edition account to begin with also can't switch to Starter Edition.) 

To graduate, click the Graduate to Standard Edition link at the bottom of the My Ad 
Campaign page. 

Graduation transfers all the account information to a full Standard Edition account. 
Your existing ads become part of the first ad campaign in the new account, and your 
ads continue running. 

The remainder of the Learning Center lessons focuses primarily on Standard Edition 
accounts. To learn more about Starter Edition, visit the Starter Edition section in the 
Help Center.

Please note that, with the introduction of a new AdWords interface, new AdWords 
advertisers may no longer be given the option of Starter Edition vs. Standard Edition. 
If you don't see this option upon sign-up, you can assume that you are using the new 
AdWords interface. This Learning Center currently trains on the previous AdWords 
interface, but you can find out more about the new interface by visiting the main 
AdWords Help Center.

AdWords Account Structure 

AdWords Account Structure

Objective: Understand the structure of an AdWords account — from the account level 
to the ad group level. Then, start thinking about how you can take advantage of 
AdWords versatility to suit your advertising needs.

Account Structure

An AdWords account is structured like a pyramid, which expands from top down. It's 
broken down into three main levels. At the top level is account, followed by 
campaign, and then ad group. Each level has its own components: 

Account: Unique email address, password, billing information, and account 
preferences 

■

Campaign: Start and end dates, daily budget, Google Network preferences, 
target languages and locations, and advanced options

■

Ad group: Ads, keyword and / or placement list, and CPC or CPM bids■
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An AdWords account contains up to 25 campaigns; a campaign can have up to 100 
ad groups; and ad groups can contain up to 2000 placements, up to 2000 keywords, 
and up to 50 complementary ads that show when those keywords are searched. 

 
Account

Unique email address and password 
Billing information 

Account preferences 

          

Campaign   Campaign
Start & end dates 

Daily budget 
Google Network preferences 

Language and location targeting 

  

Start & end dates 
Daily budget 

Google Network preferences 
Language and location targeting 

          

Ad Group Ad Group   Ad Group Ad Group
One set of 

keywords and/or 
placements 

One or more ads 
CPC or CPM bids

One set of 
keywords and/or 

placements 
One or more ads 
CPC or CPM bids

  

One set of 
keywords and/or 

placements 
One or more ads 
CPC or CPM bids

One set of 
keywords or 
placements 

One or more ads 
CPC or CPM bids

Account Organization

The basic idea behind AdWords structure is versatility. An advertiser has many 
options - to run one ad on a few keywords and placements, or hundreds of ads on 
thousands of keywords and placements. You can organize your campaigns in any 
way you wish. Successful advertisers, however, tend to build many small, highly 
targeted ad groups around individual products or services.

This is explained in much more detail in the Starting Off Right lesson.

Account Naviagtion Overview 

Account Navigation Overview

Objective: Learn to navigate the main sections of your AdWords account.

Accessing an AdWords Account

To access an AdWords account:

Visit the AdWords homepage at https://adwords.google.com. 1.
Enter your email address and password in the login fields, and click Sign in. (If 
you're already signed into Google or AdWords with this information, Google 
skips this step and takes you directly to your account.)

2.

If you have trouble accessing your account, click the I cannot access my account 
link below the login fields.

Navigating Account Tabs

There are four main tabs, or sections, in all AdWords accounts: Campaign 
Management, Reports, Analytics, and My Account. Each section can have one or 
more sub-sections, which are listed as links directly underneath the tabs, and may 
vary depending on your account settings. 

If you create a My Client Center account, you'll see slightly different tabs. Similarly, if 
you sign up to be a Google Advertising Professional, you'll see an additional Pro 
Center tab. To learn more, visit the My Client Center lesson. 

Account Navigation
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Campaign Management: Get a summary of your account's performance, find 
useful tools for managing your campaigns, and edit your campaigns and ads 
through this tab. Sub-sections: Campaign Summary (from which you can drill 
down to view campaign details and ad group details), Tools, Conversion 
Tracking, and Website Optimizer.

1.

 
Reports: Create detailed reports on your account's performance. Sub-
sections: Report Center and Create Report. To learn more, see the Reports 
lesson.

2.

 
Analytics: Set up advanced performance tracking reporting for AdWords and 
other online advertising channels. Sub-sections: Analytics Settings and View 
Reports. To learn more, visit the Google Analytics section.

3.

 
My Account: View and edit your billing and account login information. Sub-
sections: Billing Summary, Billing Preferences, Access, and Account 
Preferences. For qualifying advertisers, there may also be a Budget page.

4.

Campaign Management 

Campaign Management

Objective: Learn to navigate on the Campaign Summary page, and understand how to 
edit information at the campaign level.

Campaign Summary

The Campaign Summary page is usually the first page you see when you sign in to 
your account. 

From here you can:

Search: Use the 'Search my campaigns' box to search for words or phrases across all 
campaigns, ad groups, and ads in your account. 

Receive alerts: You may see an alert box tinted yellow, green, or red. These alerts 
provide important information about your account and about new AdWords features — 
such as a declined payment.

Create a new campaign: Use the link above the table to create a new campaign.

Change campaign status and settings: Pause, resume, or delete campaigns, or 
edit campaign settings by checking the box to the left of one or more campaigns and 
then selecting one of the buttons above the table. 

Review the Campaign Summary table: This table displays summary data about all 
online campaigns in your account.

Use the date range drop-down menus above the table to select the day or date range 
you'd like to review. You can also view all campaigns, all active campaigns, or all but 
deleted campaigns by clicking the appropriate link above the table. 

Below are descriptions of each table column:

Campaign Name: A list of your campaigns. Click the name of any campaign to 
see the ad groups within that campaign and any other relevant statistics. 

■

Current Status: The status of each campaign. A campaign's status can be 
Active, Paused, Deleted, Pending, or Ended: 

■

 
Active: Set to run normally ■
Paused: Temporarily suspended and not currently running ■
Deleted: Deleted and no longer running ■
Pending: Not yet started running ■
Ended: No longer running as end date has already passed■

 
Current Budget: The current daily budget of each campaign ■
Clicks: The clicks accrued for the ads in each campaign ■
Impr. (impressions): The number of times the campaign's ads have been 
displayed on Google or on sites in the Google Network

■

CTR (clickthrough rate): The number of clicks divided by the number of 
impressions that the ads have received. This is expressed as a percentage: 2 
clicks for 100 page views equals a 2% CTR.

■

Avg. CPC (average cost-per-click): The average cost accrued for clicks on the 
ads within that campaign.

■
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Avg. CPM (average cost per thousand impressions): The average cost per 
thousand impressions for ads in a placement-targeted campaign 

■

Cost: The total costs that a campaign has accrued during the time frame you 
selected

■

Conv. Rate (conversion rate): How many user clicks turned into actual 
conversions for the advertiser. Conversion rate equals the number of 
conversions divided by the number of ad clicks. This applies only to users who 
have set up conversion tracking. 

■

Cost/Conv.: The total cost divided by the total number of conversions. This 
tells you how much each conversion costs. This applies only to users who 
have set up conversion tracking.

■

To hide or show any of the above columns, click the 'Customize columns' link above 
the Campaign Summary table. 

Campaign Details

When you click a campaign name in the Campaign Summary table, you go to the 
Campaign Details page. From here you can review and edit your selected campaign 
and the ad groups in that campaign. 

Here are few actions you can take:

Campaign Level

Edit selected campaign: Pause, resume, delete, and undelete the selected 
campaign. If you delete a campaign, you'll see an 'Undelete Campaign' button. 
You can also access the Edit Campaign Settings page. 

■

Edit/add campaign negatives: For more information on campaign negative 
keywords, see the Keyword Targeting lesson.

■

Edit site or category exclusions: This link takes you to the Site and Category 
Exclusion tool, where you can select websites or categories of content where 
you don't want your ad to appear.

■

Ad Group Level
Change ad group and names and states: Rename, pause, resume, or delete 
one or more ad groups in the table. Check the box next to one or more ad 
groups you want to edit, and click the relevant button. 

■

View different ad groups: Use the drop-down menu above the table to show 
all ad groups, only active ad groups, or all but deleted ad groups. 

■

Create new ad groups: Use the 'New ad group' link below the basic campaign 
data to create a new ad group within the current campaign. Click the link, then 
choose 'Start with keywords' or 'Start with placements.'

■

Review summary statistics for your ad groups: This table is similar to the 
other tables in your account — such as the Campaign Summary table covered 
previously — but with two additional columns: 

■

 
Current Bids : This column shows your current bid settings — including 
the default maximum or preferred bid, and optional content and 
placement bids — for each ad group within a campaign. 

■

Avg. Pos. (Average Position): This shows the overall average 
placement for ads within each ad group. (When running placement-
targeted campaigns, the Avg. Pos. column doesn't appear.)

■

To look at any ad group in greater detail, click its name to see the Ad Group Details 
page. Click 'View all Ad Groups' to see the details for all ad groups on one page. 

Editing Campaign Settings

You can access this page via the Edit Settings button on the Campaign Summary 
page or via the Edit campaigns settings link on the Campaign Details page. The 
page contains the following sections:

Basic Settings: Edit your campaign name and end date. 

Budget Options: Change your daily budget or delivery method. 

Budget: Daily budget helps determine your ad display. To make sure that your 
daily budget is high enough to show ads whenever possible, click the 
'Recommended Budget' link below the daily budget field. 

■

 
Delivery Method: Choose the 'Standard' option to show your ads periodically 
throughout the day. Choose 'Accelerated' to show your ads as possible as until 
your daily budget is met.

■

Networks and bidding: This section includes these items:
Bidding strategy: Select 'Change bidding strategy' to choose different ways to 
bid for your ads — such as with the Budget Optimizer or preferred CPC 
bidding. 

■
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Networks: Adjust where your ads are distributed. When you start a new 
campaign with keywords, your ads are set by default to run on Google search, 
search partners, and the content network with the setting 'Relevant pages 
across the entire network.' When you start a new campaign with placements, 
your ads are set by default to run on the content network with the setting 
'Relevant pages only on the placements I target.' To modify these settings, 
select or deselect the checkboxes and radio buttons. For more information, see 
the Search and Content Targeting lesson.

■

 
Position preferences: Enable this feature to set a specific rank range that 
you'd like your text ads to appear on Google search and the search network.

■

 
Set a separate bid for content network impressions: When you enable the 
content network, you can also check this optional box to set an additional 
default bid for when your ad appears on content network placements.

■

 
Demographics: Click the 'View and edit options' link here to make an extra bid 
to apply when your ad is shown to members of certain demographic groups.

■

Scheduling and serving: This section includes these items:

Ad Scheduling: Set up specific days and times when you want your ads to 
appear. 

■

 
Ad Serving: Choose how you'd like different ads in an ad group to compete. 
Either select 'Optimize' to show ads that perform better more often, or select 
'Rotate' to display each ad an approximately equal number of times. 

■

Target Audience: Specify the languages and geographic areas you'd like your ads to 
show for by adjusting your language and location preferences. To learn more, see the 
Language and Location Targeting lesson.

Once you've changed any of these settings, click the Save Changes button. Click 
Cancel to return to the original settings instead of saving the new ones. 

Creating New Campaigns

You can create a new campaign at any time. Each time you create a new campaign, 
you can start by selecting keywords or by selecting placements to target your ads. 
(After you create the campaign, you can always add more keywords, placements, or 
both. The choice to start with keywords or placements only determines how you get 
started with the campaign.) Here's how to create a new campaign: 

Sign in to your AdWords account at https://adwords.google.com.■
On the Campaign Summary page, find the link titled New online campaign, 
just above the table of existing campaigns. 

■

Click the link and then select either Start with keywords or Start with 
placements from the pulldown menu.

■

If you decided to start with keywords, you may also be offered the option of using the 
one-page signup wizard, which allows you to copy and edit settings from an existing 
campaign. If the one-page wizard is available, use the drop-down menu to select an 
existing campaign to copy, then click 'Go' and follow the instructions on the next page. 

To use the full, multi-page signup wizard for a keyword-targeted campaign, ignore the 
one-page signup option and follow the regular instructions to create your campaign. If 
you decided to start with placements, follow the signup wizard instructions to create 
your campaign. 

Ad Group Management 

Ad Group Management

Objective: Learn to locate and interpret data at the ad group level. Understand how to 
edit ad groups, keywords and placements from the Ad Group Details page.

Ad Group Details Page

When you click on an ad group name in the Campaign Details table, you go to the Ad 
Group Details page. 
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The Ad Group Details page divides information into four tabs: Summary, Keywords, 
Placements, and Ad Variations. 

Summary: The summary view is the overview of the ad group. It gives you 
overall statistics for State, Current Bid, Clicks, Impressions (Impr.), 
Clickthrough Rate (CTR), Average CPC or CPM, Cost, and Average Position. 
Conversion rate columns are added for those using conversion tracking. You 
can also pause or delete an ad group here.  
 
Some of the functionality and column headers on this page mirror those we've 
seen in previous topics. 

1.

 
State: The current campaign settings for this campaign. Each network 
option is either on or off. If your campaign settings call for either 
placements or keywords, and this ad group does not include 
placements or keywords, then you'll see the message None selected. 

■

Current Bid: The amount you're bidding per click (CPC) or per 1000 
impressions (CPM)

■

Clicks: The clicks accrued for the ads in the ad group■
Impressions: The number of times the ad is displayed on Google and 
on the Google Network

■

CTR (clickthrough Rate): The number of clicks divided by the number of 
impressions that the ads in the ad group have received

■

Average CPC or CPM: Either CPC or CPM will be shown here, 
depending on which type of bidding you've chosen in your campaign 
settings. The average CPC is the average cost for all variations of your 
keywords. The average CPM is the average price you're paying per 
1000 impressions of your ads in the ad group.

■

Cost: The actual cost accrued for clicks or impressions the ad receives 
in the ad group. 

■

Average Position: The average position where your ad appears 
relative to other ads. This is only for ads with CPC bidding. (The 
message N/A will appear otherwise.) Your ads may appear for 
variations of your keyword. Your position varies according to your CPC 
bid and your keywords.

■

 
Keywords: Shows the keywords you have chosen for this ad group, and how 
they are performing.  
 
You can add new keywords, edit existing ones, edit bids, and view their current 
status. Many of the statistics are similar to the 'Summary' tab above — but 
specific to keywords. Here are some additional functions: 

1.

 
Magnifying glass icon: Point your mouse over the icon next to the 
keyword to see whether a keyword is showing ads. If the ad isn't 
showing, you'll see a quick summary of the issue. 

■

Add new keywords: Add keywords by clicking the 'Quick add' or 
'Keyword tool' links at the top of the table. Click 'Keyword tool' if you 
want help finding new keywords for your ad group.

■

Edit keywords: Click 'Edit keywords' to make changes to existing 
keywords. Then add, edit, or delete keywords. You can also enter a 
new bid. 

■

Search this list: Search the ad group for keywords by clicking the 
'Search this list' function. Select the text or stats you are interested in, 
then click 'Search.' You'll see a list of only those keywords that fit your 
parameters. Click 'Return to Full List' when you're ready to go back to 
the normal ad group view.

■

 
Placements: Shows the placements you have chosen for this ad group, and 
how they are performing.  
 
You can add new placements, edit existing ones, edit bids, and view their 
current status. Many of the statistics are similar to the 'Summary' tab above — 
but specific to placements. Here are some additional functions: 

2.

 
Add placements: Add placements by clicking the 'Add placements' link 
at the top of the table. That will take you to the Placement Tool, which 
will help you find and select new URLs.

■

Edit placements and bids: Click 'Edit placements and bids' to add or 
remove placements or change bids.

■

Search this list: Search the ad group for placements by clicking the 
'Search this list' function. Select the placements or stats you are 
interested in, then click 'Search.' You'll see a list of only those 
placements that fit your parameters. Click 'Return to Full List' when 
you're ready to go back to the normal ad group view.

■

 
Ad Variations: This tab displays all the different ads you've created for the ad 
group. (Each ad is called a 'variation.') You can create new ads or edit existing 
ones. The ad-by-ad stats should help you determine which messages are 

3.

Page 9 of 19خدمات تبليغات در گوگل www.BERTINA.us

خدمات تبليغات در گوگل www.BERTINA.us



reaching your users in the most powerful way. 
 
We encourage AdWords advertisers to create multiple ads within each ad 
group, and to discover which ad messages work best with potential customers. 

 
Create ads: Click the type of ad you want to create at the top of the 
table — either 'Text ad' or other ad types. Depending on availability, 
other ad types may include image ads, video ads, mobile text ads, or 
local business ads. Follow the instructions to create your ad.

■

Edit ads: Click the 'Edit' link next to any ad (under the 'Actions' column) 
to make changes. 

■

Pause, unpause, or delete ads: Check the box next to the ad you want 
to pause, unpause, or delete, and click the appropriate button at the top 
of the table. To perform the same action across all the ads in an ad 
group, check the box next to 'Variations,' and then click the appropriate 
button.

■

See data from all tabs: Click the 'View all tabs at once' link found in the 
lower right-hand corner of the page to see the data from all tabs 
displayed on one page.

■

My Account Tab 

My Account Tab

Objective: Learn to navigate the My Account tab and to edit your account and billing 
preferences.

Billing Summary Page

On the Billing Summary page, you see information on the payments for your account. 
You can access more detailed information about each payment by clicking the invoice 
number link. 

To learn more, see the Billing process lesson.

Billing Preferences Page

On the Billing Preferences page, you can view your method of billing and form of 
payment. You also can edit the payment details (such as payment method) and 
change your billing address or contact phone number. You may also enter any 
promotional codes you may have received.

Account Preferences Page

On the Account Preferences page, you can: 

Edit your login email address, password, and display language■
Decide which notifications you'd like to receive (such as newsletters) and how 
you'd like to receive them

■

Edit your primary business type or your PharmacyChecker ID ■
Edit your Google Analytics auto-linking capability■
Review the AdWords Terms and Conditions ■
Cancel your AdWords account■

The Budget Page

The Budget page lets you view active, past, and future account-level budgets. 
Account-level budgets are issued to qualified advertisers who prefer to be billed on a 
monthly basis with invoices. The Budget page displays the contract account budget 
and contract start and end date. It shows what portion has been consumed to date. 

To learn more, see the Invoicing lesson.
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The Access Page

The Access page lets you view and control other's access levels. It also helps keep 
your own information secure. This page comes in handy if you share your AdWords 
account with other users or if a client manager helps manage your account. 

On this page, you can invite other users to share the account with you, grant users 
access, and disable a user or client manager's access.

Organizing Your Account 

Organizing Your Account

Objective: Learn how to build a strong foundation for success. Find out how to 
organize your account logically at the campaign and ad group levels.

Campaign Strategy

Every account starts with a single campaign. Each campaign — whether you have 
one or multiple — should reflect a single, overarching goal. When building a 
campaign, ask yourself "What do I want to achieve with this campaign?" Your answer 
might be to target a certain audience, sell more products, increase signups, or bring in 
more leads. 

Some effective ways to organize your campaigns are by:

Theme or product line (coffee products, tea products, gift baskets)■
Your website's structure, such as by categories (purchase, learn, signup) ■
Different brands (X, Y, and Z)■
Geography (New York, Chicago, and United States)■
Language (English, Spanish, German)■
Distribution preference (search engines only, content sites only, or both search 
and content) 

■

Budgets (different budgets per product line)■
Map your structure on paper first to provide a template for the real thing. 

Strategies for Account Organization

Google AdWords gives you a basic structure to work within. From here, it's essentially 
up to you to organize your own campaigns, ad groups, keywords and placements in a 
way that makes the most sense. Organization is a key component to starting off 
strong and to helping you determine what works and what doesn't.

Note: This lesson is geared toward campaigns that are using only keyword targeting. 
However, many of the concepts can also be applied to campaigns that use placement 
targeting in conjunction with keyword targeting. To learn more, please read the lesson 
about how keywords and placements work together.

Ad Group Strategy

Just like your campaigns, your ad groups should be organized by common theme, 
product, or goal. Often, picking keywords and placements can lay the groundwork for 
your ad group strategy. Think hard about your keywords and placements. When 
choosing keywords, think of what words someone would use to search for on Google 
when seeking your product. Try writing down every keyword that comes to mind. You 
can refine them later. (This is discussed more in the Selecting Keywords lesson.)

Next, group similar keywords together — such as by a common theme. Each grouping 
reflects an ad group. For example, if your campaign goal is to sell more coffee beans, 
logical ad groups might include: 

Account Organization, Keywords and Ad Text
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Gourmet coffee beans Organic coffee beans French roast beans

Keywords:
Specialty coffee■
Gourmet coffee■
Gourmet coffee 
beans

■

Keywords:
Organic coffee 
beans

■

Decaf organic 
coffee

■

Natural coffee■

Keywords:
Decaf French roast 
coffee

■

French roast 
coffee beans

■

French coffee 
beans

■

 

Similarly, when choosing placements, consider where your typical customer might be 
browsing, and target those types of sites for ad placement. Although this lesson is 
geared toward campaigns that are using only keyword targeting, many of the 
concepts can also be applied to campaigns that use placement targeting in 
conjunction with keyword targeting. To learn more, please read the lesson about how 
keywords and placements work together.

If you find that the keywords or placements in one ad group become unwieldy, split 
the ad group into two to make them easier to manage. 

Finally, give your campaigns and ad groups descriptive names. This helps you 
manage your account at a high level without memorizing what each of your ad groups 
contains. 

Review, Test, and Refine Account Organization

Your AdWords account needs constant checkups. You can continue to reorganize 
your account as you learn more. The key is to check your progress and continue to 
refine your account. As you add more products, keywords or placements, you may 
need to reorganize your account. This is explained in more detail throughout this 
lesson and in the Optimizing Your Account lesson. 

Selecting Keywords 

Selecting Keywords

Objective: Understand how to build an effective keyword list for your campaigns 
through a simple five-step process. Delve into some simple but very important 
concepts about starting off right.

Creating a Keyword List

Keywords trigger ads. Ads influence clicks. And clicks bring you business. Or that's 
the general idea. Since keywords start this advertising food chain, it's important that 
you choose keywords relevant to your business from the get go. 

Keyword creation involves a five-step process: build, group, match, scrub, and test 
and refine. 

Building a Keyword List

Your first step in creating a keyword list is to come up with as many relevant keywords 
as possible. List any keywords that you think users might search for to find your 
product or service. 

Use the Keyword Tool for help. Available through the Tools page on the 'Campaign 
Management' tab (or via the 'Keyword' tab in your Ad Group Details page), the 
Keyword Tool offers additional keyword ideas — including synonyms and spelling 
variations — to yours. It allows you to build extensive, relevant keyword lists, review 
traffic estimations, and add your keywords directly into your ad groups from the same 
page. 
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To learn more, visit the Keyword Tool lesson.

Grouping Keywords

Keywords lay the groundwork for the ad groups and ads you create. As mentioned in 
the Organizing Your Account topic, group your keyword list into similar items, such as 
by product line. Each group makes up an ad group. You can write multiple ads for 
each ad group, so keyword groupings should match a single theme.

For example, organize keywords pertaining to organic coffee in one ad group and 
keywords relating to gourmet coffee in another. 

Finally, remember to keep your keyword lists small and manageable. 

Matching Keywords

Now it's time to target your keywords using Google's keyword matching options: broad 
match, phrase match, exact match, and negative match. These match types help you 
pin point ad delivery so your ads reach people precisely when they're searching for 
what you have to offer.

Broad match is the default setting for all keywords. All searches made using 
your keyword (in any order or combination) might display your ad.

■

Phrase match narrows your reach by requiring the words to appear in that 
exact order.

■

Exact match further narrows your reach by showing your ad when the exact 
phrase is used in the search — without any other words before, between, or 
after.

■

Negative match eliminates searched phrases you don't want your ad to 
appear on, such as cheap or free.

■

For a more in depth understanding of keyword matching, visit the Keyword Targeting 
and Matching lesson. 

Scrubbing Keyword Lists

After you've built, grouped, and provided match types to your keyword list, start 
refining it. Strive to keep specific keywords that relate most to your product or service. 
Which keywords are irrelevant or are likely to bring you the least traffic? Delete them.

Two- or three-word phrases generally work best. For example, instead of the keyword 
coffee, use fair trade coffee or gourmet coffee beans. Consider removing any single-
word or general keywords. These are often too broad and can lead to clicks from 
people who don't know what you're offering. 

Testing and Refining Keywords

To keep up with the dynamic nature of online advertising, you should continue to test 
and refine your keywords. Build on keywords that work, and delete others that don't. 
Also, if you're running ads on the content network, consider using placement targeting 
to refine your reach to your desired audience. Track your results using your 
performance stats in your account. To learn more about tracking keyword results, visit 
the Tracking Ad Performance lesson on Keyword issues.

Writing Targeted Ad Text 

Writing Ad Headlines

The best headlines directly relate to the keywords being searched. That makes your 
ad seem especially relevant to the searcher's interests. Therefore, include successful 
keywords in the headline. Plus, if the keyword in your ad text is identical to the 
keyword searched for, it will appear in bold font in your ad. 
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To determine which keywords are successful, review your ad groups and find 
keywords with the highest number of clicks or impressions. For example, if the 
keyword online advertising is clearly generating the most clicks and impressions in 
your account, use this term in the title of your ad. 

Commonly, advertisers make the mistake of including the company name or the 
website domain in their headlines. This typically doesn't attract more clicks unless 
you're advertising an established company with a distinguished brand. Consider using 
more general ad titles that inspire clickthroughs, which will eventually fortify your 
brand. 

Ad Text Basics and Examples

Ad text is a crucial distinguishing factor in luring a user to your website. Successful 
ads are clear, well-written, specific, and compelling. Here are some tips for writing ads 
that will get people clicking:

Include a call to action, such as buy, order, and purchase. While find and 
search may be accurate, these words imply that the user is still in awareness 
or interest mode, and doesn't easily encourage the user to click through.

■

Include keywords in your headline, since that's what people are looking for.■
Relate your ad to offers that you make on your landing page to help users 
complete the sales cycle.

■

Get to the point — fast. Include the most relevant information about your 
business first.

■

Write more than one ad per ad group, and test the results.■
Here are two sample ads promoting the AdWords program: The first ad is vague, 
redundant, and doesn't offer any benefits or contain a call to action. The second ad 
contains clear ad text, a specific benefit to the user, and a call to action.

 
 

Google 
Online advertising. 
Google's online advertising program. 
adwords.google.com

 
 

Online Advertising 
Improve your website ROI. Sign up 
for AdWords. Show ads today. 
adwords.google.com

Writing Targeted Ad Text

Objective: Learn how to write clear and compelling ad text — from the headline down 
to the destination URL.

Writing Descriptive Ad Text

The description should convey both the benefits of your product or service and include 
a call to action. Keep everything as short and simple as you can. To start, list your 
products or services (online advertising, website advertising, AdWords) and benefits 
(high ROI, show ads immediately). Then put it all together with a call to action, such 
as Order now or Sign up now.

Choosing Display and Destination URLs

Your display URL (or web address) doesn't have to be the same as your destination 
URL (where users go when they click your ad). But it should be an actual URL for 
your site. 
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Choose a destination URL that promotes the exact product or service your audience 
is searching for, rather than your usual homepage. It's usually most effective to direct 
users to a landing page that they're most interested in, as soon as you can.

Testing Text Quality with Multiple Ads

There's a common theme in this lesson, and that's to test and refine. Just like with ad 
groups and keywords, you should continue to watch, review, and rewrite your ads for 
the best results. AdWords makes this part easy for you. You can create multiple ads 
per ad group. If your ad serving options are set to optimize (the default setting), 
Google automatically shows the best performing ad more often. 

Check your stats, and swap out new ads for low performing ones. To learn more, visit 
the Optimizing Your Account lesson. 

Ad Format Basics 

Ad Formats Basics

Objective: Learn about the different ad formats — in addition to text ads — that you 
can choose to run on. Get details about the expanded text ad. 

Overview of Ad Formats

So far, we've been talking about text ads — Google's most traditional and popular ad 
format. In addition to creating text ads, you might also have the option to create the 
following types of ads:

Image (and animated) ads ■
Video ads■
Local business ads■
Mobile ads■

Some of the above formats are only available in certain locations. If available, they'll 
appear in your Ad Group Details table — via the Ad Variations tab. (Sign in to your 
account > Click the appropriate campaign name > Click the ad group name > Click 
the Ad Variations tab). 

You can include one or more different ad formats per ad group. Overall, we suggest 
that each ad group contains at least one text ad. If you have multiple ad formats per 
ad group, Google displays the most relevant one on a search or content page.

Make sure your ad closely relates to the product and service offered and describes 
what you expect a user to do on your page. Visit the Writing Targeted Ad Text topic to 
find out about common best practices. 

Take a quick glimpse at how ad formats vary in the chart below.

Content 
sites

Search 
sites

Placement
-targeted 
campaigns

Keyword-
targeted 
campaigns

Text-
based

Graphics
-based

Text Ads X X X X X

Image 
ads X X X X

Video 
ads X X X X

Local 
business 
ads

X X X

Using Different Ad Formats
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Mobile 
ads X X X

At times, your text ad might expand to fill an entire ad position (the area on a webpage 
dedicated to ad space). This is called an expanded text ad. Rather than being 
grouped with other text ads, the expanded text ad fills the entire ad space by itself.

An expanded text ad contains the same number of characters and the same editorial 
guidelines as a regular text ad, but the font and layout are increased to fill the entire 
banner, box, skyscraper, or position space.

Any text ad can run as an expanded text ad on the Google content network only (not 
on search results pages). No special arrangements are needed. A text ad is expanded 
automatically whenever the AdWords system determines that its price, relevance, and 
other competitive conditions make it a good candidate to take the entire space itself. 

Image Ads 

Image Ads

Objective: Learn about the features, creation process, and guidelines for image ads. 

Features

AdWords image ads are graphic ads that can be static (motionless) or animated. 
These ads appear on select content sites (not search sites) in the Google Network 
which have opted in to the image ads program. 

Image ads combine two features — graphics and AdWords targeting technology. This 
gives advertisers the power of pictures along with the precision of matching ads to 
related content sites. 

Campaign Integration

Image ads are available for campaigns that use keyword and/or placement targeting. 
Since image ads only run in the content network, campaigns using keyword targeting 
only must be opted into the content network in order for image ads to run. To learn 
how, visit the Edit Campaign Settings topic.

When you load your images via your Ad Variations tab, try to provide descriptive 
image names so you can better manage your account. Include the following in your 
image name: 

An image description ■
The campaign or ad group name ■

Formatting and Guidelines

Static image ads can be formatted in .gif, .jpg and .png. Animated image ads can be 
formatted in .gif or Flash. Image ads should clearly and accurately reflect your site 
and emphasize unique benefits of your product or service.

Both types can be in the following sizes: 

250 x 250 Square■
200 x 200 Small Square ■
468 x 60 Banner ■
728 x 90 Leaderboard ■
300 x 250 Inline Rectangle ■
336 x 280 Large Rectangle ■
120 x 600 Skyscraper ■
160 x 600 Wide Skyscraper ■

To learn more about formatting and specific image ads guidelines, visit Editorial 
Guidelines for Image Ads. For general information, visit the Image Ads section in the 
Help Center. 
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Video Ads 

Video Ads

Objective: Learn about the features, creation process, and guidelines for video ads.

Features

Video ads are click-to-play or in-stream ads that appear on select content sites (not 
search sites) in the Google Network and on Google Video. 

Click-to-play video ads appear as a static opening image. Users click the 'play' 
button or the opening image to watch the video in the ad space. If a user clicks 
the display URL at the bottom of the ad or clicks the ad while it's playing, the 
user goes to the webpage you've specified. 

■

 
In-stream video ads are streamed during other videos, similar to how 
commercials are shown on television. Just like click-to-play ads, in-stream ads 
contain a display URL that, when clicked, takes the user to the specified 
webpage. 

■

Video ads let you interact with and engage the user. For example, users can control 
the volume and replay the video. 

Campaign Integration

Video ads are available for campaigns that use keyword and/or placement targeting. 
Since video ads only run in the content network, campaigns using keyword targeting 
only must be opted into the content network in order for video ads to run. To learn 
how, visit the Edit Campaign Settings topic. 

When paying on a CPC basis, advertisers pay for clickthroughs leading users to the 
website, not for clicks on the opening image/video or play button. When paying on a 
CPM basis, advertisers pay for impressions of the opening image (or for in-stream 
video, when the video runs), rather than plays of the video.

Formatting and Guidelines

Google hosts and streams video feeds. Streaming technology is optimized for all 
bandwidths (dial-up, DSL, etc.). The video operates as a Flash element. As a result, 
users don't have to install anything. 

Here are some tips for creating a video ad: 

Create a descriptive and eye-catching opening image (the image which users 
see before playing the video).

■

Entice users to click 'play' by using rich, sharp colors.■
Include a few words to describe the product, service, and/or company.■
Boost play rate with a call to action that tells users they can play the video to 
learn more.

■

Create multiple video ads with different opening image sizes to increase the 
number of placements where your ad is eligible to appear.

■

Keep the video engaging and no longer than necessary (play rates drop off 
significantly after 45 seconds). 

■

Be clear about business offers. ■
Deliver key messages early in the video, because users may not watch the 
whole thing. 

■

Provide clear next steps for users to take after finishing the video, such as 
making a purchase or visiting the website or store. 

■

To learn more about formatting and specific video ads guidelines, visit Editorial 
Guidelines for Video Ads. For general information, visit the Video Ads section in the 
Help Center.
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Local Business Ads 

Local Business Ads

Objective: Learn about the features, creation process, and guidelines for local 
business ads. 

Features

Local business ads are AdWords ads associated with a specific geographic location. 
They can appear when a user searches for specific businesses or services in the 
advertiser's selected geographic area. This option gives you a good way to reach 
local customers and to create local customer awareness. 

For example, if a user searches on dentists San Francisco, CA, Google displays a list 
of dentists in or near San Francisco.

Local business ads are eligible to appear in two places: 

On Google Maps (maps.google.com)■
On Google and other sites in the Google search network■

Campaign Integration

Local business ads are available for campaigns using keyword targeting only. These 
campaigns must be opted into the search network (or into Google search only) and 
target a specific region or city. To learn how, visit the Edit Campaign Settings topic. 

Each local business ad should be associated to a business location within the 
campaign's targeted region. For example, if your campaign targets Manchester, 
England, you won't be able to create local business ads for businesses in London.

To enable local business ads to run on Google Maps and search sites in the Google 
Network: 

Create a business listing in Google Maps.1.
Create an AdWords local business ad. 2.

Formatting and Guidelines

The format of local business ads appear differently on Google Maps and on the 
Google search network: 

Google Maps: Google Maps includes a map component for each local 
business ad. When a user clicks the ad title or the map marker, an info window 
expands on the map to reveal additional information about the business. When 
users click the URL in the ad or in the info window, they are redirected to the 
advertiser's website. 

■

 
Google and the search network: A text-only version of each local business 
ad is automatically eligible to run on Google and other search sites in the 
Google Network. The text version has the same ad text and display URL as the 
enhanced ad running on Google Maps. In addition, a fifth line of text appears 
with the city (and state, if applicable) of your business. 

■

When creating local business ads, follow standard text ad Editorial Guidelines. To 
learn more about local business ads, visit the Local Business Ad section in the Help 
Center.

Mobile Ads 

Mobile Ads

Objective: Learn about the features, creation process, and guidelines for mobile ads.
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Features

Mobile ads are short, text-based AdWords ads that appear when users search Google 
from a mobile device. Your mobile ads can send users to your mobile webpage or 
connect them to your business phone. 

Mobile ads only appear on mobile devices, and not on search or content sites in the 
Google Network.

Campaign Integration

Mobile ads are available for campaigns using keyword targeting only. Advertisers 
either pay per click (when users click through to the website) or pay per call (when 
users click the 'Call' link). 

Mobile ads only work for country- or territory-targeted campaigns (not for local 
targeting). Therefore, your campaign should be set to target countries or territories 
and should include geographically targeted keywords (like San Francisco pizza). This 
helps users clearly identify where the business or product is located. To learn more, 
visit the Region and City Targeting topic.

Formatting and Guidelines

Mobile ads contain two lines of text, with a limit of 12 or 18 characters per line, 
depending on the language in which you write your ad. 

If you choose to connect users to your webpage, your display URL appears on a third 
line. If you select the option that allows customers to connect to your business phone, 
a 'Call' link appears next to your display URL. Your business phone must be domestic 
to the location your ads target, and may not be a toll number. 

To learn about mobile ads policies, visit Editorial Guidelines for Mobile Ads. For 
general information, visit the Mobile Ads section in the Help Center.

AdWords - Contacting Us - Help with other Google products - Change Language: English (US)  

©2010 Google - Google Home - Privacy Policy - Terms of Service - Advertising Policies 
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The Google Network 

The Google Network

Objective: Get a clear picture of the Google Network, including how search targeting and contextual targ

About Search Targeting

Search targeting applies to keyword-targeted ads shown on Google search results pages and on sites in
network. Ads shown on these pages appear alongside the search results and are specific to that particu
the advertiser's keyword matches the user's search term, the advertiser's ad could appear.

You can fine-tune your ads for search targeting by targeting specific areas and languages, choosing spe
assigning keyword match types. 

About Contextual Targeting

Contextual targeting is used to match ads with keyword targeting to sites within the content network. Ou
the content and theme of the site, considering factors such as text, language, link structure, and page st
these factors, Google determines the central themes of the webpage and targets AdWords ads to the pa
advertiser's keyword selections and language and location targeting.

As a result, contextually targeted ads provide useful information to readers and attract an audience with
interest in your message.

You can fine-tune ads for contextual targeting by using the site exclusion function in your AdWords acco
lets you choose sites, or types of sites, that you don't want your ads appearing on — such as competito
conversion rate sites, or sites that conflict with your interests. To learn more about site exclusion, visit th
Tool lesson. 

You can also now combine keyword targeting and placement targeting in the same ad group. This lets y
content sites where you want your ads to show (based on your keywords), and allows you to bid more e
keyword match is found on a targeted site. To learn more about how to combine keyword and placemen
the Keywords and Placements Together lesson. 

Quality of Ad Delivery

Google maintains a high standard for the quality of both AdWords ads and the websites that display the
ads, all sites in the Google Network are constantly reviewed to ensure that ads appear on appropriate a
even as content on the page changes. 

Our system looks at the following things to ensure quality ad delivery: 

Semantics: Google's language processing capabilities can untangle terms that might otherwise b
a page mentions Java, for instance, our system analyzes the context to distinguish between the c
programming language, and the Indonesian island.

■

 
Inappropriate Material: The AdWords system detects inappropriate or sensitive themes, such as 
news. In addition, ads do not appear on sites classified by Google as containing adult content, sp

■

AdWords Help
Search and Contextual Targeting
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content pages. As such, you can be confident that your ads will not appear on sites that might da
or image. 

In addition, Google's proprietary technology analyzes for invalid click activity. To learn more, see the Inv
lesson. 

About Performance and Pricing

Google evaluates an ad's performance on a case-by-case basis for each site where the ad appears. Th
performance of your ads on a content site does not affect the ranking of your ads on a search results sit
Clicks from contextual targeting usually mean additional qualified leads for you at no risk to the performa
campaign.

In addition, Google uses "smart pricing" technology for clicks made in the content network. Ads in the co
sometimes return lower conversion numbers than ads in the search network. To make up the difference
automatically lowers the cost of these content clicks. 

If you find that you receive better business leads or a better return from ads on content sites than on sea
versa), you can enable content bids at the ad group level or campaign level. Content bids let you set on
search sites and a separate price for ads on content sites. 

To learn more about smart pricing and content bids, visit the Cost Control lesson.

Google Network Overview

The Google Network lets advertisers reach users across the Internet — from small newsletters to large 
Since search results pages make up a very small fraction (around 5%) of all pages viewed online, the G
provides a cost-effective way to reach users on the greater portion of the web. 

Recall that the Google Network is split into the search network (which includes Google and other search
Ask.com) and the content network (like Gmail, newsletters, and HowStuffWorks). Together, the search a
networks make up thousands of search and content sites displaying targeted Google ads. See other site
might appear.

By default, AdWords keyword-targeted campaigns are opted in to the entire Google Network: Google se
partners, and the content network (with 'Relevant pages across the entire network' as the setting). You c
the search or content networks at any time on your Edit Campaign Settings page. To do so: Sign in to y
Check the box beside the campaign you want to edit > Click the Edit Settings button > Check or unche
radio buttons under the section titled 'Networks and bidding' > Click Save Changes.

Keyword-targeted ads can appear across search and content pages in the Google Network. Goo
targeting to match keywords to search queries on search sites. For content pages, Google uses 
targeting to match keywords to webpage content. (See details below.)

■

 
Placement-targeted ads can appear only on pages in the content network. The advertiser choose
audience and site, or portion of a site, to target. If the ad group also has keywords, the keywords
will work together to determine where ads should appear. Keywords will continue to match your a
through contextual targeting, and you can add your own placements to bid more when your ad a
sites, or to limit your ad to appearing only on the placements you target. To learn more, see the P
targeting lesson.

■

 
Google displays ads in the search network and in the content network based on relevancy factor
different results by creating two separate campaigns — one targeted to the search network and o
content network. This lets you customize your ad text, keywords, placements (if any), and bids. 

■

 
The appearance of your ads may vary slightly among Google Network sites to match the look an
webpages. Google automatically formats your ads for you. AdWords ads are always clearly labe
related links.

■

 
Text ads can appear on search pages and on content pages. Ads that contain graphics (like imag
ads) can only appear on content pages. To learn more, visit the Using Different Ad Formats lesso

■
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Contextual Targeting 

Contextual Targeting

Objective: Dive deeper into contextual targeting by understanding some of key differences between how
ads for content and for search. Then, learn some strategies for building and tracking a contextually targe

Contextual Targeting Vs. Search Targeting

You've already learned some of the basic differences between contextually-targeted ads and search-tar
Google Network topic) — mainly that contextually-targeted ads appear only on content pages and prope
search-targeted ads appear only on search sites. However, the way AdWords interprets your keywords 
varies. 

For contextual targeting, AdWords looks at the themes of the keywords in an ad group to decide whethe
for relevant content. If one of your keyword themes matches the theme of the content, your ad might be
targeting, however, your ad can appear based on the keywords you've chosen and how they match the 
enters.

Since keywords are analyzed differently, it's best to create two separate campaigns - one geared to sea
geared to content. This allows you to structure each campaign with different objectives in mind. 

Here's a summary of some of the key differences between search targeting and contextual targeting. Re
concepts when building your campaigns.

Search Targeting Contextual Targeting
Place where ad can 
appear: 

Search results pages in the 
search network 

Web pages and other properties (like vid
content network 

Acceptable ad 
formats: 

Text only Text ad, image ad, flash ad, video ad, ga

Basis of ad being 
shown: 

Keyword relevancy Keyword themes in each ad group, com
group placements (if any)

Bidding options: CPC CPC and CPM* 

*Note: CPM bidding is available only for campaigns that don't target the search network. Campaigns tha
network must use CPC bidding. 

Creating Contextually Targeted Campaigns

How do you create a keyword-targeted campaign specifically for content? Start with the basics. That is, 
campaign around a single campaign goal (see Organizing Your Account for details). Then, create ad gro
common theme and pick some general keywords that fit. Unlike search advertising, where you often loo
individually, keywords used for contextual targeting should be woven together collectively under a comm

Campaign strategy: As discussed previously, create a separate campaign when targeting the content n
this, create a new campaign in your account, starting with keywords. Then go to your Edit Campaign Se
find the 'Networks and bidding' section. Choose 'The content network' and 'Relevant pages across the e

As always, make sure that your budget is set to a price you can afford and that you only target locations
which your services relate. 

Ad group strategy: Create at least three ad groups, each around a common theme. The idea is to bring
to your site by covering the entire market for which your products or services relate. For example, create
around the exact product or service you're offering; a second ad group around similar products or servic
group around your audience demographics. 

Next, create a keyword list that fits the theme of each ad group. It's useful to include both general and s

Finally, create multiple ads for each ad group. Try intermingling different ad formats, like text ads with im
everything related, choose the same destination URL for every ad in a particular ad group. 

Here's an example of how a pet supplier might organize its account with the goal in mind to sell more do
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Ad group 1:  Direct product 
theme (dog supplies)

Ad group 2 theme: Complementary 
products (pet supplies)

Ad group 3: audience
theme (dog owners)

Keywords Keywords Keywords

dog supplies 
dog products 
dog food 
dog treats 
dog bones 
dog crates 
dog collars 
dog beds 
leashes 
dog shampoo 
-cat 
-fish 
-pet 
-training 
-adoption 
-guide 

pet supplies 
cat supplies 
fish food 
cat food 
pet products 
animal products 
-training 
-adoption 
-obedience 

Dog Day Care 
Dog Walkers 
Kennels 
Dog training

 
 
Follow these tips when creating your own contextually targeted campaign:  
 
Do

Create separate campaigns for contextually-targeted ads and search-targeted ads.■
Set your bids at the ad group level.■
Base each ad group around a single theme.■
Test different ad formats (text, image, video).■
Point all ads in a particular ad group to the same destination URL. The more specific the landing ■
Create short keyword lists.■
Use negative keywords.■
Write compelling, specific ads. (See Writing Targeted Ad Text.)■
Use placement targeting to raise your bid for websites or other placements where you particularly
appear. Or, use placements to lower your bid for websites where you know your ad doesn't perfo

■

Don't:
Create different destination URLs per ad group.■
Bid at the keyword level.■
Use keyword matching options.■
Include both singular and plural keywords.■
Have more than 50 keywords per ad group.■
Create just one ad group per campaign.■
Choose generic landing pages for each ad group.■

Tracking Contextually Targeted Ads

Tracking how your ads perform is important in determining what works and what doesn't. With proper da
a more informed decision about how to adjust your messaging, keywords, and bids for the greatest succ

To see how your ads are doing on various pages in the content network, launch the Placement Perform
(PPR). This report shows performance statistics for your ads on specific domains and URLs. You'll get i
where your ad is shown, as well as the CPC, total clicks, and total impressions from sites where your ad

Before running the report, try implementing either Google conversion tracking or Google Analytics. Both
applications are accessible in your account. Conversion data often provides the clearest insight about h
doing on a specific site. 

Running and Analyzing a PPR Report

To run a PPR report: 

Sign in to your account at https://adwords.google.com.1.
Click Create a New Report.2.
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Select Placement Report under step 1, Report Type.3.
Complete the rest of the form by choosing the data you'd like to see for a specific period of time. 
range spanning one to two weeks. 

4.

Click Create Report when you're done. To see a complete description of these steps, visit How d
Product Placement Report. 

5.

After you run the report, check the results. Focus on the areas that matter the most by initially sorting th
fields such as 'Clicks' or 'Cost'. This helps you understand which domains or URLs give your ads the mo

Here are some tips for analyzing a PPR report: 

Implement Google's conversion tracking so you can understand how individual sites are converti■
Don't focus on lower overall clickthrough rates (CTR). Remember: A low CTR on a given site doe
mean your ads perform poorly. Users behave differently on content pages than they do on searc
telling information, rely on your conversion data.

■

When you find placements where ads from one ad group convert well, consider targeting those p
Placements tab in your ad group. Try raising your bid so that your ads will have a better chance o
whenever your keywords put your ad on that placement. Or, try doing the opposite with poorer-pe
placements: lower your bid to seek a better ROI on those specific placements. 

■

Respond only to statistically significant data. It may take several weeks before you can see how 
a specific site. Wait until you have enough click and impression data before making decisions.

■

Use the site exclusion tool to exclude sites that are not converting for your campaign. ■

Introduction to Placement Targeting 

Introduction to Placement Targeting

Objective: Learn how placement targeting works on ad campaigns.

What is Placement Targeting?

Placement targeting is an alternative to traditional AdWords keyword targeting, but it can also be combin
targeting to allow for a more refined reach to your selected audience. Placement targeting lets advertise
individual websites in the Google content network, or specific sections of those sites, where they'd like t
Placement targeting gives advertisers the ability to: 

Advertise on a favorite site or sites■
Reach customers early in the advertising cycle, with ads designed to increase awareness or to p■
Bid using either cost-per-click (CPC) pricing or using an alternate cost-per-thousand impressions
model. (See Content Network Pricing and Ranking below for details.) 

■

Combine with keyword targeting to define specific content sites where ads with keyword targeting
and allows for more effective bidding when a keyword match is found on a targeted site. (See the
Placements Together lesson for more information).

■

Why Use Placement Targeting?

Creating a campaign with placements only is often a good choice for advertisers who want to promote a
product to a specific audience. With placements, you can select the exact sites where you want your ad

Mixing placements with keywords in the same ad group is also a good way to refine content network ca
keywords determine where on the content network your ads can appear, and your placements can be u
bid for certain placements, or to limit your ads to appearing only on the placements you choose, and on
those placements match your keywords. 

If you're not sure if placement targeting is for you, you can create separate campaigns with placements 
separate ad groups mixing placements with keywords. Then track your results to see what works best fo

Learn more about how keywords and placements work together. 

Placement Targeting
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Placement Targeted Ad Appearance and Position

Campaigns using placement targeting can include text ads and rich ad formats (like image and video ad
maintain the same look and feel as standard ads using keyword targeting alone. 

However, a placement-targeted ad always fills the entire ad position (space reserved for ads on a page)
that only one placement-targeted ad appears on a content page. If you run a text ad, the ad would be ex
expanded text ad format so it fills the entire position. 

To see how ads can be formatted on a content network page, visit our ad format page.

Starting a Campaign with Placement Targeting 

Starting a Campaign with Placements

Objective: Learn the steps for creating a new campaign by starting with placements where the ads can a

Creating a Campaign Starting with Placements

when you create a new campaign in your AdWords account, you're offered a choice: 'Start with keyword
placements.' Either way, you begin in the same place: on your Campaign Summary page. Sign in to you
account, then click the Campaign Management tab, then click the link titled New online campaign. Yo
down menu with the 'Start with keywords' and 'Start with placements' options.

The creation process for both choices is similar. But when you start with placements, you'll notice a few 
starting with keywords: 

Placements: Instead of creating a list of keywords to trigger your ad, you create a list of websites
placements where you'd like your ad to appear.

■

 
Placement Tool: Instead of using the Keyword Tool to find potential keywords to advertise on, yo
Tool to find potential placements where you'd like your ad to appear. You can list exact URLs or 
to generate a list of available placements. This is explained in more detail below.

■

Choosing Placements for a Campaign

The Placement Tool appears when you create a new campaign or ad group starting with placements, or
the Add placements link on the Placements tab of an existing campaign. The Placement Tool helps yo
and other placements in the content network where you'd like your ad to appear.

The Placement Tool offers four ways to choose placements: 

Browse categories: Shows sites and related placements that match categories (like Entertainm
subcategories (like Music) that you select. For best results, narrow the topic by picking subcatego
precisely match your ad. 

■

 
Describe topics: Shows sites and related placements relevant to words or phrases you enter. F
coffee merchant might enter topics like organic coffee beans, coffee, or coffee products. We'll the
sites relating to the topics entered.

■

 
List URLs: Shows placements that exactly match, or are related to, URLs you enter. For exampl
advertising tennis equipment, you might enter the URLs of your favorite tennis or sports websites
enter are part of the Google content network, we'll display those sites as available for targeting. I
a list of related sites that may have a similar audience. Then you can pick the placements where
to appear.

■

 
Select demographics: Shows sites and related placements popular with the audience demogra
For example, you might choose an audience age range of ages 35-44. We'll display placements 
audience. 

■

For each of the above methods, you can generate up to 100 content placements that match your criteria
includes an estimate of the Max. Impressions/Day — the number of impressions available to all advert
in an average day. 
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Click Add next to placements where you'd like your ad to appear. Placements you select move to the S
Placements list on the right-side of the page. Click the Add Selected Placements button to save them 

To match your ad to the most relevant placements, we recommend that you use all four methods above

How AdWords Targets Users 

How AdWords Targets Users

Objective: Learn how Google determines the location and language of a user by Google domain, query 
address, and language preference detection.

Targeting by IP Address

Google can sometimes identify a user's IP address to determine a user's general physical location. An I
unique number assigned to each computer connected to the Internet (such as 10.32.20.135). The IP ad
automatically assigned by a user's Internet Service Provider (ISP).

We'll only use the IP address to show regionally (region and city) targeted or customized ads, or when a
Google.com from any location.

Regionally targeted and customized ads: If a Google user searches plumbers from a New Yor
we may display regional or customized ads targeted to New York, even though New York isn't in 

■

 
Google.com searches: If a user with an IP address in France searches on Google.com, the use
targeted to France, even though the user isn't accessing Google.fr. 

■

Targeting by Google Domain

Google has over 100 country-specific domain extensions to which AdWords ads can be shown. The dom
attached to each web address, such as .com, .fr, and .es. Google.com is geared to users in the United S
users in France, and Google.es to users in Spain.

When a user searches on any of the hundreds of Google domains, AdWords displays ads according to 
For example, if a user located in Spain searches on Google.fr, AdWords shows ads targeted to France.

Targeting with Query Parsing

With query parsing, Google can use the user's search query to determine when to show ads targeted to
or city. 

For example, if a user in New York searches for hotels in Hollywood, the user sees ads targeted to the H

This search functionality only applies to ads that target certain areas worldwide.

Targeting by Language Preference

The Preferences link on the Google homepage lets users choose the language in which they want to se
user sets the language preference, Google only displays ads that are targeted to the chosen language. 
specify a language preference, the Google domain (like Google.fr) determines the default language pref
case, French).

For example, users who choose Spanish as their language preference see ads targeted to Spanish spe

Language and Location Targeting
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Google does not translate ads. If an advertiser writes an ad in English and targets the Spanish language
in English, regardless of the targeted language. 

Overview of Language and Location Targeting

Your ads are targeted to reach a certain audience, based on your chosen language and location targetin
next topic for more details). With this information, AdWords works to ensure that your ad appears to you
audience. 

When a user searches Google or sites across the Google Network, we'll determine to show your ad bas

Google domain■
Query entered (called query parsing)■
Internet Protocol (IP) address■
Language preference■

Language and Location Targeting 

Language and Location Targeting Options and Setup

Objective: Get an overview about the different language and location targeting options. Learn how to im
options for a new or existing campaign. 

Implementing Language and Location Targeting

New Campaign

To choose your language and location targeting options for a new campaign: 

Sign in to your AdWords account at https://adwords.google.com.1.
On the Campaign Summary page, click the link for New online campaign and then choose to 's
or 'start with placements.' You will be taken to a new page.

2.

Name your campaign and ad group.3.
Select one or more languages you wish to target. 4.
Under Target customers by location, you'll see a default location. To show your ads to custom
place, click 'Change location,' then make your selection. 

5.

Click 'Continue.'6.
After you complete the targeting section, finish creating your campaign.7.

Existing campaign 

To change your language or geographic targeting settings for an existing campaign:

Sign in to your AdWords account at https://adwords.google.com.1.
Check the campaign you with to edit, and click Edit Settings.2.
Select a language to target beside 'Languages.'3.
Click Edit beside 'Locations.'4.
Click OK if you receive a pop-up dialog box.5.
Select your new locations.6.
Click Finished. 7.
Click Save Changes. 8.

Language and Location Targeting Options

Whenever you create a new campaign in your AdWords account, you choose which languages and loca
target. Your options include: 

Language: Target up to 40 different languages.1.
Location: Target any combination of countries, territories, regions, cities, and customized areas t2.

All advertisers must choose a language and location to target, so it's important to understand what's righ
general guidelines to follow, which are further discussed in the following topics. 
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Target countries or territories to reach a wide audience across one or more countries.■
Target regions and cities if your business serves specific geographic areas or if you want differen
messages in different regions.

■

Target customized areas to reach specific geographic areas which may not be available in region
targeting, or if you want to define specific geographic areas.

■

Language and Country/Territory Targeting 

Language and Country/Territory Targeting

Objective: Learn how to reach a broad audience by targeting one or more languages and countries. Find
your campaigns to reach an international audience.

Targeting by Language

Language targeting lets you reach an audience that speaks one or multiple languages. Because people
different languages in many different locations, language targeting gives you a good way to reach your u
they're physically located in non-native areas.

For example, if you sell Spanish books, you can choose to target your ads to the Spanish language. Wh
a user speaks Spanish by one of the methods listed in the topic above (How AdWords Targets Users), w
ad. 

We recommend that you target the language in which your ad is written. For example, if your ad is writte
target English-speaking users. Remember that Google won't translate your ad for you.

Targeting by Country and Territory

You should choose this location targeting option if you have a large audience and offer services or prod
one or more countries or territories. If you have a global business, it would make sense to target all coun
territories, ensuring that your campaigns get exposure across the world. 

It's common for new advertisers to target all countries and territories in the hope of widening their reach
doing this, you may target people who can't read the language of your ad or website, which creates low-

To help assess where and who you should target, answer these questions: 

Where does your business sell or provide?■
Who is your intended audience? ■

For example, if you sell maps of the United States and only ship within the United States, you should tar
to the United States. However, if you sell DVDs worldwide, you should target your campaign to all count

International Targeting Campaign Strategy

International targeting means that you target more than one language or location. If you decide to target
audience, organize your campaigns and ad groups logically. 

A good strategy is to organize and name your campaigns by country (such as Germany) and your ad gr
lines (such as coffee products and tea products). Then, tailor your keywords and ad text to the intended

Make sure that your keyword list and ad text for each ad group is in one language. This ensures that the
same language in which the keyword was entered. For example, if a user enters a keyword in Japanese
appear in Japanese.

About Ad Text Using Local Languages

With AdWords you can create ad text using double-byte characters, such as those used in many East A
However, be aware that double-byte characters have special requirements.

Page 9 of 16خدمات تبليغات در گوگل www.BERTINA.us

خدمات تبليغات در گوگل www.BERTINA.us



Double-byte characters need nearly twice the display space as single-byte characters. For example, the
English ad has a 25 character limit. However, the limit for that same title line is 12 characters for a doub
The second and third lines of English ad text are limited to 35 characters, while the limit for double-byte

Two other rules to follow when creating ads with double-byte characters: 

- Use single-byte characters for symbols, such as punctuation marks and currency symbols. 

- Use single-byte characters for alphanumeric characters. 

When creating a double-byte character ad in the English interface, the character limit on the screen is w
receiving an error message, enter only the correct character length. 

 
Figure: Japanese ad in U.S. AdWords interface

 
Figure: Single-byte characters and numbers inside of a double-byte ad

Region and City Targeting 

Region and City Targeting

Objective: Target your ads to small geographic areas using region and city targeting to reach a specific
why and when to use region and city targeting.

Targeting a Region or City

Region and city targeting is best used by advertisers whose audience is concentrated in defined areas. 
city targeting, you can capture a smaller population segment and receive more qualified clicks. This help
Quality Score high and your costs low. Additionally, you can create more customized ad text and landing
highlight special promotions or pricing based on the audience you're targeting.

Region and city targeting usually works best for region-specific businesses, such as boutiques, stores, r
hotels. For example, if you sell flowers and only deliver in the New York City area, you should target you
area only. 

Region and city targeting may not be offered in your country. The available options are displayed when 
campaign.

Appearance of Location Targeted Ads

AdWords displays your chosen region or city (whichever is the most specific) in the last line of ad text to
from country- and territory-targeted ads. These ads appear on Google and on some of our partner sites

Region and City Targeting Accuracy

Some countries and territories — specifically Spain, Japan, South Korea, and Brazil — lack the infrastru
for us to always detect a user's location. To ensure that you reach users in these areas, we recommend
create a country- and territory-targeted campaign (in additional to a regional one) that includes region-sp
and ad text. 

Here's how:

Include the names of regions and cities you wish to target in your keywords, such as Seoul hotel
Seoul. When a user anywhere in South Korea searches for your keyword, your ad appears. 

■
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Add the names of regions and cities you do not wish to target as negative keywords. For exampl
contains the broad-matched keyword hotels, add -Sao Paulo as a negative keyword (with the hyp
your ad from showing for the query Sao Paulo hotels.

■

Include region and city names in your ad text to reinforce the local nature of your product or serv
your ad appears for a user uninterested in the targeted region, the user won't click your ad.

■

Here's an example of a used car dealer in Madrid that has created both regional and country campaigns

Campaign 1: Region and City Campaign 2: Country and Territory

Location Targeting: Madrid Location Targeting: Spain 

Keywords: Keywords: 

used car 
used truck 
car dealer 
buy pre-owned car 
-Barcelona 
-Seville 

Madrid car dealer 
Madrid used truck 
Madrid used car 
buy pre-owned car in madrid

Customized Targeting 

Customized Targeting

Objective: Learn why and when to use customized targeting to reach more qualified leads.

When to Use Customized Targeting

Customized targeting is best suited for advertisers with an audience in very specific areas. If you select
targeting option for your campaign(s), your ads will only appear to customers searching for results within
within) a specified distance from your business or within the area you define.

Additionally, customized targeting doesn't limit you to the cities and regions offered by region and city ta
example, an advertiser owns a restaurant chain in Southern California. With customized targeting, the a
choose to target the entire southern half of California instead of specific regions or cities. 

Three Types of Customized Targeting

When setting up customized targeting, you have three options: enter a physical address, select a point o
enter multiple latitude and longitude points to form a polygon. 

Enter a physical address: With this option, you enter a street or business address. (This option is
U.S and Canada only.) You then choose a distance (such as 50 miles or kilometers) that forms th
circle around the address. Only users located within this circle, or those who include in their sear
cities within this circle, will see your ads.

■

 
Select a point on the map: Instead of entering an address, you can define the center of your adve
dragging the interactive map to place a red marker on your location. This location will automatica
exact latitude and longitude coordinates, which the AdWords system will use in targeting your ad

■

 
Multi-point (or polygon): Multi-point targeting lets you click three or more points on an interactive 
advertising region of your choice. (Again, the system will convert the points you select to latitude 
automatically.) Using multi-point targeting, you can create target areas of virtually any size and s

■

Keyword Targeting
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Keyword Targeting and Matching Options 

Keyword Targeting and Matching Options

Objective: Understand the various keyword matching options and how to use them to your advantage in

Overview of Keyword Targeting

Keyword targeting uses matching to more precisely control how a user's search will trigger your ad on G
pages. Defining how broadly or narrowly your keywords are targeted helps you reach the audience you 
the more targeted your keywords and ads are, the more likely you are to reach potential customers. 

You can apply the following matching options to your keywords:

Broad match■
Phrase match■
Exact match ■
Negative match■

AdWords also offers a more advanced matching option called embedded match, which is discussed in g
in this lesson.

About Broad Match Keyword Targeting

Broad match is the default setting for your keywords. Therefore, when you submit a new keyword to you
quotes or brackets, it appears as a broad-matched term.

Broad-matched keywords reach a wide audience and trigger your ad to appear whenever that keyword 
appears in a user's query. This means that your ad appears even if:

Other words are included in the query ■
Terms in the query are not written in the same sequence as your keyword ■
The query is similar to your keyword. This includes plurals and synonyms. ■

Example: For the broad-matched keyword used book, your ad could appear when users enter the follow

Used book dealer 
Buy used book 
Used and rare book 
Used book for sale 
Used book finder 

About Phrase Match Keyword Targeting

A phrase-matched keyword triggers your ad to appear for any query that includes your keyword or phras
sequence and form that you specify. (Additional terms in a user's query can precede or follow the phras
matching narrows your reach by restricting your ad from showing on irrelevant variations of your keywor

To enable phrase matching for a particular keyword, enclose it with quotation marks.

Example: For the phrase-matched keyword "used book", your ad will appear when users enter the follow

Ad will appear: 
used book dealer 
buy used book 
rare and used book

Ad won't appear: 
used paperback book 
book of used matches
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About Exact Match Keyword Targeting

Exact match is the most precise method for targeting your keywords. Use exact match when you want y
only on a query that precisely matches the keyword you have chosen — without any additional words or
between, or after the keyword. 

To enable exact matching for a keyword, enclose it in square brackets. 

Example: For the exact-matched keyword [used book], your ad could appear when users enter the follow

Ad will appear: 
used book

Ad won't appear: 
used book seller 
used books

About Negative Match Keyword Targeting

Negative-matched keywords prevent your ad from appearing when a search includes a keyword that isn
ad. Your ad won't appear when a negative keyword you've specified is included in a user's search query

To specify a negative keyword, add a minus sign (-) before the keyword or phrase you want to exclude. 
may not restrict your other keywords as much as phrase or exact matches might. 

Example: For the broad-matched keyword used book and negative keyword -college, your ad could app
enter the following query:

 

Ad will appear: 
used book seller 

Ad won't appear: 
used college book

About Embedded Match Keyword Targeting

Embedded match is a sophisticated form of keyword matching that allows you to prevent your ad from a
relation to certain phrase or exact matches. This is popular when an advertiser sells merchandise relate
book, but not the actual movie or book.

Example: An advertiser selling Toy Story merchandise might use the embedded match option of a nega
match on -[Toy Story]. This way, the advertiser's ads appear for Toy Story dolls and Toy Story products
exact match Toy Story.

Implementing Keyword Matching Options 

Implementing Keyword Matching Options

Objective: Learn the benefits of different keyword matching options and how to implement them in an ad

Choosing Keyword Matching Options

When choosing between different matching options, determine what you want to accomplish for the ad g

Here are some things to consider:

Broader matching options tend to give you more impressions but accrue higher costs. Therefore,
matching options (like phrase- or exact-match) along with broad-matched keywords in an ad grou

■

Broad-matched keywords should be at least two-word phrases (gourmet coffee or organic coffee■
Narrower matching options tend to give you fewer clicks and lower your costs. It's still important t
words for these matching options.

■

Negative keywords work well in most cases when you know a term doesn't apply to your busines■
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Also, keep in mind your campaign settings. If your campaign is set up to target a very specific geograph
matched keywords might work well. On the other hand, if you're targeting one or more countries or territ
precise keyword matching options could be used.

Implementing Keyword Matching in Ad Groups

As demonstrated, you can include different matching options for keywords in the same ad group. 

To edit or add a keyword with matching options in your ad group: 

Sign in to your account at adwords.google.com.1.
Select the campaign, and then the ad group you want to edit.2.
Click the Keywords tab on the Ad Group Details page.3.
Click Quick add or Edit keywords.4.
Enter your keyword with the proper punctuation (e.g. quotes, brackets).5.
Click Save.6.

You can also edit or add multiple keywords across campaigns in your account using the Keyword Tool. 

Keyword Matching Examples

Take a look at the following ad. Which keywords and keyword matching options might work best? (Assu
campaign is targeted to one country and one language.) Let's compare different keywords for broad, ph
matching options. 

Find New and Used Books 
Special Shakespeare Collection. 
Huge Selection. Order Online Today. 
www.Bookstore-Example.com

 
 

Potential Broad-Matched Keywords

Used books 
Used rare books 
Used Shakespeare plays 

Used books is probably too general for this ad. The ad could appear for queries such as used bio
used shelves for books. As a result, the ad would probably accrue many impressions but few clic
return a low CTR. A better idea might be to try this keyword as a phrase- or exact-matched term.

■

 
Used rare books and used Shakespeare plays are better broad-matched keywords. They're mult
that provide more detail about the nature of the ad. The result would be more relevant clicks and 

■

Potential Phrase-Match Keywords

"used books" 
"Shakespeare books" 

"Used books" as a phrase-matched term works better than a broad-matched term because you'll
looking for different variations of used books. It ensures that the ad appears only if users search 
books in that order. The ad could appear if users search on Shakespeare used book or used boo

■

 
"Shakespeare books" is also an effective phrase-matched keyword, as it represents types of boo■

Potential Negative-Matched Keywords

Shakespeare plays 
-performance 
-auditions

The broad-matched keyword Shakespeare plays doesn't differentiate between users searching for book
plays, performances of Shakespeare plays, or auditions for Shakespeare plays. Adding the negative key
performance and -auditions would eliminate many unwanted impressions, and possibly improve your CT

Final Keyword List

By taking the top picks from above, the final keyword list in an ad group would look like this:

Used rare books 
Used Shakespeare plays 
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"Shakespeare books" 
"used books" 
Shakespeare plays 
-performance 
-auditions

Keywords and Placements Together 

Keywords and Placements Together

Overview: AdWords ad groups can have keywords, placements, or both. The keyword and placements 
with your campaign settings, determine where on the content network your ad can appear. 

This lesson will discuss how your keywords, placements, and campaign settings interact with each othe
placements for your ad. Remember that only the content network is targeted by both keywords and plac
results are targeted only by keywords. 

Ad Group Choices for Keyword and Placements Targeting

You'll begin any new AdWords ad group with either keywords or placements. Many people prefer to star
but the choice is always yours. After a new ad group is created, you can add more keywords or placeme
clicking the appropriate tab on the ad group page. You can also remove keywords and placements at an

In other words, you have three possible ad group combinations:

keywords only■
placements only■
keywords and placements both■

If your ad group has placements only, then the ads can appear only on the content network. If your ad g
keywords only, or keywords and placements, then the ads can appear on both the search network and t
network, depending on the campaign settings you choose. 

All three types of ad groups compete with each other in AdWords. If an ad position is available on the co
placement-targeted ads and keyword-targeted ads from all advertisers will compete for the position.

How Keywords and Placements Work Together

The rule to remember is this: Keywords always do their work first. When an ad group has keywords, the
always starts by looking through every possible page in the content network to find content that matches
Only then does the system check to see if any of those content pages match your placements. 

This means that if a placement you choose isn't a good match with your keywords, your ad won't appea
don't want keywords to be involved, create a separate ad group or campaign with placements only.) 

This also means that when you combine keywords and placements, the main role of a placement is to le
bid when your keywords put your ad on that placement. If you know that your keyword-targeted ads per
certain website, you might choose that site as a placement with an increased bid to give your ad a bette
there. For a very advanced feature, you can also insert different destination URLs when your ad appear
placements. 

If you choose 'Relevant pages across the entire network,' your keywords will be used to place the ad an
content network, whether you've targeted those placements or not. If you choose 'Relevant pages only o
I target,' your ad will appear only when keywords match your ad to a placement you have selected in yo

Here are how some combinations of keywords, placements and campaign settings will place your ads o
network. (The search network, remember, is affected only by keywords.) 

Keywords only + 'Relevant pages across the entire network'

Your ads can appear on any content network page where the content matches your keywords.■
You've chosen no placements, so they don't affect this ad group.■

Keywords only + 'Relevant pages only on the placements I target' 
You've chosen no placements, so there's nowhere for these ads to appear.■

Combining Keywords and Placements
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Ads from this ad group won't run unless you add placements or change your campaign settings.■
Placements only + 'Relevant pages across the entire network'

Your ads can appear only on placements you've targeted.■
You've chosen no keywords, so there's no way to target your ad contextually to any other pages.■

Placements only + 'Relevant pages only on the placements I target' 
Your ads can appear only on the placements you've targeted. ■

Keywords with placements + 'Relevant pages across the entire network' 
Your ads can appear on any matching content network page. ■
Your placements are used only for bid adjustments or to assign individual destination URLs.■

Keywords with placements + 'Relevant pages only on the placements I target' 
Your ads will appear only on your placements, and only if those placements also match your key■

Keyword and Placement Targeting Pricing

Campaigns that target the content network can take cost-per-click (CPC) or cost-per-thousand-impressi
This is true whether keywords, placements, or both are used to target your ads. However, CPM pricing c
for the content network. Campaigns that target Google search along with the content network can use o

When a placement is targeted by both keywords and a placement, the placement bids will take priority. 
placement bid has been created, that will be used. If not, the ad group default placement bid will be use
bids has been made, then the content network bid from your campaign settings page will be used. Final
above apply, then your ad group default bid will be used. If you have made individual keyword bids, they
with the ad group default bid as they normally are in determining pricing and ranking for contextually-tar

To put it in order, from highest priority to lowest: 

Individual placement bid1.
Ad group placement bid2.
Content network bid3.
Ad group default bid (combined with individual keyword bids, if applicable)4.

AdWords - Contacting Us - Help with other Google products - Change Language: English (US)  
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About Ad Relevance, Quality and Performance 

About Ad Relevance, Quality and Performance

Objective: Learn about how quality impacts Google search results, ads, 
and the performance of your account. Find out how to monitor your 
performance. 

How AdWords Monitors Performance

AdWords uses a dynamic variable called 'Quality Score' to evaluate 
keyword relevance. Quality Score is based on your keyword's clickthrough 
rate (CTR) on Google; the relevance of your ad text, keyword, and landing 
page; and several other relevance factors. 

A Quality Score is calculated every time your keyword matches a search 
query-that is, every time your keyword has the potential to trigger an ad. 
Quality Score is used in several different ways, including influencing your 
keywords' actual cost-per-clicks (CPCs) and the first page bid estimates 
that you see in your account. It also partly determines if a keyword is 
eligible to enter the ad auction that occurs when a user enters a search 
query and, if it is, how high the ad will be ranked. In general, the higher 
your Quality Score, the lower your costs and the better your ad position. 

Quality Score helps ensure that only the most relevant ads appear to users 
on Google and the Google Network. The AdWords system works best for 
everybody-advertisers, users, publishers, and Google too-when the ads 
we display match our users' needs as closely as possible. Relevant ads 
tend to earn more clicks, appear in a higher position, and bring you the 
most success.

How You Can Monitor Performance

Due to the dynamic nature of search, your keywords' Quality Scores can 
fluctuate often. Therefore, it's a good idea to keep tabs on your 
performance and make adjustments as needed. 

To analyze your account performance quickly, use the following resources:

Keyword Analysis page: Check the Keyword Analysis page to get 
a detailed view about your keyword's performance — including how 
Quality Score impacts your keyword and ad performance and how 
you can improve it. You'll also find your first page bid estimate, 
which tells you the cost-per-click (CPC) bid likely needed for your 
keyword to trigger ads on the first page of search results. To launch 
the Keyword Analysis page, point your cursor over the magnifying 
glass icon beside any keyword in your account; then click one of 
the 'Details and recommendations' links.

■

 
Keyword Status: View the 'Status' column on the 'Keywords' tab of 
your Ad Group Details page. Your keyword status indicates whether 
or not your keyword is triggering ads to appear on search results 

■

AdWords Help
Quality and Performance Basics
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pages. As mentioned, each of your keywords (except any negative 
keywords) is identified by a keyword state. Here's the full 
breakdown: 
 

Active: Active keywords are eligible to trigger ads. You may 
see the following two notes beneath the 'Active' status:

■

Bid is below first page bid estimate of ____: This will 
appear if your keyword's cost-per-click (CPC) bid 
doesn't meet the amount likely to place your ad on 
the first page of Google web search. 

■

Ads show rarely due to low Quality Score: This will 
appear if your keyword's Quality Score is very low 
and preventing your ad from accruing much traffic. In 
this case, we recommend following these optimization 
tips to improve your Quality Score.

■

 
Disapproved: These keywords don't comply with our 
Editorial Guidelines or Content Policy and won't trigger ads 
until you correct the problem.

■

 
Paused/Deleted: These are keywords you've paused or 
deleted. They won't enter the ad auction and therefore won't 
trigger your ads. 

■

 
To learn how to enable a keyword that isn't running, visit the 
Keyword Status troubleshooting topic.  
 
CTR Column: View the 'CTR' column on your Campaign Summary 
page to see how well a campaign is performing. The higher the 
clickthrough rate (CTR), the better the campaign is probably doing. 

■

For more in-depth performance tracking, we suggest that you set up 
conversion tracking or Google Analytics. 

Ad Relevance and Quality

People use Google because they find what they're looking for fast — 
whether it be the latest news, best candy bar, or closest pizzeria. This is 
the essence of relevance: Google provides users with the most relevant 
search results based on their search.

However, relevancy doesn't end with our search results. We also work to 
show the most relevant ads for every search query. This model works for 
users and advertisers alike: The more relevant the ads are, the more likely 
users are to click on your ads now and again in the future. 

We measure relevancy for search and ads differently. 

For search results, relevance and ranking are automatically 
determined by over 100 factors, including Google's patented 
PageRank algorithm.

■

For AdWords ads, the most important factor in relevance and 
ranking is the ad's quality, also called the Quality Score. This 
measurement is the strongest representation of how useful a user 
has found an ad to be and is central to the AdWords cost-per-click 
(CPC) pricing model. 

■

Account-Wide Issues 

Account-Wide Issues

Objective: Learn how to identify and correct issues at the account level 
that may prevent ads from showing.

Ad Visibility and Troubleshooting
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Email Verification for Account Activation

In order to activate your account, you must first verify your email address. 
If you have not verified your email address and you attempt to sign in to 
your account, you will receive a message to check your email to verify your 
email address.

Visit your email account, and open the email verification notice from 
AdWords. Click the link in the email to verify your email address and 
access your account. Then, continue with the activation instructions. 

Submitting Billing Information for Account Activation

After you verify your email address, the next step is to enter your billing 
information. If you haven't entered your billing information, you'll see a 
message when you log in to your AdWords account reminding you to do 
so.

Click on the link in the message, or click on the My Account tab and then 
Billing Preferences in your AdWords account to enter your billing 
information. If you're using a credit card or debit card, be sure to enter the 
billing address that matches the credit card.

Your ads will appear on Google after you've entered valid credit card or 
debit card information. In the case of direct debit, a debit authorization may 
have to be received and processed before your ads will start running. If 
you choose to pay via prepay, your ads may appear once funds have been 
received via credit card or bank transfer or after your bank transfer setup is 
complete. 

For more information on the payment options available for your billing 
location and currency, visit the Billing lesson.

Declined Payment Issues

If we aren't able to process a payment for your account, your ads will 
temporarily stop running and you'll receive an email regarding the declined 
payment. You'll also see a message when you log in to your AdWords 
account.

If you're not sure why a payment is declined, use the following checklist to 
figure out possible reasons:

Have you entered valid payment details (such as credit card 
number or expiration date)?

1.

Do you have sufficient funds in your account, or have you reached 
your daily, weekly, or monthly spend limit?

2.

Have you entered the correct billing address?3.
If your payment is still declined, contact the financial institution handling 
the funds to get more details about a declined payment. 

Campaign-Specific Issues 

Campaign-Specific Issues

Objective: Learn how to identify and correct issues at the campaign level 
that may prevent your ads from showing.
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Paused, Deleted or Ended Campaigns

If a campaign is Paused, Deleted, or Ended, ads within that campaign will 
not show. Follow the steps below to reactivate your campaign from your 
Campaign Summary page:

Paused: Check the box next to the name of the campaign, and 
click the 'Resume' button above the Campaign Summary table.

■

Deleted: Click on the name of the campaign to go to the Campaign 
Details page. Then click the 'Undelete Campaign' link that appears 
next to the campaign name.

■

Ended: Change the campaign end date. Check the box next to the 
name of the campaign, and click 'Edit Settings.' Adjust your end 
date next to the 'Will run until' section, under the Basic Settings 
heading.

■

Daily Budget Settings

Your ads might not show if your campaign is close to reaching, or has 
already reached, its daily budget.

To see whether your daily budget is being met, visit your Campaign 
Summary page, set the date range above the table to yesterday, and 
compare the Current Budget column with the Cost column. If you 
exceeded your daily budget yesterday, your ads may stop running before 
today's daily budget is reached. 

We might exceed your daily budget when we determine that your ad can 
benefit from more exposure on particularly heavy traffic days. However, 
our system makes sure that in a given billing period, you are never 
charged more than the number of days in that month multiplied by your 
daily budget. Visit the Billing lesson for more information.

To view the recommended daily budget for a campaign, or to edit the 
existing daily budget, go to the Edit Campaign Settings page, and click 
Recommended Budget. This recommendation will be high enough to 
capture all of the clicks the system estimates your ads will receive with full 
exposure.

Remember that this number is only a recommendation, and you should set 
your daily budget at a level with which you are comfortable. If you don't 
wish to raise your daily budget, you can try refining your keywords by 
using the techniques found in the Optimization lessons.

Ads Targeted Outside Your Region

You can target your campaigns to specific languages and geographic 
regions. However, if these targets do not include your own language 
settings and geographic location, you will not be able to see your ads.

To view or edit the language targeting for your campaign, check the 
Languages section under Target Audience on your Edit Campaign 
Settings page. Ensure that your Google interface language, which 
you can view by clicking the Preferences link on your Google 
homepage, is included on the list of selected languages.

■

 
To view or edit the geographical targeting settings for your 
campaign, check the Locations section under Target Audience on 
your Edit Campaign Settings page. Ensure that your own 
geographic location is included within the geographic regions that 
you have chosen.

■

For more information about targeting your ads, visit the Language and 
Location Targeting lesson.
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Campaign Negative Keywords

If there is overlap between your negative and regular keywords, the 
negative keyword will block your regular keywords from showing. To 
ensure that this isn't happening in your campaign, review the negative 
keywords and making changes where necessary. This will allow your 
keywords to show your ad. 

To learn more about negative keywords, please refer to the Keyword 
Matching lesson.

Google Network Issues

If your ad isn't appearing on sites in the Google Network, check to make 
sure your campaign is opted in to our content or search networks by 
visiting your Edit Campaign Settings page. (Sign in to your account > 
Check the appropriate campaign > Click the Edit Settings button). You 
can opt in to the search network, the content network, or both under the 
Networks and bidding section of this page. 

For ads to show on partner sites, the ads must: 

Be reviewed and approved■
Be in a campaign opted-in to the Google Network■
Meet partner requirements, which vary■

To determine whether an ad is showing on our search or content partner 
network, check the Search and Content totals on the Summary tab in 
your ad group. If no content impressions have occurred, you can check the 
Average Position column to make sure that your ads have a high enough 
average position to appear on the Google Network. Many of our partners 
accept only the ads that rank highest on Google.

Ad Group-Specific Issues 

Ad Group-Specific Issues

Objective: Learn how to identify and correct issues at the ad group level 
that may prevent ads from showing.

Bid and Budget Issues

If the cost-per-click (CPC) or cost-per-thousand impressions (CPM) bid for 
your ad group is higher than your campaign daily budget, the ads won't 
run. To lower your CPC or CPM bid from the campaign details page, check 
the box next to your ad group, and click the Edit Bids button.

Ad Group Status

Ads in paused or deleted ad groups will not show. To resume a paused ad 
group, check the box next to the ad group, and click the Resume button 
above the Campaign Details table. To restore a deleted ad group, click the 
Undelete Ad Group link next to the ad group title and status at the top of 
the page.
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Ad Approval Issues

We may disapprove an ad if it doesn't meet Google's editorial and policy 
guidelines. If an ad is disapproved, it will stop running. When you have a 
disapproved ad, an alert box will appear in your account. In addition, your 
ad will also be marked as 'Disapproved.'

Click on View reason(s) under the affected ad to see the specific 
disapproval reasons. Then make the appropriate changes. Editing your ad 
will automatically re-submit it for review. Visit our Editorial Guidelines to 
learn more. 

To view all your disapproved ads, you can click View all ads in the alert 
box. You can also go directly to the Tools > Disapproved Ads page to 
make corrections to your ads.

Adult Content Issues

Ads for sites containing sexually explicit material will only show alongside 
search results on Google.com that contain adult material. A Google search 
results page that contains very little adult content will not display adult ads. 

To enable an adult ad to show, use specific keywords that are relevant to 
your targeted audience. You can also try searching for one of your 
keywords in combination with a more sexually explicit phrase, such as 
'xxx.'

Please note, some of the sites in the Google Network may restrict 
advertising or keywords based on their own policies regarding content and 
editorial standards. 

Missing Keyword, Placement or Ad Text

If you're running a search campaign, make sure you have at least one 
keyword and one ad in your ad group. If you're targeting the content 
network with a campaign setting of 'Relevant pages across the entire 
network,' make sure the ad group contains at least one ad and one 
keyword or placement. If you're targeting the content network with a 
campaign setting of 'Relevant pages only on the placements I target,' 
make sure the ad group has at least one ad and one placement. 

Keyword and Placement Specific Issues 

Keyword- and Placement-Specific Issues

Objective: Learn how to identify and correct issues with your keywords or 
placements that may prevent your ads from showing.

Keyword or Placement Bid Issues

If you have chosen to specify values for your keywords or placements, 
remember to make sure that the CPC or CPM values don't exceed your 
campaign's daily budget.
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Disapproved, Deleted or Paused Keywords

Your ad will not show for keywords that are disapproved, deleted, or 
paused. You can see the status of a keyword in the Status column on your 
Ad Group Details page. 

Disapproved keywords: Refer to the disapproval email you 
received for instructions on how to re-enable a disapproved 
keyword. Or, visit the Editorial Guidelines page or the Content 
Policy page.

■

 
Deleted keywords: Re-add the deleted keyword to your ad group 
to re-enable it. If you delete a keyword and add it back to your 
account in any other format or any other location (another ad group, 
for instance) our system takes the keyword's account-wide 
performance into consideration. A poor performer can affect an 
entire ad group or campaign. For this reason, we recommend you 
regularly review your account's performance and either optimize 
poorly performing keywords or increase their CPC bids.

■

 
Paused keywords: To resume a paused keyword, check the box 
next to the keyword on your Ad Group Details page and click 
'Unpause.'

■

To launch the Keyword Analysis page and learn more about your keyword 
status, point your cursor over the magnifying glass icon beside any 
keyword in your account. A help bubble appears, which gives you a 
snapshot of your keyword's Quality Score and whether or not your 
keyword is triggering ads. Then, click one of the 'Details and 
recommendations' links to access the Keyword Analysis page.

Low Quality Score Issues

If your keyword's bid doesn't meet the first page bid estimate and its Quality Score is very low, the Status column of 
the Keywords tab in your Ad Group Details page will read Active: Ads show rarely due to low Quality Score. 
Neither the Status column nor the Keyword Analysis page will show the first page bid estimate. This is to 
emphasize the importance of improving your keyword's Quality Score through optimization rather than increasing its 
bid. Optimization will save you money, plus help ensure the quality of the AdWords program and the overall user 
experience. 

If you see this message in your Status column, visit the Keyword Analysis page for more information on your 
Quality Score.

Introduction to AdWords Reports 

Introduction to AdWords Reports

Objective: Understand what reports are and how they are used. Learn where to find reporting 
features and how to create customized reports based on your needs.

AdWords Reports Explained

Reports are collections of statistics that help advertisers analyze their accounts.

The AdWords Report Center can generate fully customizable reports on specific topics such 
as campaigns, keywords, and ad text. These reports let users identify important trends over 
weeks, months, or years. Most reports can also be viewed as graphs, which offer a clean 
look at spikes and dips in traffic, CTR, or other key elements of an account. And because 
each report can be customized with configurable columns and performance filters, they 

AdWords Reports
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provide just the information you need to help you identify your strengths and build on them, 
and to sniff out areas of low performance and optimize these areas accordingly.

You can view your reports online, or you can download them to your computer and view 
them with a spreadsheet application, such as Microsoft Excel. You also can have reports 
generated and emailed to you regularly.

Creating AdWords Reports

We currently offer nine types of performance reports, each fully customizable based on the 
levels and types of data you want included. These report types, which cover the basic data 
users most often want to see, are:

Keyword Performance: Displays details on selected keywords and organizes 
statistics by keyword. 

■

Ad Performance: Presents relevant statistics for ad variations, such as text ads, 
image ads, video ads, and local business ads.

■

URL Performance: Displays statistics and measures the performance of destination 
URLs. 

■

Ad Group Performance: Organizes statistics for each of your ad groups. ■
Campaign Performance: Organizes statistics for each of your campaigns.■
Account Performance: Generates statistics for your entire account, or for a portion of 
your account. 

■

Search Query Performance: Shows performance data for the search queries that 
triggered your ads which appeared after receiving clicks.

■

Placement Performance: Shows statistics for ads that appeared on specific domains 
or URLs in the Google content network.

■

Reach and Frequency Performance: Find out how many people saw your ads and 
how many times they saw them over a certain period of time. 

■

Creating your report is as simple as following our four-step form, and then clicking 'Create 
Report' when you're done. Here's how: 

Report Type: To begin creating your report, select your Report Type from radio 
buttons beside each report name. Your options on the remainder of the page will 
ajdust according to the type of report you have chosen.

1.

Settings: In this section, you establish your report View and Date Range, and which 
ad groups and campaigns to include.

2.

View: Choose 'Summary' for a high-level overview of all your selected stats, or 
choose from among 'Hourly (by date or regardless of date),' 'Daily,' 'Weekly,' 
'Day of week,' 'Monthly,' 'Quarterly,' or 'Yearly' metrics for your account. 

■

Date Range: Use the pull-down menu and select a time period (i.e. 'Last seven 
days,' 'Last 30 days,' 'This month,' etc.) for your report. For specific dates for 
summary, Daily or Weekly views, click on the date fields underneath the pull-
down menu. Clickable calendars will appear, from which you can select report 
beginning- and end-dates. (Note: Hourly report data is available from February 
1, 2006 onwards).

■

Campaigns and Ad Groups: To include all campaigns, choose the first radio 
button. For individual campaigns or ad groups, choose the manual selection 
option and click on the campaigns and/or ad groups you want included in your 
report. Choose as many or as few as you want included. 

■

Advanced Settings: In this optional section, you can customize columns and filters 
so your report includes only the data you want to see.

3.

Columns: Click the 'Add or Remove Columns' link to reveal check boxes for 
each of the available column categories for your report type. You'll find a wide 
range of choices, including Impressions, Clicks, CTR, Avg CPC, Cost, Avg 
Position, Campaign, Daily Budget, Campaign Status, Ad Group, Ad Group 
Status, Headline, Display URL, and many others. As you add or remove 
columns, the visual column display is updated based on your selections.

■

Filters: Click the link to 'Filter Your Results' for filter options based on your 
report type. Filters allow you to refine up to four data types. Use the pull-down 
to select and customize the relevant data types for your report. Depending on 
your report type, your filter options may include Ad Distribution, Status, Match 
Type, Site/ Keyword, Avg Position, Clicks, Cost, Avg CPC, CTR, and 
Impressions, among others. 

■

Templates, Scheduling and Email: In this section, you'll name your report, save it as 
a template if you want to reuse your settings, and provide an email and format for 
receiving your report.

4.

Name Your Report: Enter a title for your report. Pick a name that will be easy 
to recognize when you see it on a list of other reports you've created.

■
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Templates: Check the box to 'Save this as a report template' if you want to run 
similar reports later.

■

Scheduling: If you want to run this report on a regular basis, check the box to 
schedule automatic reports and choose from the pull-down schedule menu (for 
delivery daily, every Monday or on the first of every month).

■

Email: To receive an email when your report is ready, check the box and then 
list the email address or addresses you want notified (for multiple addresses, 
separate each email with a comma). If you want your report attached to the 
email, check the next box and select your preferred report format from the pull-
down menu (.csv, .csv for Excel, .tsv, .xml, .html). 

■

You're almost done! Now, just click the 'Create Report' button and you'll see a screen 
confirming that your report has been submitted.

At the top of the page you'll see Google's estimate of how long your report will take to 
generate. (Most reports take a few minutes or less.) Next comes a text box directing you to 
the Download Center, where you can review your report when it is completed. To the right 
you'll see details of the report you have just run.

An important note: You don't have to wait at this page for your report to finish running. You 
can continue to browse through your account, sign off for a time, or even shut down your 
computer and return later. The report will continue to run and should be ready for you when 
you return. And if you requested an email notification and / or attached report, the report 
notice and attachment will be sent as soon as the report is completed.

You can view your report online in three formats: as data only, as graphs created from your 
data, or as both data and graphs together in one report.

If you prefer to download the report to your computer, you can do so in the same formats you 
can choose from for emailing your report: .csv (for Excel), .csv, .tsv, .xml., and .html .csv 
(comma-separated values) and .tsv (tab-separated values) files are encoded in UTF-8. 
These formats are recommended for users who prefer to process or review report data in text
-only format. .csv (for Excel) files are encoded in UTF-16LE, and are compatible with most 
U.S. and international versions of Microsoft Excel. Select .xml (for 'Extensible Markup 
Language') to place your statistics in a database or on a website. Select .html (for 'Hypertext 
Markup Language') if you want to be able to view your report as a webpage. You may also 
open your report as a Google Spreadsheet for easy viewing and collaboration purposes.

About Report Graphs

If you click on the View report link, your report will contain the fields and values you selected 
along the top. The table is dynamic, so you can sort by each metric by clicking on the name.

To save your graph, click 'Export Report' and select 'Download graph.' 

Additional Reports Features 

Additional Reports Features

Objectives: Learn how to download and save reports and edit report templates, and get some 
basic report troubleshooting tips. 

About Report Center

Under the Reports tab in your AdWords account, you'll see a link for the Report Center. 
Click on this link to view your reports.

In the Report Center, you'll find links to your most recently created reports, under the header 
Saved Templates as well as your scheduled reports and any on-demand reports you saved 
as templates. 

The Last 15 Reports section presents the last 15 reports you've created, along with the date 
range they covered, the dates they were requested, and their status (usually Completed). To 
view a report in this section, click on the report name. 
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An important note: Once you create more than 15 reports, the system will automatically 
delete your oldest report whenever a new one arrives. If you have scheduled a daily report, 
for instance, the oldest report will be deleted each day to make room for the new one. You 
can also delete reports you no longer want saved on this list by clicking the Delete link on the 
far right of the report name line.

Within the Saved Templates section, you can see all scheduled and on-demand reports 
saved as templates when you created them. The table tells you the date range for each, the 
time when each scheduled report will run next, and whether you're receiving the report by 
email. You can run either an on-demand report or a scheduled report by clicking the link 
marked Create Report. 

You can also edit any of these saved templates by clicking the Edit this template link. This 
will open up the template in the Edit Template page, which is similar to the Create Report 
page that you used to create the original report upon which you based the template. Here, 
you can revise your saved template by reassigning report values for Report Type, Date 
Range, View and Campaigns and Ad Groups. And you can further customize your new 
report by resetting the columns and filters within the Advanced Options section.

Once you have edited your template, you can choose to rename the template, schedule 
reports for automatic delivery, assign an email address or addresses for notification, and 
select a format for report delivery. Then just click Save Template and you're all done 
creating a new report from your saved template.

To permanently delete a report template at any time, click the Delete link.

Email Reports and Multiple Email Addresses

You can receive an email notification of a completed report, or receive the report itself via 
email in one of five formats that you can specify when you create your report. 

Check the box next to the statement Whenever the report runs, send email to: when 
creating the report and then type into the text box the email address or addresses to which 
you want notification sent when the report is finished. For multiple email recipients, separate 
each email address with a comma. If you schedule the report to run regularly, you'll be 
notified each time the report runs.

By checking the box for with report attached as: you also can choose to have your report 
sent as an email attachment. Select your preferred report format from the pull-down menu: 
csv (for excel), .csv, .tsv, .xml, and .html

Please note that files will be emailed in a zip, or compressed, format. Compressed reports 
must be less than 2 megabytes in order for the report to be sent via email. If the file is larger 
than 2 megabytes, you will receive an email notification asking you to retrieve your report 
from the Report Center.

Understanding Return on Investment (ROI) 

Understanding Return on Investment (ROI)

Objective: Learn how to calculate your advertising ROI (return on investment).

Calculating ROI

The term 'conversion' refers to converting from leads to customers or users of your service. 
So if someone clicks on your AdWords ad, and buys something on your site, that click is a 
conversion from a site visit to a sale. Other conversions you might want to track are page 
views or signups.

Advertising is only effective if it generates measurable results for your business. Your Google 
AdWords account is an investment of time and money that you use to drive customers to 

Basic ROI and Conversion Tracking
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your website. In this lesson, the resulting conversions are called your return on investment, 
or AdWords ROI.

ROI can also be called Return on Ad Spend, or ROAS. Your ROI can be calculated as 
revenue from sales, minus advertising costs, all divided by the cost of advertising. For 
example, if your advertising costs for the past week were US$500 and you've sold US$1,000 
worth of inventory as a result, you have a 100% ROI for the week ((US$1000-US$500) 
divided by US$500). To express ROI as a percentage, you multiply the result of this formula 
by 100. 

Determining your AdWords ROI can be a very straightforward process if your business is 
after web-based sales. You'll already have the advertising costs for a specific time period for 
your AdWords account in your Campaign Summary statistics. You can also create reports via 
the Report Center. The net profit for your business can then be calculated based on your 
company's revenue from sales made via your AdWords advertising, minus the cost of your 
advertising. Dividing your net profit by the advertising costs will give you your AdWords ROI 
for that period in time.

In other cases, your ROI may require a different formula. For example, if you're interested in 
calculating the ROI for a page view or lead, you'll have to estimate the values of each of 
these actions. For example, a Yellow Pages ad for your business may cost US$1,000 per 
year and result in 100 leads. Ten of those leads become customers, and each customer 
provides an average revenue of US$120. The value of each lead is therefore US$12 
(US$1200 revenue/100 leads), and your ROI for the Yellow Pages ad is 20% ((US$1200 
revenue minus US$1000 spent)/US$1000 advertising cost) x 100.

A simple alternative to estimating values for your leads and page views is to use a cost-per-
acquisition (CPA) measurement. This method will allow you to focus primarily on how your 
advertising costs compare to the number of acquisitions those costs deliver. Using the Yellow 
Pages example again, your ads may cost US$1,000, resulting in 10 sales: therefore, your 
CPA for those ads is US$100. Your CPA should not exceed your profit derived from each 
acquisition. In the case of the Yellow Pages ad, the CPA is 20% less than the revenue the 
acquisitions provide.

ROI Example - Camera Shop

Ultimately, your ROI calculation will help you determine the best way to spend your 
advertising dollars. For instance, if you represent a camera shop that sells photography 
equipment and provides photography classes, the keywords 'photography' and 'photography 
classes' could both potentially be valuable to you. However, how would you determine which 
keyword would have the greater potential ROI for your business?

Assume that you have a US$100 daily advertising budget. The keyword 'photography' 
generates 110 clicks, resulting in US$120 in sales, but it also costs you US$60 a day. This 
results in an ROI of 100% for that keyword. The keyword 'photography classes' uses only 
US$25 of the daily advertising budget, but generates 40 clicks. These clicks result in US$90 
in sales, with an effective ROI of 260%. This advertiser would be better served allocating 
more of their budget to the 'photography classes' keyword because of its higher ROI, despite 
the potential for fewer clicks for this keyword.

Introduction to Conversion Tracking 

Introduction to Conversion Tracking

Objective: Understand and implement AdWords conversion tracking.

Defining a Conversion

An AdWords conversion occurs when someone clicks on your AdWords ad and performs a 
behavior on your website that you recognize as a completed sale or collected lead. 
Conversions can include the purchase of a digital camera, a visitor submitting their contact 
information for an insurance quote, or a prospective buyer downloading a white paper about 
your company's software capabilities. 
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The conversion rate listed in your account is the number of conversions divided by the 
number of ad clicks. Conversions are only counted on Google and some of our Google 
Network partners. The conversion rate is adjusted to reflect only the ad clicks on which we 
can track conversions.

Another important term to understand when tracking conversions is 'transaction.' While a 
conversion represents somebody coming to your site through AdWords and making a 
purchase, the transaction represents the purchase or desired visitor action itself. 

Setting Up Conversion Tracking

Conversion tracking is free - all you need is an AdWords account and access to your 
website's HTML. Setting up conversion tracking is a straightforward process that gets you 
started tracking overall conversions with minimal steps. You can also select advanced 
conversion tracking options with more customized preferences such as assigning unique 
conversion values. With conversion tracking in general, you can specify conversion types 
such as purchases or sales, leads, signups, and page views. You can also create your own 
conversion type from the Other option. The advanced settings options will be covered in 
detail in later topics.

To set up conversion tracking for your active ads, log in to your account and click the 
Conversion Tracking link on the Campaign Management tab at the top of your account. 

Disabling Conversion Tracking

You can stop or re-start conversion tracking at any time. To do so, log into your account and 
click the Conversion Tracking link on the Campaign Management tab, then click Stop 
conversion tracking. To stop sending tracking data to Google or remove the Google Site 
Stats text, remove the conversion tracking code from your website. Stopping conversion 
tracking in your AdWords account will remove the statistics and tracking information from 
your AdWords account pages. However, your reporting data will still be available via the 
Report Center.

Getting Conversion Tracking Code 

Getting Conversion Tracking Code

Objective: Understand how to select your settings and implement your conversion tracking 
code.

Conversion Tracking Security Level and Language Settings

There are two important options to consider while setting up conversion tracking: the security 
level of the HTML code you would like to implement, and the language you want to use for 
your Google Site Stats link and corresponding informational page. The choice of 'http://' or 
'https://' conversion tracking code is determined by the security level of your conversion 
page. Most shopping carts will use the more secure 'https://' option, and you can easily 
determine your own needs by examining the address bar in your web browser when you 
access your conversion page. If in doubt, use the more secure 'https://' since it will have no 
negative effects on your website. 

Your choice of language will affect which Google Site Stats link is displayed on your 
conversion page. It will also give your users information about conversion tracking in a 
language appropriate for the majority of your site's visitors. 
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Implementing Conversion Tracking Code

Adding the code to your website is a simple cut-and-paste procedure. Make sure that you 
copy all of the code from within your account and that when adding the code to your website 
it is completely within the HTML <BODY> </BODY> tags, as shown here:

[Purchase Conversion Default: Sample code snippet only - DO NOT USE]

<html> 
<body> 
<!-- Google Code for Purchase Conversion Page --> 
<script language="JavaScript" type="text/javascript"> 
<!-- 
var google_conversion_id = 1234567890; 
var google_conversion_language = "en_US"; 
var google_conversion_format = "1"; 
var google_conversion_color = "666666"; 
if (1) { 
  var google_conversion_value = 1; 
} 
var google_conversion_label = "Purchase"; 
//--> </script> 
<script language="JavaScript" 
src="http://www.googleadservices.com/pagead/conversion.js"> 
</script> 
<noscript> 
<img height=1 width=1 border=0 
src="http://www.googleadservices.com/pagead/conversion/1234567890/?
value=1&label=Purchase&script=0"> 
</noscript> 
</body> 
</html> 

Verifying Conversion Tracking Code

You can verify if the code is working by waiting for a conversion to occur or completing a test 
conversion yourself. If you know that a conversion has occurred on your site from an 
AdWords ad, check the conversion column in your reports to see that the conversion 
registered. Please note that updates to your account reports may take up to 24 hours.

You can also run through the process yourself by searching on Google, clicking on one of 
your ads and completing a conversion on your site. However, this method costs you an ad 
click, so we recommend that you wait for a conversion to occur.

The Google Sites Stats Link in Conversion Tracking

The conversion tracking code snippet will show a visible Google Site Stats text block on your 
website's user-facing confirmation pages to indicate that a conversion has been completed. 
This text will only appear to users who have been referred to your site by Google.

You should check your conversion reports to ensure that the conversion has recorded 
correctly. The Site Stats text link is an important feature of the program. It lets users know 
that you're tracking their purchase, and gives them a link to more information about Google 
conversion tracking. 

If you can't see the Site Stats link, verify that the conversion code has been added to your 
webpage with no additional line breaks (compare your page to the conversion code available 
within your account). Some HTML editing programs will insert line breaks into the conversion 
code for the lines that are long enough to have wrapped to a second line in your account. 
The conversion tracking code should not have any line breaks inside of the '<' and '>', unless 
there is a ';' at the end of the line.
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Improving ROI with Conversion Tracking 

Improving ROI with Conversion Data

Objective: Learn to:

Analyze conversion statistics■
Determine the return on investment, or ROI, of your campaigns■
Improve campaign performance using your conversion data■

Overview of Conversion Data

Once you've implemented conversion tracking, two new columns will appear on all of your 
campaign management screens. The Conversion Rate and Cost/Conversion columns give 
you a quick overview of how your campaigns are doing, but they don't include any of the 
advanced statistics available through your Report Center.

The Conversion Rate is the percentage of clicks that become conversions. Cost/Conversion 
is the cost you've accrued over the time period which you're viewing, divided by the number 
of conversions you received as a result of those clicks. This data will give you a quick 
overview of how well your clicks are converting, and the average cost of those conversions.

Ad Group Conversion Data

The conversion tracking statistics available in your AdWords account will provide the data 
you need to improve your ROI. Statistics are available both at the ad group level and via the 
Report Center.

Your ad group summaries will include conversion rate and cost-per-conversion data. Again, 
conversion rate is a basic percentage, highlighting the percentage of clicks you received that 
resulted in a conversion. Your cost-per-conversion number represents the total cost of clicks 
for that campaign or ad group, divided by the number of conversions. This number will help 
you to quickly evaluate your ROI for the ad group as a whole.

Report Center Conversion Data

Your Report Center gives you detailed and specific conversion tracking information. 
Generating a custom report will give you access to all of your conversion statistics, including 
the number of transactions and your cost-per-transaction. See the Reports lesson to learn 
more.

A Custom Report enables you to evaluate keywords based on performance for each 
transaction type. Even seemingly relevant keywords may not provide the ROI you expect, so 
careful evaluation of the actual conversion and transaction data is essential for optimizing 
your campaigns.

After selecting the relevant conversion tracking fields for your report, you can start evaluating 
your account's performance. Conversion rate and cost-per-conversion are important statistics 
to monitor, but each individual conversion can lead to multiple transactions as users shop for 
various products on your site or return later to make additional purchases. Consequently, 
your transaction and cost-per-transaction statistics can prove even more valuable, since 
acquiring regular customers is more valuable than any single conversion. Tracking your 
transaction statistics can provide valuable insight into the effectiveness of your advertising, 
as well as the effectiveness of your site and the value of your product offerings.

Advanced Option Conversion Statistics: The conversion tracking statistics in your AdWords 
account provide data for improving your ROI. When you select the advanced option, you'll 
receive data based on the unique conversion values you have set. 

Conversion Tracking Troubleshooting

Improving the conversion performance of low-ROI keywords can help make your advertising 
budget last. Helpful questions to ask include:
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Are the keywords targeted and relevant enough to produce the desired results? ■

If a keyword is too general, you run the risk of getting clicks to your site 
that aren't really relevant, and have a lower conversion rate. By 
narrowing the appeal of your keywords (using tennis racquet instead of 
just tennis), you'll get more relevant clicks and customers coming to 
your website. 

 
If the keywords are well-targeted, then is your site hindering your conversion rate? ■

Taking a prospect directly to the most relevant page on your site can 
boost your conversion rate. Improving the usability of your site in 
general by making it easier for prospects to find and purchase your 
products or services can make a huge difference in your conversion 
rates. 

Conversion Tracking Limitations

The Google conversion tracking system has a few limitations. Because the tracking code is 
JavaScript function associated with a cookie, Internet users who have disabled cookies or 
JavaScript in their Internet browsers won't be tracked. For this reason, multiplying the 
number of clicks you have received by your Conversion Rate may not always be an accurate 
way to calculate the number of conversions you have received, but should be a close 
approximation. In your reporting, clicks which can't be tracked aren't included in your 
conversion data.

Introduction to Advanced Conversion Tracking 

Introduction to Advanced Conversion Tracking

Objectives: Understand the functions of advanced conversion tracking options.

Overview of Advanced Conversion Tracking

The advanced conversion tracking option enables you to select different values for each 
transaction type. You can even track dynamic values that change for each transaction (also 
called 'dynamic variables'); for example, total purchase amounts. 

To select advanced conversion tracking options and obtain your modified code, set up 
conversion tracking and click Advanced option to the right of each conversion type. You can 
set up conversion tracking by clicking the Conversion Tracking link, located beneath the 
Campaign Management tab in your account.

Conversion Types

AdWords provides four types of conversions that you can define. These should cover the 
majority of conversions you'll want to track. These are: Purchase/sale, Leads, Sign-ups, and 
Page Views. You can also create your own conversion type using the Other label. 

The Purchase/Sale label helps online commerce sites track purchases and sales.■
The Leads label tracks how many users reached a point in your website at which they 
have contacted your company, such as completing a 'request more information' form 
on your website. 

■

The Sign-ups label can track how many users elected to subscribe to a newsletter or 
to download a white paper. 

■

The Page views label enables you to track when a visitor navigates to a specific page 
that you think is valuable.

■

The Other label enables you to define your own conversion type. ■

Advanced Conversion Tracking
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The transaction types are just labels; you're not restricted to tracking only these types of 
transactions. Transaction labels can be assigned to any conversion page you would like to 
track.

Using Advanced Conversion Tracking Code 

Using Advanced Conversion Tracking Codes

Objectives: You'll learn how to:

Define values for your conversions.■
Implement and verify your conversion tracking code.■

Static Variables in Conversion Tracking

The advanced conversion tracking option enables you to define a value for each transaction. 
If the value of each transaction (conversion) does not change (that is, it is static), use the 
Value field, which accepts integer values. For example, if you're tracking signups for a 
newsletter on your site, and you have determined that signups are worth US$25 to your 
company, you would enter '25' into this field. Entering a value for the conversion into the 
advanced field will allow AdWords to calculate the ROI associated with that transaction. 
Using the value of the transaction and the cost data, AdWords can get an accurate cost per 
conversion.

Non-Static (Dynamic) Variables in Conversion Tracking

You'll often place conversion tracking code on a page that summarizes for your users the 
total dollar cost of their purchase. Since the value of each customer's transaction is different, 
the webpage uses what's called a dynamic variable. A dynamic variable is a value that 
changes based on automated calculations, and is part of the code on the page. 

You can track dynamic transaction values by inserting a dynamic variable in the Value field 
when setting up conversion tracking. 

Conversion tracking works with most of the popular webpage development languages 
available. For example, ASP users most likely have a dynamic variable such as <%
=totalValue%>, while sites built with PHP resemble <?echo $totalValue?>.

Verifying Advanced Conversion Tracking Code

Verifying that you correctly added the conversion tracking code to your website is as simple 
as viewing your conversion page in any web browser. If you can see the Google Site Stats 
link, then the code has been correctly placed and you're now tracking conversions. However, 
there are some common errors that could provide irregular results for your conversion 
tracking statistics. Placing your conversion tracking code on the landing page of your ad, for 
example, would result in a 100% conversion rate. Similarly, if you run a report for your 
advanced transaction labels and do not receive the correct value for your transactions - or 
you are returned the correct value but the transaction type is incorrect - check to make sure 
that you have copied the conversion tracking code correctly and completely from within your 
account.

AdWords - Contacting Us - Help with other Google products - Change Language: English (US)  

©2010 Google - Google Home - Privacy Policy - Terms of Service - Advertising Policies 
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How AdWords Controls Your Costs 

How AdWords Controls Costs

Objective: Learn how AdWords helps keep your costs down with the AdWords 
Discounter and smart pricing. 

AdWords Discounter and Actual CPC/CPM

With Google AdWords, you set a cost-per-click (CPC) bid or cost-per-1000-impressions 
(CPM) bid. However, the AdWords Discounter works so you usually end up paying less 
than this amount.

Here's how it works: After we determine your ad rank, the AdWords Discounter 
calculates your actual CPC or CPM. This is the actual amount you pay to maintain your 
ad's position above the next lower ad. Your actual CPC or CPM is never more than the 
maximum CPC or CPM bid you specify. 

About Smart Pricing

Google Network bids may be different from Google web search bids. Using smart pricing, 
AdWords may automatically lower the maximum cost-per-click (CPC) bid for keyword-
targeted ads that appear on Google Network pages. While you set one maximum CPC 
bid, if our data shows that a click from a Google Network page is less likely to turn into 
actionable business results - such as online sales, registrations, phone calls, or 
newsletter signups - we may reduce the bid for that site. 

For example, let's say that you advertise digital cameras. Your ad appears on two 
different pages - a Google web search page for the keyword 'digital cameras' and a 
Google Network page. If Google determines that your ads are not likely to perform as 
well on the Google Network page as on Google web search, AdWords may reduce the 
maximum CPC bid for that site. 

Smart pricing reductions are automatically reflected in the Avg. CPC column on your 
Campaign Summary page.

How You Can Control Costs 

How You Can Control Costs

Objective: Learn how you can control your AdWords advertising costs — primarily 
through your daily budget and bids. Understand the advanced pricing option of content 
bids.

Setting the Right Bids

Your maximum CPC or CPM bid represents the highest amount that you're willing to pay 
per click or thousand impressions, respectively, on your ad. You can set a bid at the ad 
group level, or for individual keywords and placements. (See the Ad Group Details page 
lesson for more information.) If you don't specify a maximum CPC or CPM bid for a given 
keyword or placement, the ad group maximum CPC or CPM bid will automatically apply.

When setting your CPC or CPM bid, consider the following: 

AdWords Help
Cost Control
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Your Quality Score. This is the single most important factor we use in 
determining the price you pay per click for keyword-targeted ads. Therefore, you 
can decrease the overall costs of your ads by increasing your Quality Score. To 
learn more, visit Preparing to Optimize lesson. 

■

 
The value of a click. How much is it worth for someone to visit your website? 
How likely is it that a click will turn into a conversion (sale, signup, etc.)? If high, 
then you might want to set a high bid. If low, lower the bid. You can get conversion 
statistics by setting up conversion tracking or by using Google Analytics.

■

 
Your daily budget. Be sure that your daily budget is higher than your CPC or 
CPM bid. Otherwise, your ad won't show. 

■

Setting the Right Budget

The daily budget is the primary way to control your overall costs. It determines the most 
you're willing to spend per day per campaign. Since you set a daily budget for each 
campaign in your account, you can add up all of your daily budgets to get an idea of how 
much you could spend per day for your entire account. 

The daily budget determines how often your ads show throughout the day. You can set 
your daily budget to be as high or as little as you want. You set your daily budget via your 
Edit Campaign Settings page:

Sign in to your account at https://adwords.google.com.1.
Check the campaign you want to edit.2.
Click Edit Settings.3.
Set a daily budget under the Budget Options section. 4.

When choosing a daily budget, keep the following in mind:
Your daily budget must always exceed your CPC or CPM bid. If it doesn't, your ad 
won't show.

■

 
You can view the recommended daily budget — based on the keywords or sites 
you choose, bid amount, and other factors — by clicking the View 
Recommended Budget link below the Budget field.

■

 
If the recommended daily budget is more than you can afford, optimize your 
keywords, ads, or targeting options. To learn more, visit the Preparing to Optimize 
lesson. 

■

 
You can choose between two ad delivery methods when setting a daily budget: ■

(1) Standard (default setting): Your ad appears intermittently 
throughout the day if we find that your ad receives more charges 
than your daily budget allows. This means that your ad will be 
shown less frequently but spread out evenly throughout the course 
of the day — rather than shown only in the morning.  
 
(2) Accelerated: Your ad appears as often as possible until your 
budget is reached. If your budget is low, this means that your ads 
may stop showing early on in the day, as soon as your budget has 
been exhausted. 

We may "overdeliver" your ad up to 20% more than your specified daily budget on 
a given day to provide your ad extra exposure on heavy-traffic days and to make 
up for days when traffic is low. If we exceed your monthly budget (daily budget X 
30 days), we'll issue overdelivery credits to your bill. See the Billing lesson for 
more details. 

■

Managing Content Bids

You can set separate content bids for clicks on the content network, just like your search 
bids for for clicks on the search network. It's especially useful if you find that you get a 
higher return on clicks from one network than the other. 

For example, if you find that clicks on search pages return more sales than you get with 
clicks on content pages, you might want to lower your content bids. 

Content bids are automatically enabled for all campaigns opted in to the content network. 
You can change your content bids at the ad group level. Here's how: 

Sign in to your AdWords account at https://adwords.google.com. 1.
Click the campaign you'd like to edit. 2.
Check the boxes for ad groups with content bids you'd like to change. 3.
Click Edit bids. 4.
Make your changes in the column labeled Content. 5.
Click Save changes.6.
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If you leave the content bid field blank, your bid will be set to 'Auto' by default. Auto 
content bids are based on an average of all keyword cost-per-click CPCs for the ad 
group (including the default ad group CPC and individual keyword CPCs). You can 
change this automatic bid at any time to a price appropriate for your advertising needs.

Continue to monitor your campaign performance, and make adjustments as needed. To 
learn more about assessing performance, visit the Quality and Performance Basics 
lesson.

Basic Billing Processes 

Basic Billing Process

Objective: Learn how you are billed for advertising costs, and about different payment 
options that are available. 

How Charges Accrue

With cost-per-click (CPC) advertising, you accrue advertising costs only when users click 
on your ad; you are charged for each click based on the CPC bid that you assign to each 
ad group or keyword. With cost-per-impression (CPM) advertising, you are charged for 
each time your ad is displayed, based on the CPM bid you set for each ad group, 
keyword or placement. 

At the end of your billing period, you will be charged for all costs accrued during that 
cycle. The AdWords billing period is defined by Google and is not the billing period of 
your credit card.

Payment Options

Available payment options depend on your billing address country and chosen currency. 
In this topic, we will cover postpay payment by credit card, which is the most widely 
available method of payment.

Google currently accepts Visa, MasterCard, American Express, JCB, and debit cards 
with a MasterCard or Visa logo. Please refer to the Payments Outside of the U.S. lesson 
to learn about direct debit, bank transfer, and Switch/Solo payment methods available in 
countries where credit cards are not widely used. 

Depending on the payment methods offered in your location, you may also have the 
option to pay for your advertising prior to receiving clicks (prepay) or after receiving clicks 
(postpay).

With our prepay option, we will deduct charges from your pre-paid balance each time a 
Google user clicks on your ads. Your ads run almost immediately after payment is 
received.

Our postpay option allows you to pay after users click on your ads and you accrue 
charges. Your ads run almost immediately after submitting your credit card and billing 
information. 

Determine the payment options available for your billing address and currency. 

In addition to these payment options, a select group of advertisers also has the option to 
receive invoices once a month. You can learn more details about invoicing by reviewing 
the Invoicing lesson.

The AdWords Billing Cycle

Your credit card is charged based on your AdWords billing cycle. When you create and 
activate your account with a credit card, debit card, or direct debit, Google starts running 
your ads almost immediately. We then charge you every 30 days unless your advertising 
costs reach a certain threshold within your 30-day billing cycle. 

We won't charge you before 30 days unless you earn US$50 worth of clicks or 
impressions, depending on whether you're running a CPC or CPM campaign. The first 

AdWords Billing Cycle
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time your account reaches US$50 within 30 days, we'll charge you. Then, we'll let you 
accrue US$200 worth of clicks before charging you within the subsequent 30 days. 

If you reach your US$200 limit within 30 days, Google will bill you and raise your billing 
threshold to US$350. Once you reach the US$350 threshold, you'll be billed again, and 
your threshold will be raised to US$500, the maximum allowed. Remember that the 
amount billed may be in excess of the threshold since ads will continue to run and 
generate charges between the time the billing cycle is triggered and the time the charge 
is completed.

The activation fee, along with any other advertising costs accrued, is charged to your 
credit card at the end of your first billing period.

Billing Details and Issue Resolution 

Billing Details and Issue Resolution

Learn about the billing summary and payment details for an account, including the 
application of overdelivery credits, how to resolve declined credit card charges, and how 
to calculate pending charges. Also, become familiar with Google's credit card security 
practices. 

Billing Summary and Payment Details Pages

On the Billing Summary page you'll see your billing history and invoices for your account. 
You can access more detailed information about each invoice by clicking the invoice 
number link.

Your Billing Summary page will appear differently if you're billed on a postpay or prepay 
basis.

If you are billed on a prepay basis, your page will display the following information.

 
Figure: AdWords Billing Summary page for prepay advertisers.  
 

1. Date: The date of payment and invoice activity for your account.

2. Activity: Account adjustments, charges, or declined payments that occurred for the 
reported month, and unique invoices for each payment toward your account.

3. Charge: Your total advertising costs accrued for any month. This column will also 
include adjustments and credits made, including promotional credits, credits for invalid 
charges toward your account, and courtesy credits applied by AdWords client services 
specialists.

4. Payment: Individual payment amounts for the current month. For each payment, you 
can click the related invoice link to view details about the payment method and amount.

5. Balance Remaining: Balance remaining in your account. As you make payments 
and accrue costs, your Balance Remaining column will display the amount of prepaid 
funds left in your account. 

6. Funds Remaining: Current balance remaining in your account. Though similar to the 
Balance Remaining, this amount is based on slightly more updated usage statistics than 
the Balance Remaining and reflects your most up-to-date costs accrued, at any time.

If you're billed on a postpay basis, your Billing Summary page will show the following 
information:

 
Figure: AdWords Billing Summary page for postpay advertisers.  
 

1. Date: The date of payment and invoice activity for your account.

Page 4 of 11خدمات تبليغات در گوگل www.BERTINA.us

خدمات تبليغات در گوگل www.BERTINA.us



2. Activity: Account adjustments, charges, or declined payments that occurred for the 
reported month, and unique invoices for each payment toward your account. 

3. Invoiced Amount: Costs per campaign are itemized by the date billed and relevant 
invoice number. Adjustments will be included within the invoiced amount, and may reflect 
promotional credits, credits for invalid charges toward your account, and courtesy credits 
applied by AdWords client services specialists.

4. Payment: Individual payment amounts for the current month.

5. Balance Due: Invoiced balance. For postpay accounts, where payments are made 
promptly following each invoice, the balance column will typically be zero. This is 
because the Balance Due column does not reflect recent clicks or impressions for which 
you have not yet been invoiced. 

6. Outstanding Balance: Overall balance. This amount reflects your most up-to-date 
costs accrued, including clicks or impressions for which you have not yet been invoiced 
as well as any outstanding billed balance.

Invoice Details

If you would like more details regarding a specific payment, click the invoice number that 
you wish to review. This will take you to the Invoice Details page.

Click Printable invoice to print an invoice for your records.

 
Figure: AdWords Invoice Details page. 

1.Invoice Details: Invoice/payment date and time, applicable taxes, and your invoice 
number. You can also print your invoice, which will include your payment terms 
(immediate charge or credit line), and all line items associated with your payment. 

2.Account Adjustments and Fees: Applicable fees (account activation or re-
activation) and billing adjustments that may reflect promotional credits, credits for invalid 
charges toward your account, and courtesy credits applied by AdWords client services 
specialists.

3.Advertising Charges by Campaign: 

Campaign: Relevant campaign for which activity was recorded.■
Date Range: Corresponding dates for activity accrued per campaign.■
Billable Activity: Explanation of charges (clicks, impressions, or overdelivery 
credit).

■

Number of clicks or impressions: The number of clicks or impressions accrued.■
Daily Budget: The daily budget for the relevant campaign for the delivery period 
shown. 

■
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Amount: Charges accrued during the delivery period shown. This amount may 
also include overdelivery adjustments.

■

Total: Subtotals appear per campaign in the right-hand column; the final line 
represents total advertising charges for the invoice.

■

Payment Received Link

If you return to the Billing Summary page, you'll see that each invoice has a Payment 
received link. Click on this link to view the Payment Details page.

Payment Details Page

The Payment Details page lists the date and time a payment was received, the form of 
payment, and the amount credited.

You can print a receipt for your records from the Payment Details page by clicking the 
Printable receipt link.

Overdelivery Credits

As traffic is never constant from day to day, it is possible that your cost-per-click 
campaign may accrue charges above or below your set limit. To ensure that your CPC 
campaigns reach their potential, Google may allow up to 20% more clicks in one day 
than your daily budget specifies. However, we'll never charge you more than your daily 
budget multiplied by the number of days in that delivery period. 

For example, if you budget US$10 per day in a 30-day month, you may receive more 
than US$10 in clicks on a given day, but the maximum you would pay is US$300 for that 
month. If Google overdelivers your ads resulting in more clicks than your budget allows, 
you will receive a credit to your account. Credits for clicks in excess of your daily budget 
are listed on your invoice as: 'Overdelivery credit.'

Example Scenario

Advertiser's Daily Budget = US10 
 
Day 1 Spend: US$8  
Day 2 Spend: US$10  
Day 3 Spend: US$12  
Day 4 Spend: US$14 

In the above example, this advertiser received US$12 worth of clicks on Day 3. That's 
US$2, or 20%, more than the daily budget.

On Day 1, the advertiser only received $8 worth of clicks, so Google will apply the US$2 
worth of overdelivery charges to Day 1. By applying these charges to Day 1, charges on 
Day 3 meet the advertiser's daily budget. 

On Day 4, the advertiser receives US$14 in clicks. Since Google has allowed his 
campaign to accrue US$14 in clicks, or 40% above the daily budget, Google will return 
20%, or US$2, as an overdelivery credit. In addition, the remaining 20%, or US$2, will 
also be applied as an overdelivery credit because the advertiser reached his daily budget 
each day. 

Credit Card Declines

If Google is unable to charge a credit card, advertising is suspended for that account. 
AdWords notifies the advertiser via email that his or her credit card has been declined.

You can view detailed information regarding any declined payments on the Payment 
Declined Details page. Here you'll see itemized payment declination details by invoice, 
including the date and amount of the attempted charge, and the reason our billing system 
was unable to process your payment.

There are several common reasons why credit cards are declined. If your payment is 
declined, consider the following:

Have you entered the correct credit card number? ■
Have you entered the correct expiration date? Has that date passed? ■
Have you entered the correct billing address and phone number? If the address 
and phone number listed in your AdWords account do not match those associated 
with your credit card, we may be unable to process your charges. 

■
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Have you exceeded your credit limit? Your credit card must have enough 
available credit to cover your monthly advertising budget. If your card does not 
have enough credit, you'll need to decrease your daily budget, or enter a new 
credit card with a higher credit limit. You may need to contact the issuing bank to 
determine the credit limits on your credit card. 

■

If you still cannot successfully submit your credit card information after reviewing the 
information above, contact the card-issuing bank for details about why they have 
declined the particular transaction.

In order to process the declined charge and reactivate your account, you'll need to 
update your billing information. Please note that this is the only way to process a failed 
payment. If you plan to use the same credit card, you can simply click the 'Retry card' 
button to trigger us to try your card again. Once we process your payment successfully, 
your ads will begin running again.

If you're not already using a backup credit card, you may wish to enter one to help 
ensure continuous ad delivery in the future. When you provide a backup credit card, we'll 
try to charge it if your primary card is declined in the future. You can enter a backup 
credit card by visiting your Billing Preferences page and adding a card in the Backup 
Payment Details section.

Pending Charges

Your pending charges are determined by the number of clicks your ads have received 
since the last time you were billed. (If you're running a CPM campaign, the charges are 
determined by the number of impressions you've received.) All pending charges can be 
viewed on the Billing Summary page in your account. The outstanding balance on this 
page reflects the cost of accrued charges since you were last billed. 

Your outstanding balance provides an estimate for upcoming charges for your 
campaigns. Please note that this amount does not necessarily reflect a delinquent 
amount, or a final balance. The outstanding balance is updated throughout the day, and 
includes deductions for any overdelivery credits that may apply. However, this balance 
may still be more than what you are actually charged for that time period, as additional 
overdelivery credits may be applied prior to billing your account. All credits and past 
charges posted to your credit card are also available under the My Account tab.

If you pause or delete your campaigns, it is important to note that any pending charges 
will be charged to your credit card at the end of your billing period. Because your 
AdWords account runs on a 30-day billing cycle, you may be billed for your campaigns 
up to one month after pausing or deleting them. 

For example, an advertiser is billed for his account on June 4, and then pauses his 
campaigns on June 18. He would then be billed on July 4 for any charges accrued 
between June 4 and June 18.

Credit Card Security

Our highest priority is to ensure the security and confidentiality of your personal 
information. 

Google uses industry-standard SSL (secure socket layer) technology to protect every 
interaction you have with the AdWords system. This protects your credit card and other 
personal information. Once we receive your information, it is encrypted and stored behind 
a firewall. 

When payment information is submitted online, Google works with third-parties to verify 
and process your information. Your personal information is encrypted and neither Google 
nor our payment partners share or sell your personal information. Your information will 
only be used for the purpose for which it was provided. For more details, please see our 
Privacy Policy. 

Non-U.S. Payment Options 

Non-U.S. Payment Options

Objective: Learn about various payment options that are available to AdWords 
advertisers outside of the U.S., and how to select the option that's best suited for you. 

Payments Outside the U.S.
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Prepay and Postpay Options

Google's payment options can be divided into two categories: prepay and postpay. 

Our prepay option allows you to pay for advertising before you accrue charges, and 
postpay allows you to pay for advertising after you accrue charges. 

To find out what payment options are available to you, visit 
https://adwords.google.com/select/AfpoFinder. 

Postpay: Credit/Debit cards and Direct debit 

Postpay means you pay Google only after your ads run and charges are accrued. Your 
ads are served almost immediately after you submit valid billing information. For more 
details on how and when Google bills your account, please review the Billing Cycle 
lesson. 

Payment methods for postpay:

Credit/Debit card: You can use a Visa, MasterCard/Eurocard, American Express, 
or JCB credit card, or a debit card with a MasterCard/Eurocard or Visa logo 
(accepted in all countries). This is the most popular and widely available billing 
option for AdWords advertisers. 

■

Direct debit: Selecting this method authorizes Google to submit appropriate 
charges to your bank. Funds are withdrawn directly from your bank account once 
the advertising costs reach the criteria for billing (currently available only in 
Germany, France, Austria, Spain, the Netherlands, Italy, the United States, the 
United Kingdom, and Israel).

■

Qualifying AdWords advertisers can apply for monthly invoicing. Typically, an established 
payment history and minimum spending requirements (varying by country) are 
necessary. To learn more, please see the Invoicing lesson. 

Prepay: Credit/Debit cards and Bank Transfer 

Prepay requires advertisers to pay before their ads run and begin to earn charges. As 
users click on your ads, Google deducts the charges from your prepaid balance. To help 
keep your account balance up-to-date and your ads running, you'll receive emails when 
your funds run low and approach a zero balance. 

Payment methods for prepay:

Credit/Debit card: If you choose this payment method, Google charges your credit 
or debit card in the amount that you specify. Your ads will begin running almost 
immediately after you enter valid credit/debit card information and specify a 
payment amount. You can use a Visa, MasterCard/Eurocard, American Express, 
or JCB credit card, or a debit card with a MasterCard/Eurocard or Visa logo 
(accepted in all countries). 

■

Bank transfer: With this payment method, you transfer funds from your bank to 
Google. Transfers can take several weeks to process, so it's important to add 
funds before your balance draws too close to zero. Bank transfer is not available 
to advertisers in some countries, including the U.S.

■

Bank Transfer Payments

To pay for your advertising via bank transfer, you must first generate a reference number. 
Bank transfers can be initiated following these steps:

Sign in to your AdWords account at https://adwords.google.com.1.
Click the My Account tab, and then click Make Payments.2.
Enter the amount of money you plan to transfer to your AdWords account in the 
Payment amount field, and click Go. 

3.

Click Transfer Information page to view the details of your bank transfer. Here, 
you can access your reference number, the amount you entered for transfer, your 
account information, and the information of the bank to which the funds should be 
transferred. 

4.

Click Print page in the upper or lower left corner of the page, and fill in the 
necessary information about your bank account in the space provided. 

5.

Use the printed sheet, complete with your bank account information, to perform 
the transfer of funds at your bank. **It's very important that you include the entire 
reference number along with the bank transfer. We won't be able to process your 
payment without it. If you can't fit it on your bank's transfer form, insert the entire 
number in the 'Name' field before your name.**

6.

Once Google receives the funds and complete reference number, we will send you a 
confirmation message via email, and your ads will start running on Google. It can take 
several weeks for Google to receive a bank transfer, depending on your bank's process. 

Page 8 of 11خدمات تبليغات در گوگل www.BERTINA.us

خدمات تبليغات در گوگل www.BERTINA.us



Note that different countries may require different treatment of the reference number--you 
will be given instructions specific to your country.

Switching Payment Types & Currency

Postpay advertisers may switch back and forth between available postpay options (credit 
card to direct debit, for example) as well as between different payment providers (such as 
Visa to MasterCard). Prepay advertisers may also switch back and forth between bank 
transfer and prepay by credit card, if the options are available in their country and 
currency. 

It's currently not possible to switch from a prepay method to a postpay method, and vice 
versa. For example, it's not possible to switch from credit card prepay to direct debit. 
Similarly, once a currency has been selected, it's not possible to switch to a different 
currency. The currency selected applies to both billing and payment. 

In order to change currencies or to switch from prepay to postpay, you must close your 
existing account and create a new account with the preferred currency.

VAT for EU Advertisers 

VAT for EU advertisers

Review VAT implications for AdWords advertisers located in the European Union (EU).*

*Legal Disclaimer: Google is not able to provide you with tax advice. Any tax-related 
information provided by Google is not intended as and should not be construed as 
legal, tax or investment advice. You should always consult your tax advisor to help 
answer specific questions regarding how tax laws apply to you and/or your business. 
The tax summary we have provided is necessarily incomplete, and the tax laws and 
regulations are subject to change. Therefore, Google does not guarantee and is not 
liable for the accuracy or completeness of any tax information provided, or any results 
or outcome as a result of the use of this information. 

Please review these resources for additional information about tax regulations: 
http://europa.eu.int/comm/taxation_customs/taxation/vat/how_vat_works/index_en.htm

AdWords and European Value Added Tax

AdWords accounts with European Union billing addresses are subject to VAT charges. If 
you have an AdWords billing address within the European Union, this topic applies to 
you.

Billing Address in Ireland

All EU advertisers are affected by VAT. Advertisers with billing addresses in Ireland are 
subject to different VAT implications than those with billing addresses in the rest of the 
EU.

Advertisers with an Irish billing address, and who have provided Google with a 
valid VAT registration number do not need to self-assess VAT charges. Google 
will automatically assess your account at the Irish VAT rate. 

■

Advertisers with an Irish billing address who do not provide Google with a valid 
VAT registration number are also assessed at the current Irish VAT rate. The Irish 
VAT rate is subject to change per the Irish government's discretion. 

■

Billing Address in EU, Outside Ireland

If your billing address is outside of Ireland and you provide Google with a valid EU VAT 
number, Google will not charge VAT to your account. You must self-assess for VAT at 
the EU member country rate where your billing address is located.
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However, if your billing address is outside of Ireland and you do not provide Google with 
a valid VAT registration number, Google will charge VAT to your account at the current 
Irish VAT rate. VAT charges will appear in your Billing Summary. 

Providing Google with a VAT Number

New advertisers are asked to provide VAT information during the account creation 
process. You can enter your VAT number at the bottom of the Edit Billing Preferences 
page. Current advertisers already registered for VAT in an EU member state can enter 
their registration numbers by following these steps:

Log in to your account at https://adwords.google.com1.
Click the My Account tab.2.
Click Billing Preferences on the My Account tab.3.
Select the appropriate VAT option and enter your VAT registration number.4.

Invoicing Basics 

Invoicing Basics

Learn how invoicing works, and the standard criteria for invoicing eligibility.

What is Invoicing?

Invoicing is an additional form of billing available to qualifying Google AdWords 
advertisers. 

AdWords advertisers who meet certain requirements can apply for monthly invoicing. 
This billing option allows for payment on a monthly basis by check or wire transfer. Once 
approved for monthly invoicing, an advertiser's campaigns are no longer subject to 
suspension in the case of a declined payment.

Invoicing Prerequisites

Typically, invoicing candidates have an established credit history with the Google 
AdWords program and a spending level of US $1500 per month for at least three months. 
If you meet these requirements, you may begin the application process.

Applying for Invoicing

Monthly invoicing is offered at Google's sole discretion. Advertisers must first submit a 
credit application for review and approval by Google's finance team. In some cases, our 
finance team may request that you send your company's audited financials (balance 
sheet, income statement, cash flow statement and/or references) for further 
consideration.

If Google approves your application, you'll receive an offer of monthly invoicing via email 
as well as a request for confirmation of your billing address including company name, 
contact name, and address. You may then accept the terms by responding to the email. 
Once you accept the payment terms and confirm your billing address, your AdWords 
account will be switched from credit card billing to monthly invoicing. 

Invoice Budgeting and Payments 

Budgeting for and Paying Invoices

Learn how to determine an appropriate budget based on your credit limit, and how to 
submit invoice payments.

AdWords Invoicing
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Determining Daily Budgets for Invoicing

After accepting invoicing terms, an advertiser's combined daily budget cannot exceed 
1/30th of their 30-day credit limit. To determine a rough estimate of what you may spend 
per day, divide your credit limit by 30. 

For example, you have a credit limit of US$6000. Divide 6,000 by 30 to arrive at the 
estimated daily budget for all your campaigns. In this case, the combined daily budget for 
all of your campaigns should not exceed US$200. If the sum of your spending exceeds 
the maximum daily limit at any time, ad delivery will be slowed so you aren't charged 
more than your credit limit allows. Ads will be shown evenly throughout the day, but at a 
slower rate.

Making Invoice Payments

Invoices are sent on approximately the fourth business day of each new month. When an 
invoice is sent, a new line item appears on the Billing Summary page, detailing the 
included charges. All payments are due upon receipt of invoice. Non-payment within 15 
business days of the invoice date may result in account termination.

AdWords - Contacting Us - Help with other Google products - Change Language: English (US)  

©2010 Google - Google Home - Privacy Policy - Terms of Service - Advertising Policies 
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Preparing to Optimize 

Preparing to Optimize

Objective: Learn what an optimization is and why all advertisers should optimize from time to time. Then, get started by 
taking inventory of your website, account, and competitors' websites. 

What's an Optimization?

An optimization is the process of adjusting parts of your account — like your keywords and ad text — and your website to 
improve the performance of your AdWords ads. Optimizations might consist of adjusting: 

Your campaign components Your ad group components Your website

Organizing your campaigns■
Modifying language and location 
targeting

■

Editing ad delivery times and 
position

■

 
 

Editing your keywords■
Editing your ad text■
Organizing your ad 
groups

■

Changing your bids■
Using keyword matching 
options

■

Choosing landing pages■
Editing website for flow and 
relevancy

■

 
 
 

Beginning an Optimization

Now that you know the basics about optimizing, where do you get started? How do you know what needs optimizing? 
Begin by taking inventory of all things that make up your online advertising campaign. Review the following, and take notes 
of what is and isn't working well:

Your website and landing page quality: Look at your website from a user's perspective. Does the design flow 
well? Is it well organized? Is the information useful, honest, and clear? You want your website to be easy to 
navigate and to communicate your business clearly.

■

 
Your account: Review the performance of individual keywords and ads across different campaigns in your account. 
Check stats such as your keyword clickthrough rate (CTR), costs, and ad position. If your CTR is low or if your costs 
are high, optimizations are in order. To learn different ways to check your account performance, visit the Quality and 
Performance Basics lesson. 

■

 
Competitors' sites: Browse your competitors' ads and websites to help you understand the similarities and 
differences in your products or services. You can also identify factors that make your business more compelling 
than the competition (such as special promotions or unique products), which you can then highlight in your ads.

■

After reviewing the above, the optimization process begins. Continue to the next lessons to find out how to improve landing 
page quality and account performance. 

Why Optimize?

Very simply, optimization makes your advertising more effective. In AdWords terms, this means a higher Quality Score, or 
higher ad quality. Since quality is directly tied to your ad's performance, position, and costs, optimizations can bring you 
greater advertising success and lower your costs. Every advertiser can benefit from regular optimizations.

In most cases, using a combination of many optimization techniques together — such as improving your landing page and 
editing your keywords — is the best bet to improve the overall performance of your account and to increase your Quality 
Score. 

Choosing Landing Pages 

Choosing Landing Pages

Objective: Learn how to optimize your website and landing pages, and how to choose effective landing pages for your ads.

About Landing Pages

The landing page is what your site visitor sees first after clicking your ad. Therefore, it's imperative that your landing page 
works in conjunction with your ad text. If your ad describes a specific product, the landing page should display that product. 
If your ad describes a general category, that category should appear on the page. In short, your landing page should 
deliver on your ad's promise. 

AdWords Help
Optimizing OverviewOptimizing Your Website
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When optimizing your website and landing page, strive to: (1) Make the content useful, relevant, and trustworthy and (2) 
Make the site easy to navigate. 

Making Landing Pages Easy to Navigate

Landing pages should offer clear, simple navigation, allowing your site visitors to find product overviews and details easily. 
Remember, confusing landing pages will discourage your site visitors from taking the actions — such as making a 
purchase — you desire. 

Here are some tips to follow: 

Provide an easy path for users to purchase or receive the product or offer in your ad. ■
Avoid the misuse of links or browser controls, such as pop-ups, poor back-button functionality, and other obtrusive 
elements throughout your site. 

■

Make sure your page loads quickly — under four seconds if possible. Slow load times deter visitors from staying. ■
To see a more complete list on how to improve your landing page quality, visit the Google AdWords Landing Page and Site 
Quality Guidelines. 

In addition, you can take advantage of the Website Optimizer tool by testing different versions of your content. To learn 
more, visit the Website Optimizer section in the Help Center. 

Making Landing Pages Useful and Relevant

If users don't quickly see what they clicked on your ad to find, they'll leave your site frustrated and may never return to your 
site or click on ads in the future. Here are some quick pointers to ensure that doesn't happen: 

Link to the page on your site that provides the most useful and accurate information about the product or service in 
your ad. 

■

Try to provide information without requiring users to register. ■
Create unique content that relates to your service or product and that can't be found on other sites.■
Clearly define what your business is or does. ■
Deliver products, goods, and services as promised on your site.■
Treat user's personal information responsibly. Be honest and clear about why and how you might be collecting a 
person's information.

■

Landing Page Quality Example

Let's say you sell printers from all major manufacturers, including the fictitious Acme printers. When a user searches for 
the keyword Acme printers, your ad appears as follows:

Acme Printers 
Find hundreds of all-in-one, 
home Acme printers. Buy today.  
fictitious-website-address.com

What would be a good landing page for this ad? Let's explore the following options: 

Option 1: Displays a list of all printer manufacturers. Since your site visitor entered the search query for Acme 
printers, this person is likely interested in Acme printers only. A page that includes all printer manufacturers isn't the 
most relevant to your visitor's interests.

1.

 
Option 2: Displays the Acme 710c Printer. The user's query was for all Acme printers, not just specific models. 
Therefore, this page may be too specific for your visitor's query. At a minimum, you should offer clear navigation 
from this page to the rest of the site and to similar products within the Acme line.

2.

 
Option 3: Displays Several Different Acme Printers: This page delivers content that is neither too broad (all 
printer manufacturers) nor too specific (a single printer model). It's the most relevant to your visitor's query, and is 
therefore ideal. 

3.

Account Optimization 

Account Optimization

Objective: Learn how to optimize your account for optimal performance — from structuring your account to editing 
keywords and ad text. To review the basics about organizing your account, choosing keywords, and writing targeted ad 
text, visit the Starting Off Right lesson. 

Optimizing Ad Text

The content of your ads should capture a user's attention and set your business apart. Strive for the following:

Include keywords in your ad text. Include your keywords in your ad text (especially the title) to show users that 
your ad relates to their search. 

■

 
Create simple, enticing ads. What makes your product or service stand out from your competitors? Highlight 
these key differentiating points in your ad. Be sure to describe any unique features or promotions you offer. 

■

 
Use a strong call-to-action. Your ad should convey a call-to-action (such as buy, sell, or sign up) along with the 
benefits of your product or service. A call-to-action encourages users to click on your ad and action they should take 
when reaching your landing page. 

■

 

Optimizing Your Account
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Choose an appropriate destination URL. Relate your ad to offers that you make on your landing page to help 
users complete the sales cycle.

■

 
Test multiple ads in each ad group. Experiment with different offers and call-to-action phrases to see what's most 
effective for your advertising goals. If your ad serving options are set to optimize (the default setting), Google 
automatically shows the best performing ad more often. 

■

 
Try different ad formats. Google offers both text and rich ad formats, such as image ads. Incorporate different ad 
formats into your ad groups to entice a user to visit your website. To learn more, visit the Ad Formats lesson. 

■

Optimizing Keywords and Placements

Your keywords and placements should relate to your ad text. Here are some optimization strategies for keyword and 
placement targeting:

Keyword targeting 

Choose specific keywords that relate to your business, ad group, and landing page. Two- or three-word 
keywords usually work best. For optimal ad visibility, include relevant keyword variations, along with singular and 
plural versions. If applicable, consider using colloquial terms, alternate spellings, synonyms, and product or serial 
numbers. The Keyword Tool can help generate lists of possible keywords. 

■

 
Take advantage of keyword matching options. With some keywords, you'll get more ad impressions; with others, 
you'll get fewer impressions but potentially more clicks. To learn more, visit the Keyword Targeting lesson. 

■

 
Use unique keyword URLs. Keyword destination URLs send users to a specific landing page, ensuring your 
customer arrives immediately at the most relevant page for the keyword that triggered your ad. Edit individual 
keyword URLs by clicking 'Edit Keyword Settings' above your keyword table. 

■

 
Try Google Sitemaps: If you're a webmaster or have access to your webpage code, you can use Google Sitemaps 
as a tool to generate more relevant keywords for your AdWords campaign. Sitemaps enable you to automatically 
submit all your webpages to Google and receive detailed reports on those pages' top Google search queries. You 
can then use the reported top search queries as keywords for your AdWords account. 
 
For more information, visit Google Sitemaps.

■

Placement targeting 
Choose sites or related placements that are relevant to your business. The more relevant the sites you target, 
the better the chances that your ad will show. To create an effective list, we strongly suggest using all methods 
available in your account when choosing placements. To learn more, visit the placement targeting lesson. 
 
When using the Placement Tool to find and select websites and related placements, pay attention to the Ad 
Formats column in the list of available placements. If you run only certain kinds of formats — for instance, image 
ads only, or text and video ads only — make sure the placements you select accept your format.

■

 
If necessary, target site sections. If an entire website isn't relevant to your ads, you have the option to target only 
the relevant parts of the site. This option may be appropriate if the site covers a variety of topics, of which only 
some relate to your ads. For example, if you sell kitchen appliances, you might choose to advertise only on the food 
section of a news site rather than placing ads across the entire site. 

■

(Note that site sections are slightly different from publisher-defined placements. In a publisher-defined placement, 
the publisher decides what pages or portions of his site you may target. With a site section, you yourself use URLs 
to pick which parts of the site you want to advertise on.)

Using keywords + placements You can add keywords and placements to any AdWords online campaign. Keywords can 
help place your ads on both the search and content networks. Placements affect only the content network. 

When you choose both keywords and placements, you'll be targeting your content network ads twice: once by keywords 
and once by placements. Use the Networks and bidding section of your Edit Campaign Settings page to determine how 
your keywords and placements work together. 

Here's an example: Suppose in one ad group you target the keyword roses and the placement www.example.com. 

With the content network enabled and the setting 'Relevant pages across the entire network,' you can let the 
keyword roses display your ad across the content network, but raise your bid whenever roses triggers your ad on 
www.example.com. 

■

With the content network enabled and the setting 'Relevant pages only on the placements I target,' you can choose 
to have your ad appear only on content pages of www.example.com, and only when one of those pages matches 
roses.

■

Optimizing Account Organization

Maintaining organized campaigns and ad groups is important to the performance of your account. Organization helps you 
achieve your advertising goals, make edits quickly, and target your ads appropriately. 

When organizing your account, strive for the following:

Organize your campaigns by topic. Create separate campaigns for each of your product lines, resources, or 
brands. This helps you monitor your advertising more easily and make the necessary adjustments to improve your 
campaign performance. 

■

 
Target the right languages and locations. Target your audience appropriately by choosing languages and 
locations that relate to your business. If you target multiple countries, try splitting them into separate campaigns by 
country. To learn more, visit the Language and Location Targeting lesson.

■

 
Create highly specific ad groups. Just like with your campaigns, build your ad groups around a single product or 
service. Then, group your keywords and placements into related themes. By doing this, you can create ads that 
most accurately promote what you're selling. 

■

 
Avoid duplicate keywords across ad groups. Google shows only one ad per advertiser on a particular keyword, 
so there's no need to include duplicate keywords in different ad groups or campaigns. Identical keywords compete 
against each other, and the better-performing keyword triggers your ad.

■

Page 3 of 8خدمات تبليغات در گوگل www.BERTINA.us

خدمات تبليغات در گوگل www.BERTINA.us



Advanced Optimization Features 

Advanced Optimization Features

Objective: Learn about some advanced optimization features, available at the campaign level of your account. 

Optimizing with Ad Serving

If you have multiple ads in a single ad group, AdWords determines when to show your ads based on your ad serving 
settings. You can choose between two different ad serving options on your Edit Campaign Settings page, under the 
Advanced Options heading:

Optimize: This is the default setting for all your ads. Over time, our system determines which ad is performing 
better based on higher historic clickthrough rates (CTRs) and Quality Scores compared to other ads within the ad 
group. Based on this data, we'll show your higher performing ads more often. You can see which ad is being served 
more often by viewing the % Served column on your Ad Variations table.

1.

 
Rotate: This option will serve all the active ads in an ad group more evenly on a rotating basis, regardless of their 
performance. Your ads will enter the ad auction an approximately equal number of times, and our system will 
consider the ad's Quality Score when ranking the ad. 

2.

 
We recommend that you stick with the default optimize ad serving setting for best results.

Optimizing with Ad Scheduling

Ad scheduling lets you control the days and times your AdWords campaigns appear. If you want to run an ad campaign 
only on Tuesdays, or from 3:00 until 6:00 pm daily, you can do it with ad scheduling. 

Ads are scheduled on the campaign level, from the 'Edit Campaign Settings' page. Each campaign can have up to six 
scheduled segments per calendar day. Segments can be as short as 15 minutes or as long as an entire day of 24 hours. 

Two steps are needed to set up ad scheduling for an AdWords campaign. First you must enable ad scheduling for that 
campaign. Once ad scheduling is enabled, you choose the days and times when you want your ad to run. 

Here's how to enable ad scheduling: 

Sign in to your AdWords account.■
From the All Campaigns page, click the campaign you want to work with.■
Near the top of the page, click Edit Campaign Settings.■
On the next page, click Turn on ad scheduling.■

Ad scheduling is now enabled for this campaign. You'll also be taken to the Ad Scheduling page, where you can set your 
schedule. 

On the Ad Scheduling page you'll see the seven days of the week with 24 hourly blocks for each day. Green blocks 
indicate that your ad is scheduled to run during that hour. Gray blocks mean your ad will not run during that hour. Click 
Edit next to any day of the week you wish to edit, and use the pull-down menus to select your time periods. 

To make changes to many days at once, find the line marked Bulk edit and select all days. Then use the pull-down menu 
to edit the times your ad will run on all days. For instance, if you select 1:00 to 4:00 pm, your ad will run at that time on all 
seven days of the week. 

Ad scheduling also includes an advanced mode, with a bid multiplier feature that lets you raise or lower your bid during 
certain time periods. For example, if you find that this campaign gets the best results between 8:00 and 11:00 am, you can 
bid more for impressions or clicks during that period by entering a percentage higher or lower than 100%. For instance, if 
your default bid for a campaign is $1.00 CPC, and your bid multiplier entry for Tuesdays is 120%, then your CPC bid for 
Tuesdays only would be $1.00 * 1.2 = $1.20. By contrast, a bid multiplier entry of 50% ($1.00 * 0.50) would lead to a $0.50 
bid during that time period. The bid multiplier may be as little as 10% or as much as 1000% of your usual bid. 

The bid multiplier affects all ads in any campaign, including ads with separate search and content bids. When the time 
period for a given multiplier ends, your campaign will revert to your normal campaign bids. To enable advanced mode and 
use the bid multiplier, click the switch to advanced mode link near the top of the Ad Scheduling page. Then click 'Edit' 
next to any day as normal. You'll see an input box for the bid multiplier next to the usual pull-down menus. 

When you are satisfied with your ad schedule, click Save Changes. Your changes will take effect almost immediately. To 
adjust your schedule for this campaign in the future, return to the Edit Campaign Settings page as described above. Click 
Edit times and bids to visit the Ad Scheduling page. 

Once you enable Ad Scheduling, a small clock next to a campaign name on the All Campaigns page will indicate that ad 
scheduling is enabled for that campaign. 

Here are a few more things to know about Ad Scheduling: 

Ad scheduling, whether in regular or in advanced mode, will not raise or lower your budget. The AdWords system 
will still try to reach your usual daily budget in whatever number of hours your ad runs each day.

■

Ad Scheduling does not guarantee your ads will receive impressions or clicks. The usual AdWords rules still apply, 
and your ads will compete for impressions with other ads as they normally do. If you schedule a campaign for very 
short periods of time, or only at times of great competition for the keywords or placements you have chosen, your 
ads may not get the chance to run very often.

■

Ad scheduling can be used on campaigns that use keyword targeting and placement targeting. ■
Ad scheduling will not work with the AdWords Budget Optimizer™. In order for the Budget Optimizer to best serve 
an account, it must have the freedom to show ads at all times.

■

Optimizing Ad Position: Position Preference 

Optimizing Ad Position: Position Preference

Objective: Understand how AdWords advertisers can set a position preference for their ads.
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Introduction to Position Preference

Position preference lets users tell Google where they would prefer their ad to show among all the AdWords ads on a given 
page. 

If an advertiser finds that her ad gets the best results when it is ranked (for example) third or fourth among all AdWords 
ads, she can set a position preference for those spots. AdWords will then try to show her ad whenever it is ranked third or 
fourth, and avoid showing it when it is ranked higher or lower. If the ad is ranked higher than third for a given keyword, the 
system will automatically try to lower the bid to place the ad in the preferred position. 

Position preference does not mean that an ad will always appear in the position specified. The usual AdWords ranking and 
relevance rules apply. If an ad doesn't qualify for position #1, setting a position preference of 1 will not move it there. 
Position preference simply means AdWords will try to show the ad whenever it is ranked in the preferred position, and to 
avoid showing it when it is not. 

Position preference also does not affect the overall placement of AdWords ad units on the left, right, top or bottom of a 
given page. It only affects ranking relative to other ads across those units. 

Position preferences are not guaranteed. An ad may still appear in other positions, though the AdWords system makes 
every effort to display ads according to preferences. When a user sets a new preference, it may take a few days for the 
AdWords system to begin delivering the ad according to those preferences. 

About Available Positions

The position preference feature uses pull-down menus for high and low position settings. 1 is the highest (top) position, 
and 10+ is the lowest available setting. Choosing a setting of 10+ means your ad will show in positions of 10, 11, 12 and 
beyond. 

Advertisers can request that their ad be shown only when it is: 

Higher than a given position (such as above 7). ■
Lower than a given position (such as below 4).■
Within a range of positions (such as from 2-8).■
In a single exact position (such as position 2).■

Separate position preferences can be set for any or all of the keywords in a campaign. 

Setting Position Preference

Position preferences are set in two steps. First, position preferences must be enabled for a particular campaign. Then 
preferences can be set for individual keywords within that campaign. 

To enable position preferences for a campaign, follow these steps: 

Log in to your account at https://adwords.google.com.■
On the 'Campaign Summary' page, select any campaigns you want to enable for position preference.■
Click Edit Campaign Settings.■
Find the 'Advanced Options' section.■
Select the box to enable position preferences.■
Click Save Changes.■

To set position preferences for your keywords: 
Return to the 'Campaign Summary' page.■
Click the name of a campaign to edit.■
Click an ad group within that campaign.■
On the 'Ad Group Details' page, select the box next to any keywords for which you want to set position preferences.■
Click the Edit Keyword Settings button (located above the keyword list).■
On the 'Edit Keyword Settings' page, you'll see the feature in the far right column. ■
Use the pull-down menus to choose the range you want for each keyword, from 1 to 10+. The left-hand number is 
the highest position you'd like your ad to take. The right-hand number is the lowest position your ad will take. 
(Remember, these are only preferences, not guarantees.) 

■

Click Save Changes.■
Once you've set your preferences, you can view them from the main 'Ad Group Details' page by clicking the word Show 
next to each term in the Settings column. Your position preferences will remain in effect until you edit them or disable 
position preference for that campaign. 

Potential Impact of Position Preference

Setting a position preference can sharply reduce the number of impressions and clicks a keyword receives. Targeting just 
one or two positions means an ad will not show at times when it otherwise might have. We encourage advertisers to 
choose as broad a range of positions as they are comfortable with. 

There is no single "right" position for all ads. Many people want to be ranked #1, but some advertisers prefer the lower 
costs that come with lower positions. Others find that certain keywords get a better return on investment (ROI) when their 
ads run in a specific position. The more advertisers test different positions and results, the more likely they are to find the 
positions that best suit their needs. 

If an advertiser doesn't set a position preference, their ads will continue to run normally in all positions. If they enable 
position preference but don't set individual preferences, their ads will also run normally in all positions. 

Position Preference with Other Features

Does position preference work with the Budget Optimizer™? No. The Budget Optimizer sets and adjusts bids 
automatically based on overall budget, and so cannot work effectively when the advertiser also sets position preferences 
manually. 

Does position preference work with content bids? Yes and no. Advertisers may run both features in the same 
campaign at the same time. However, since position preference doesn't apply to Google's network of content sites, any 
preferences set will not affect the content bids. 

Will the keyword tool suggest position preferences? No. The keyword tool is not affected by position preferences and 
does not suggest preferences. 
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Does the Report Center show my position preferences? Yes. Your reports now show your position preference, as well 
as the average position your ad actually received. (If you changed your position preferences many times in a given 
reporting period, the average position may not be very meaningful.) Keywords without position preferences are marked 
"any." 

Does position preference work with ad campaigns and ad groups that have placements? Yes and no. Placements 
don't affect ads running on the search network. If the campaign has targeted the search network and an ad group contains 
keywords, the position preference can apply to search network results. If a campaign targets the content network only, or 
placements only, then position preference won't apply. 

Does position preference work with preferred CPC bidding? No. If you select preferred CPC bidding, the AdWords 
system automatically adjusts your ad position as it works to hit your preferred CPC bid. This position adjustment is 
incompatible with the position preference feature. 

Increasing Traffic and Clicks 

Increasing Traffic and Clicks

Objective: Learn how to optimize campaigns to increase traffic by creating unique keyword variations and taking different 
steps to increase clicks on your ads.

Increasing Site Traffic

Please note that the industry typically defines 'site traffic' as page views where webmasters can sell ad space. However, 
the AdWords definition of increasing traffic means increasing clicks on an advertiser's ad(s).

The main methods of increasing traffic include:

Adding new or unused keywords■
Creating keywords for unadvertised parts of the advertiser's website ■
Including more general keywords■
Separating high-traffic keywords■
Increasing daily budgets■
Increasing Maximum CPC or Quality Score■
Setting your distribution preferences to maximize traffic■
Broadening your location targeting settings■

We'll expound on some of these methods below. 

Optimizing by Adding Keywords

Let's consider the example of an advertiser selling a product line for 'Acme Printers' who wants to increase traffic. 

In addition to using the keyword 'Acme printers,' you may consider adding variations such as 'Acme Printer,' 'Acme jet.' 
Make sure you only add unique variations of your keywords that may not be already covered by expanded broad matches. 
Always include plurals as well. Although plurals are generally included in broad match, you should still include them to 
ensure your ads show for as many relevant queries as possible. Keep in mind that plurals can perform differently in some 
cases, so you may want to set different maximum CPCs for them. 

Browse your site to identify major product categories. You can create ad groups that target specific product types or 
models. Advertising new products that aren't already featured within your account is an effective way of increasing traffic. 
In this example, you can create an ad group to promote your Acme printer supplies and generate more traffic from current 
Acme printer owners. 

Optimizing with General Keywords

You can also increase traffic by creating ad groups for more general keywords. Continuing with the 'Acme Printer' example 
used throughout this lesson, you could use 'printers,' 'color printers,' 'inkjet,' etc. Words like this will generate a lot of 
impressions and, if they're relevant, clicks. Just remember to find the most general terms that are still relevant to your 
product or service. If they're irrelevant, they can generate poor quality leads to your website. Also, general searches are 
generally performed by users who are early in the research stage of the purchasing cycle. It's important to have a 
presence at this stage; however, you may want to start with low CPCs to allow for clicks that may not immediately result in 
a conversion. 

Optimizing by Separating High-Traffic Keywords

An important aspect of optimization is generating specific ads to go with new keywords you create. Consider the keyword 
variations 'Acme color printers,' 'Acme inkjet printers,' and 'Acme laser printers.' These keywords are more specific than 
'Acme printers,' and would benefit from their own ad text tailored around the keyword. You may want to separate these 
keywords into their own ad groups.

Moving a high-traffic keyword into its own ad group and placing that keyword in the ad title will likely increase the number 
of clicks from the same number of impressions, which will also improve its CTR. 

Optimizing by Increasing Daily Budget or CPC

If you'd like certain keywords to receive maximum traffic, make sure they're in campaigns whose daily spend isn't reaching 
or exceeding its daily budget consistently. To increase traffic on all keywords in a campaign, increase the daily budget for 
that campaign. To increase traffic for specific keywords only, move them into a separate campaign, then set the daily 
budget high enough to yield the highest number of clicks. 

Specific Optimization Strategies
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Increase your maximum CPC or optimize your ad, keyword, or campaign to improve your Quality Score and to earn a 
higher rank. Because ads with higher ranks receive more clicks, you'll gain an increase in traffic. 

Optimizing with Location Targeting and Ad Distribution

You can broaden your location targeting settings or ad distribution preferences to maximize traffic.

Make sure that your location targeting settings reflect the areas of the world where you do business. Target your ad 
internationally if your offer applies to other countries. Even if your site isn't tailored to foreign countries and languages, you 
can still target your campaign to groups of users. For example, setting your language targeting to 'English' would ensure 
that your ad is shown to any user whose browser language is set to English anywhere in the world. 

The Google Network of search and content partners offers a great opportunity to gain additional traffic. You may wish to 
edit your campaign settings so your ads are eligible to appear on this network. 

Increasing Conversions 

Increasing Conversions

Objective: Learn how to optimize campaigns to increase conversions. (Advertisers define 'conversions' differently; 
however, for this topic, we'll assume a conversion is a product sale.) 

About the Buying Cycle

Before you optimize for conversions, you should first understand the buying cycle. Consumers go through the following 
stages when buying a product:

Awareness■
Interest■
Consideration■
Purchase■
Retention■
Advocacy■

Let's consider a scenario of a consumer buying an MP3 player. You should be prepared with keywords to address each 
part of this buying cycle. For example, at the consideration/purchase stages, you should include keywords such as 'buy an 
MP3 player.' Or, at the retention and advocacy stages, you should include keywords such as 'MP3 player accessories' or 
'MP3 player headphones' to target loyal owners of the product.

Using Negative Keywords to Increase Conversions

Using negative keywords can help filter out users who aren't actually in the purchase stage. Here are some sample 
negative keywords to consider:

Adding '-free,' as a negative keyword is important if you don't offer a free product or trial. A user searching for a free 
product is less likely to make a purchase.

■

Adding '-information' or '-info' will filter out users who are early in the buying cycle and generally not looking to 
purchase. 

■

Adding '-how to,' '-what is,' and '-definition' will also filter users who are still just interested in researching the 
product, not making a purchase. 

■

Adding these kinds of negative keywords will help qualify users as potential buyers. If you feel these negative keywords 
don't apply to your website, you may simply include them in their own ad group so you can track their performance 
separately. For example, when selling MP3 players, you can add the broad-match keyword 'how to use an MP3 player' in 
its own ad group in order to test the performance of the keyword.

Using Specific Keywords to Increase Conversions

More specific keywords tend to convert at a higher rate than general keywords. For example, consider the following 
keywords: 'Acme,' 'Acme printers,' 'Acme 710,' and 'Acme 710c.' Usually a more specific keyword like 'Acme 710c' will 
convert at a higher rate than 'Acme.' Users searching for brand names, product IDs, or even SKU numbers have typically 
already researched their product and want to make a purchase. 

Some relevant keywords may not convert well. Consider the keyword 'Acme laser printers.' Let's also assume your website 
doesn't sell laser printers. You could argue this keyword is still relevant. Someone searching for a laser printer may be 
willing to purchase another high-quality printer. However, because it's not exactly the product the user is searching for, he 
or she is probably less likely to buy it. You should review your reports to gather data on keywords like this. If you're just 
starting your ad campaign and want to focus on conversions, you may wish to hold off on these types of keywords until 
your other, more-accurate keywords are performing well. 

These keywords also present a challenging situation for writing ad text. You shouldn't use 'Acme Laser Printers' as your ad 
title because your website doesn't actually offer those products. This is a disadvantage, since competitors will be able to 
use the keyword phrase in the title and have stronger CTRs as a result.

Including Prices in Ad Text

You should experiment with including prices in your ad text. If a user sees the price of a product and still clicks the ad, you 
know they're interested in a potential purchase at that price. If they don't like the price, they won't click your ad, and you 
save yourself the cost of that click. However, if you omit the price and the user goes to your website before deciding it's too 
expensive, you pay for their visit. 
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We also recommend that you review competitors' ads to watch for the prices they offer. If your price is lower, you should 
highlight this fact.

Adjusting Keyword Bids to Maximize ROI 

Adjusting Keyword Bids to Maximize ROI

Objective: See how your maximum cost-per-click (CPC) or maximum cost-per-thousand impressions (CPM) can affect 
your return on investment (ROI). Learn how to identify related factors and adjust bids to increase your ROI.

Factors to Consider

The following two factors influence your keyword performance:

How long the keyword has run: If your keyword has only been active for a short period of time, or has only 
accrued a small number of impressions, clicks, or conversions, you generally won't have enough information to 
decide if this keyword is performing well for you.

■

Keyword position: Keywords may perform differently based on their ad's position on the page. ■

Before you delete any keywords for not performing well, you may wish to consider these factors. You may also wish to edit 
your bids to experiment with different positions on the page. 

Determining Your ROI

The bottom line for any keyword is how much value it generates compared to its cost. To determine the profitability of a keyword, you can track the conversions 
from that keyword with Google's free conversion tracking tool or another third-party system. For more information, see our Conversion Tracking lesson.

Once you understand the value of each keyword, you can increase that keyword's profitability by adjusting your CPC or CPM bid. For keywords that show a profit, 
increase the bid to increase exposure and generate more traffic. For keywords that aren't profitable, decrease the bid to lower your costs. Remember that 
decreasing your CPC or CPM bids could have a drastic impact on the volume of clicks and conversions for that keyword. In some cases, if a term is driving a large 
volume of conversions, you may decide to hold that term to a lower ROI threshold so as not to sacrifice volume. In some cases it may make sense to lower the bid 
for a keyword, even if the keyword is profitable. By lowering the bid, you will lower the average amount paid, which may increase the profit margin for that keyword. 

Use your Placement Performance Report to find placements where your ads are earning the most clicks. If you find that your ad converts particularly well on a 
given website, try adding that website to your ad group as a placement, with a higher placement bid to help your ad appear on that site more often. 

It's best to adjust your bids in small increments, and then allow the keywords to accrue impressions, clicks and conversions with the new settings. Allow at least 24 
hours between changes so you'll have enough performance data to make an informed evaluation. In addition, because the market is always changing, you'll want to 
re-evaluate your bids regularly. 

Adjusting CPCs Above the Minimum Bid

If a keyword isn't performing well and becomes inactive for search, you can increase your CPC bid to improve its performance. (CPM bidding isn't available for ads 
targeted to the search network.) If your keyword is inactive for search, we'll list the minimum bid in the keyword status column in your Ad Group Details page. If your 
keyword is active and underperforming, you can find your minimum bid by: 

Creating a Custom Report for minimum bids through your Reports tab. •
Editing your keywords' CPCs or URLs in your ad group Details page. (Select the keyword or keywords you'd like to view, and click the Edit Keyword 
Settings button.) 

•

AdWords - Contacting Us - Help with other Google products - Change Language: English (US)  

©2010 Google - Google Home - Privacy Policy - Terms of Service - Advertising Policies 
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Keyword Tool 

Keyword Tool

Objective: Need more keywords? Learn to use this tool to: 

find and add new keywords to your ad groups ■
refine your keyword list ■
find negative keywords, and ■
see additional keywords that can also trigger your ads (expanded 
matches). 

■

About the Keyword Tool

The Keyword Tool has many uses. It can help you find new or negative 
keywords, improve your keyword list, estimate keyword traffic, and see 
additional search terms that may trigger your ads. After you've finished 
selecting your keywords, you can add them directly to an ad group or 
download them in a .csv (spreadsheet) file. 

Before you begin ... 

Before you select your keywords, carefully review the variations returned 
by the Keyword Tool. Ask yourself if someone searching on these 
keywords would be looking for your product or service.

If you aren't offering what some of the returned keywords describe, these 
keywords would be less relevant to your business. You can manually add 
them directly to your list as negative keywords. For example, if you only 
sell new books, you can add '-' to the keyword used, since you don't sell 
used books. Your negative keyword would be -used within an ad group 
featuring books.

Adding negative keywords can help reduce untargeted impressions for 
your ad and preserve your account's clickthrough rate (CTR). CTR is 
important because it's part of the Quality Score formula that helps 
determine your ad's position on the page.

Using the Keyword Tool

Access the Keyword Tool from within your ad group to get results based 
on your existing campaign settings and your account's performance 
history:

Sign in to your AdWords account at https://adwords.google.com. 1.
Select the appropriate campaign and ad group. 2.
Select the Keywords tab. 3.
Click Keyword tool. 4.
In field labeled How would you like to generate keyword ideas?, 
use the options labeled Descriptive words or phrases, Website 
content, or Existing keyword to create a keyword list. You can 

5.

AdWords Help
Account Performance Tools
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switch between options without losing your work. Detailed 
instructions for using each option are below. 
Show or hide columns in the statistics table for each group with the 
Choose columns to display drop-down menu. 

6.

If you show the Estimated Ad Position or Estimated Avg. CPC 
columns, a field labeled Calculate estimates using a different 
maximum CPC bid will appear. If you leave the field blank, the 
estimates in these two columns will be based on the maximum cost-
per-click (CPC) bid that would likely put your ads in the first, 
second, or third position on a Google search result page. To see 
how the estimates change, enter a different maximum CPC and 
click Recalculate. 

7.

Use the drop-down menu in the Match Type column if you'd like to 
change the match type for all your keyword results. The keywords 
are a broad match by default. 

8.

Click Add next to a particular keyword to move it to the keyword list 
in the shaded box. Use the drop-down menu next to Add if you'd 
like to change a keyword's match type first. Keywords already in 
your ad group will be marked, and you won't be able to move them. 

9.

Click Add your own keywords to expand a field and add any more 
keywords that you think of. Click Add to List when you're done. 

10.

Click Get more related keywords to generate additional keyword 
ideas based on the keywords you selected for your ad group. This 
feature is a useful way to refine your original Keyword Tool results.

11.

Download keywords by clicking text, .csv (for excel), or .csv. You'll 
need a spreadsheet program to open a .csv file. 

12.

Click Save to a different ad group if you'd like to save your 
keywords to a different ad group than the one from which you 
accessed the tool. Choose your preferred campaign and ad group 
from the drop-down menus. 

13.

Click Estimate Search Traffic to see traffic estimates for the 
keyword list you've built.

14.

Click delete next to any keywords you no longer want. ■
Click Save Changes at the bottom of the page when you're 
happy with your keyword list. 

■

Your new keywords will be lost if you click Cancel. We 
recommend that you not click Estimate Search Traffic until 
you've finished building your keyword list.

■

If you didn't go to the Estimate Search Traffic page, save your 
keywords by clicking Save to Ad Group in the shaded box.

15.

'Descriptive words or phrases' option

Choose this option to generate keyword ideas from terms that describe your product or service. 
This option will be selected for you by default.

In the field provided, enter terms describing your product or service. Make sure that you 
enter only one word or phrase per line. For example, if you sell pies, you might enter the 
terms:

1.

home-made pies 
apple pies 
peach pies

Leave Use synonyms checked to get the widest range of keyword results. If you uncheck 
the box, the Keyword Tool will only give results that contain at least one of the terms you 
entered. 

2.

Click Filter my results to restrict the keyword ideas that the tool generates. 3.
Click Get Keyword Ideas. The results will be organized in order of relevance to the terms 
you entered. 

4.

Follow steps 6 - 15 at the top of the page.5.

'Website content' option (limited language release)

Choose this option to generate keyword ideas based on the content of any webpage.

Enter the full URL of a webpage in the field provided (example: 
http://www.google.com/index.html). In most cases, we would recommend entering your ad 
group's destination URL. 

1.

Check Include other pages on my site linked from this URL if you'd like the Keyword 
Tool to evaluate other webpages with the same domain that are one link away from the 

2.
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URL. For instance, www.mysite.com/apples has the same domain as 
www.mysite.com/oranges. 
Click Or, enter your own text in the box below (optional) if you'd like to enter your own 
text rather than use a URL. A field will expand in which you can input text relevant to your 
product or service. For instance, you could enter seasonal marketing or advertising print 
copy that may not be available on your website for the entire year. 

3.

Click Filter my results to restrict the keyword ideas that the tool generates. 4.
Click Get Keyword Ideas. The results will be organized into groups of related terms. The 
group most relevant to the webpage you entered will appear first. 

5.

Follow steps 6 - 15 at the top of the page.6.

'Existing keyword' option

Choose this option to generate keyword ideas based on one of your existing keywords that has 
earned a high clickthrough rate (CTR).

Click Filter my results to restrict the keyword ideas that the tool generates. 1.
Click one of the keywords listed in the shaded area to get keyword ideas. The results will 
be organized in order of relevance to the keyword you selected. 

2.

Follow steps 6 - 15 at the top of the page.3.

Reviewing Your Keyword Results

The keyword results returned from your search will be listed in a table. You can view your keywords along with 
various statistics and sort by the columns provided. Use these features to help you decide which keywords will be 
the most cost-effective and relevant for your business or service.

I. Keyword Match Type

The tool automatically produces results based on the broad match variation of the keyword(s) entered. All views 
include a Match type column. You can change the match type shown and add other keyword matching variations 
directly to an ad group. However, changing the match type via this column won't actually change the broad match 
statistics shown, and is intended only to assist you in managing your keyword list.

II. Keyword Tool Views

Show or hide columns in your Keyword Tool results with the Choose columns to display drop-down menu. Each 
column shows estimated performance statistics about the keyword results to help you pick the best ones to add to 
your ad group. Available statistics are:

Estimated Ad Position: Your ads' estimated position on Google for these keywords •
Estimated Avg. CPC: Your ads' estimated average cost-per-click (CPC) on Google for these keywords •
Advertiser Competition: The number of advertisers worldwide bidding on each keyword relative to all 
keywords across Google 

•

Previous Month's Search Volume: The relative number of users who searched for these keywords on Google •
Avg. Search Volume: The average monthly search volume on Google for each keyword over a recent 12-
month period 

•

Search Volume Trends: Fluctuations in Google search volume for each keyword over a recent twelve-month 
period 

•

Highest Volume Occurred In: The month that each keyword received the highest Google search volume 
within a recent 12-month period

•

Site and Category Exclusion Tool 

Site and Category Exclusion Tool

Objective: Learn how to prevent your ads from appearing on certain websites and groups of webpages 
in the Google content network.

About the Site and Category Exclusion Tool

There may be times when--for any reason--you feel that certain websites in the Google Network aren't a 
good match for your ad campaign. When that's the case, the Site and Category Exclusion Tool can 
prevent your ads from appearing on those sites as well as groups of sites related to specific categories. 

Page 3 of 18خدمات تبليغات در گوگل www.BERTINA.us

خدمات تبليغات در گوگل www.BERTINA.us



The process is relatively simple: you name the sites where you don't want your ad to appear, and 
Google blocks your ads from appearing on those pages.

Using the Site and Category Exclusion Tool

To access and use the Site and Category Exclusion Tool:

Sign in to your AdWords account at https://adwords.google.com. 1.
Click the Tools link on your Campaign Management tab. 2.
Click Site and Category Exclusion. 3.
Select a campaign from the drop-down menu. 4.
Select the Sites tab and enter sites within the content network from which you'd like to exclude 
your ads. 

5.

Select the Topics and Page Types tabs and select the categories you'd like to exclude. 6.
Click Save all exclusions.7.

Exclusions are applied at the campaign level: you can exclude individual campaigns from a site, but not 
individual ad groups or an entire account at once.

Campaign Optimizer 

Campaign Optimizer

Objective: Learn how to use the Campaign Optimizer to get a customized proposal for improving your 
campaign's performance. 

About Campaign Optimizer

The Campaign Optimizer uses Google's advanced technology and experience with AdWords ads to your 
advantage. The tool automatically analyzes your campaign (including your budget, keywords, ad text, 
and landing page) and generates a proposal to improve your campaign's performance. You can then 
review the proposed changes and accept the ones you want to apply.  
 
Here's more detail about how we analyze your campaign: 

Budget analysis. We assess your campaign history to determine whether you've missed ad 
impressions due to a low budget. If we find this is the case, you'll see a summary of the clicks and 
impressions you could be getting, along with a budget proposal. 

◦

Keywords. We automatically analyze your landing page and the current performance of your 
keywords to determine what is or isn't working well for your campaign. For each ad group, we use 
this information to propose changes to your keyword list. Changes may include: 

◦

Adding new keywords ■
Deleting poor performers ■
Changing keyword matching options (broad, phrase, or exact) ■
Adjusting cost-per-click (CPC) bids ■

Ad text. The Campaign Optimizer automatically reviews your ad text and may propose small 
changes in capitalization or punctuation. These changes are based on optimization tips we've 
found to be successful 

◦

We're aware that you know your business best. In order to ensure the success of your campaign, please 
review the Campaign Optimizer's automated proposals carefully. Some of the proposed changes may 
not suit your advertising goals, so only accept those changes that you like. 

Using Campaign Optimizer

Follow these steps to use the Campaign Optimizer: 

Sign in to your AdWords account at https://adwords.google.com. 1.
Click on the name of the campaign you want to optimize. 2.
Click Optimize Campaign above your ad group table. 3.
Click Get Started after reviewing the introductory page. 4.
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Review the campaign-level proposal (if present) and choose the action you wish to take. 5.
Click Save and Continue to view a list of your ad group proposals. 6.
Click Review to see detailed proposals for an ad group. 7.
Follow the instructions in the Campaign Optimizer to review the remainder of the ad group 
proposal. 

8.

Click Apply Changes and Continue when you're finished with the ad group. 9.
Repeat steps 7-9 for any remaining ad groups. 10.

A few additional tips for reviewing your proposal: 
Don't navigate away from the proposal until you're finished with it. If you exit the proposal before 
applying your changes, your proposal will be lost. 

◦

Review your proposal carefully. The proposal is automated, so some changes may not be 
relevant for your campaign. 

◦

Check the Approve box next to the changes you like. Only changes that you approve will be 
applied to your campaign. 

◦

You can also access the Campaign Optimizer from the Tools page on the Campaign 
Management tab. Click Campaign Optimizer, then select the campaign you want to optimize. 

◦

Edit Campaign Negative Keywords 

Edit Campaign Negative Keywords Tool

Objective: Learn how to add campaign negative keywords to your account. 

Using the Edit Campaign Negative Keywords Tool

About the Tool 

Negative keywords prevent your ads from appearing whenever a user includes a certain term in his or 
her search query. The Edit Campaign Negative Keywords tool lets you add those negative keywords to 
any campaign. For example, if you're advertising your bookstore, but you don't sell textbooks, you might 
want to add the negative keyword "-textbooks" to your campaign. This will stop your ad from appearing 
alongside searches like "textbooks" or "used school textbooks." 

Using the Tool 

To access and use the Edit Campaign Negative Keywords tool: 

Log in to your AdWords account at adwords.google.com 1.
Click the Tools link on your Campaign Management tab. 2.
Click Edit Campaign Negative Keywords. 3.
Select the campaign you'd like to edit from the drop-down menu, and click Go. 4.
Enter your negative keywords in the 'Enter words manually...' field, and click Add Keywords. 5.

If your negative keywords appear in more than one ad group, use Clean Sweep to 
remove them from the ad group level and add them at the campaign level. Use the drop-
down menu in step one to select the location of the negative keywords, and click 'Run 
Clean Sweep.' 

■

If you need help identifying appropriate negative keywords, visit the Keyword Tool. This tool displays 
lists of keywords that may trigger your ad. If any of the keywords suggested by the Keyword Tool don't 
relate directly to your ad group, adding them as negative keywords will help you better reach your target 
audience. 

The Traffic Estimator 

The Traffic Estimator

Objective: Thinking about adding a new keyword to your account? With the Traffic Estimator, you can 
see how your keyword might perform. Learn what this tool does and how to use it. 
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About the Traffic Estimator

The Traffic Estimator provides traffic and cost estimates for new keywords before you add them to your 
campaign. You can also review estimates for current keywords already running in an ad group. 

When you enter a keyword into the Traffic Estimator, you get estimates for your keyword's status, 
search volume, average cost-per-click (CPC), cost/day, and average position. By using this tool, you can 
better forecast your ad's placement and performance based on your CPC bid, targeting options, and 
other criteria.

Using the Traffic Estimator

You can access the Traffic Estimator from within your AdWords account -- either when you're creating or 
reviewing a keyword for a particular ad group, or from the Tools page on your Campaign Management 
tab. The estimates you receive are based in part on the values you enter (or on your current ad group 
and campaign settings), including your CPC bid and targeting options. If you're flexible on your costs 
and targeting, it's a good idea to play around with these fields to see different results. 

To use the Traffic Estimator when creating a keyword in your account: 

Log in to your AdWords account at adwords.google.com. 1.
Click the campaign containing the ad group for the keywords you want to add or review. 2.
Click the appropriate ad group. 3.
Select the Keywords tab.4.
Click Edit Keywords at the top of the table. 5.
In the field provided, enter your keywords so that each word/phrase appears on its own line. 6.
Click Estimate Traffic. You will see all of the estimates for each of your keywords entered. If 
necessary, you can adjust your CPC bid and recalculate your estimates. 

7.

Click Save Changes to keep the new settings or Cancel to delete them (your original settings will 
be applied). 

8.

When using the Traffic Estimator from within your account, at the bottom of the estimates page you have 
the ability to make changes to your keywords and CPC bids, and then re-estimate the traffic.

Note that when using the Traffic Estimator from within your account, you will see the predicted status of 
your keyword. Please see the lesson on monitoring performance for more information on the keyword 
status.

To access the standalone Traffic Estimator tool through the Tools page in your account:

Log in to your AdWords account at adwords.google.com.1.
Click the Tools link on the Campaign Management tab. 2.
Click Traffic Estimator. 3.
Enter keywords: In the field provided, enter your keywords so that each word/phrase appears on 
its own line. 

4.

Choose a currency: Select your currency, then enter a specific CPC bid for your estimates, or 
let us suggest a value. Our suggested value should deliver ads in the top position 85% of the 
time. If you feel you don't need your ad in the top position 85% of the time, you can reduce the 
CPC bid.

5.

Choose your target languages: Select which languages you'd like to target. 6.
Select Location Targeting (countries, regions and cities, customized) 7.
Choose one or more target countries: Select which country you'd like to target. 8.
Select if you want the estimates provided to be customized based on your account history.9.
Click Continue to see your estimates. 10.

The Traffic Estimator works for ads with keyword targeting only; it does not work for ads with placement 
targeting using either CPC or CPM bidding. 

Reviewing Your Traffic Estimates

When you use the Traffic Estimator, you'll see the following estimates for each keyword entered:

Search Volume: Indicates the amount of search traffic received by your keywords. This information can 
help you determine how competitive ad placement is for a particular keyword. The green bar shown 
represents a general low-to-high quantitative guideline. 
 
Estimated Avg. CPC: The average amount you'll pay for each click. The AdWords Discounter 
automatically adjusts your actual CPC so you pay only one cent more than the minimum amount 
required to keep your ad's position. Therefore, the displayed amount may be lower than your 'official' 
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CPC bid above.  
 
Estimated Ad Positions: The average position in which your ad may show. '1' is the highest position on 
the first page of search results. There is no 'bottom' position. Values may contain ranges because the 
Traffic Estimator displays estimates as averages based on dynamic keyword activity among advertisers. 
Also, average ad positions are not fixed; they may vary depending on bidding activity and your 
keyword's quality. 
 
Estimated Clicks/Day: The number of clicks your ad may receive each day. 
 
Estimated Cost/Day: The average amount you may spend per day. 

The values provided by the Traffic Estimator are only estimates, not guarantees. They will vary 
depending on conditions such as fluctuations in user behavior and dynamic search and pricing activity. 
The Traffic Estimator works for ads with keyword targeting only; it does not work for ads with placement 
targeting using either CPC or CPM bidding. 

For more information about cost control, overdelivery, and ad ranking, refer to the lesson on Pricing and 
Ranking.

My Change History Tool 

My Change History Tool

Objective: Learn how to use the My Change History tool to view changes you've made to your account 
since January 1, 2006. 

About the Change History Tool

The My Change History tool allows you to view all changes for a particular time period or to filter the 
results by the type of change (such as budget adjustments or keyword edits). If multiple users with 
different logins manage your account, you can also use the tool to see who made certain changes.  
 
Reported Changes  
 
This tool will report the following changes: 

Daily budget adjustments ◦
Keyword edits or additions ◦
Changes in ad distribution preferences ◦
Changes made via the AdWords API ◦

The tool won't display the following changes: 

Maximum cost-per-click (CPC) adjustments made by the Budget Optimizer(TM) ◦
Changes made by the Ad Automator ◦
Ad approval or disapproval ◦
Password changes (for security reasons) ◦

Using the Change History Tool

To access My Change History, follow the steps below: 

Log into your AdWords account. 1.
Click 'Tools' on the Campaign Management tab. 2.
Click My Change History under the Analyze Your Ad Performance section. 3.
Select the date range for which you'd like to see changes. 4.

Additional notes about the tool: 
You may see incomplete results if you request data for a time period that extends before January 
1, 2006, or if no changes were made to your account during the time period selected. 

◦

It can take a few minutes for your changes to appear in My Change History. If you don't see 
your most recent changes, please check again later. 

◦
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Ads Diagnostic Tool 

Ads Diagnostic Tool

Objective: Learn how to use the Ads Diagnostic Tool to troubleshoot your ads. 

About the Ads Diagnostic Tool

The Ads Diagnostic Tool:

Reports whether an ad is appearing on the first page of Google search results ■
Identifies why a particular ad or group of ads may not be showing■
Determines why a particular keyword may not be triggering ads to appear■
Provides recommendations for increasing ad rank or ad display■

This tool reports data for Google search results only and not for ads that show on the content 
network or other sites in the search network. 

With the Ads Diagnostic Tool, you can search for ads that might not be showing for a 
particular search term or on a specific webpage. 

Using the Ads Diagnostic Tool

You can access Ads Diagnostic Tool results in two ways.  
 
Ad Group Details page  
 
To get a quick summary of your keyword performance for a particular ad group, follow these 
steps: 

Sign in to your AdWords account at https://adwords.google.com. 1.
Click the campaign that contains the ad group you want to view. 2.
Click the appropriate ad group. 3.
Select the Keywords tab. 4.
Point your mouse at the magnifying glass icon next to any keyword in your ad group. 
A help bubble will appear with information about your keyword. If your ad isn't 
showing, click the link for more information. 

5.

Note that the quick summary gives a snapshot analysis of your ad performance based on the 
location and language targeting selections for the associated campaign. If your campaign 
targets multiple locations or languages, the Ads Diagnostic Tool selects just one language 
and location combination. For a comprehensive analysis, use the Tools page described 
below. 
 
Tools page  
 
For more in-depth information about your keywords, follow these steps: 

Sign in to your AdWords account at https://adwords.google.com. 1.
Click Tools beneath the Campaign Management tab. 2.
Click Ads Diagnostic Tool. 3.
Enter information for either Option 1 or Option 2: 4.

Option 1 (Search Terms and Parameters): Use this option if you're concerned 
about all ads within your account that should be appearing for a specific search 
term on Google. Specify the keyword query, the Google domain, the display 
language, safe search setting, and user location. 

■

Option 2 (Search Results Page URL): Use this option if you're concerned about 
a particular Google search results page that you believe should be showing 
one of your ads. Copy and paste the URL from the address bar on the search 
results page where your ad should be showing. 

■

Click Continue when you are finished. 5.

Troubleshooting Tools
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Ad Preview Page

The ad preview page is a companion to the Ads Diagnostic Tool. It lets you perform a test 
search to see how your ads and search results would appear on a regular Google search 
results page without accruing extra impressions. 

To perform a test search, follow these steps: 

Go to www.google.com/adpreview.1.
Enter your search term. Click Go or hit Enter on your keyboard. 2.
The search results and ads appear as they would on Google, except the links on the 
preview page aren't clickable. 

3.

You can also use the ad preview page to see if your ad is appearing in other geographical 
locations.

Disapproved Ads Tools 

Disapproved Ads Tool

Objective: Learn how to use the Disapproved Ads Tool to find useful information about any 
ads in your account that have been disapproved. 

About the Disapproved Ads Tool

The Disapproved Ads Tool shows all ads in your account that have been disapproved. You 
can view the disapproved ad, its location, the reason for disapproval, suggestions for 
improving your ad, and the date your ad was disapproved.  
 
Additional notes about the tool: 

Advertisers still receive emails regarding any disapproved ads, unless they opt out of 
email notifications. 

■

At this time, the tool doesn't reflect the status of approved or pending ads, or 
keywords for your account. 

■

Using the Disapproved Ads Tool

Access the Disapproved Ads tool by following the steps below: 

Log into your AdWords account at adwords.google.com 1.
Click 'Tools' on the Campaign Management tab. 2.
Click Disapproved Ads under the Analyze Your Ad Performance section. 3.

Tips for using the tool: 
Click Details in the Disapproval Reason column to learn more about why your ad was 
disapproved. 

■

If your ad belongs to a paused or deleted campaign or ad group, this status will be 
included in the Campaign or Ad Group columns. In this case, you won't be able to 
make edits. However, you can click View ad to review the ad text. 

■

To edit an ad, click the Edit ad link in the far right-hand column. You'll be able to edit 
your ad from its corresponding ad group; once you save your ad, it will automatically 
be submitted for review. 

■

To remove ads from this page (but not actually remove them from your account), use 
the Ignore function at the top of the table. You can also use the drop-down box to 
view your disapproved ads: Show all campaigns, Show only active campaigns, Show 
all but deleted campaigns. 

■

AdWords Editor
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Introduction to AdWords Editor 

Introduction to AdWords Editor

Objective: Learn basic information about AdWords Editor, including key features, how to 
install it, and how to start using it.

About AdWords Editor

AdWords Editor is a free, downloadable desktop application for managing your AdWords 
campaigns. If you have a large number of campaigns or keywords, or if you manage multiple 
accounts, AdWords Editor can save you time and help streamline your workflow.  
 
The application offers a wide array of features, but the basic process is simple: download 
your account, make your changes, then upload your revised campaigns when the changes 
are finalized. You'll learn more details about these steps in subsequent lessons. 

AdWords Editor Features

With AdWords Editor, you can: 
Work offline on your Mac or PC. ■
Upload changes to AdWords any time. ■
Store and navigate one or more accounts. ■
Add, edit, and delete campaigns, ad groups, ads, keywords, and placements. ■
Make large-scale changes quickly. ■
Perform advanced searches and edits. ■
Add comments for your changes. ■
Sort and view performance statistics. ■
Copy or move items between campaigns, ad groups, and accounts. ■
Export a snapshot of your account for archiving or sharing. ■
Import an archive or share file and review the proposed changes. ■

You'll learn more details about these and other features in subsequent lessons. 

Installing AdWords Editor

To download and install AdWords Editor, visit the AdWords Editor website. Select Windows 
or Mac, then click Download AdWords Editor. You'll need Windows 2000, Windows XP, 
Windows Vista, or Mac OS X (10.4 or later).  
 
The first time you run AdWords Editor, you'll be prompted automatically to download your 
account. To download additional accounts, go to the File menu > Open Account.  
 
You may only edit one account at a time. To switch accounts, go to the File menu > Open 
Account, select the account you want to view, and click Open Selected Account. 

Navigating AdWords Editor

You can navigate through your account in AdWords Editor via the tree view on the left side of 
the interface and the tabs on the right side. Your selections in the tree view and the tabs 
determine what information you can view and edit.  
 
Tree view: The tree view is a hierarchical view of your account on the left side of your screen. 
Click the plus and minus signs to expand and collapse the tree view and see the campaigns 
and ad groups in your account.  
 
Tabs: Once you've selected an account, campaign, or ad group in the tree view, you can use 
the tabs to select the kind of data you want to view or edit. Each tab shows a part of your 
account, such as keywords, ad groups, or campaigns. For example, to view the ad groups in 
Campaign #1, select Campaign #1 in the tree view and click the Ad Groups tab.  
 
Tab tool bars: Each tab has a tool bar with buttons for functions within the tab. For example, 
the Keywords tab has buttons for adding and deleting keywords, making multiple changes, 
and reverting changes. The adding and editing options are also available from the Data 
menu.  
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Data view and edit panel: The data view displays the details of the selected tab. When you 
select an item in the data view, you can edit it directly in the row or in the edit panel below the 
data view. 

AdWords Editor: Add, Edit and Delete 

AdWords Editor: Add, Edit, and Delete

Objective: Learn how to add, edit, and delete campaigns, ad groups, ads, keywords, and 
placements.

AdWords Editor: Add Individual Items

You can add an individual campaign, ad group, ad, keyword, or placement several ways. The 
two simplest ways are: 

Go to the Data menu and select the type of addition you want to make. For example, 
to add a keyword to Campaign #1, go to the Data menu > Add New Keyword. 

■

Click the Add button on the appropriate tab. For example, to add an ad group to 
Campaign #2, select Campaign #2 in the tree view. Next, go to the Ad Groups tab 
and click Add Ad Group. 

■

When you add a new item to your account, a plus sign (+) appears next to it. Learn more 
about AdWords Editor symbols in the View and Sort Information lesson.  
 
If you want to create a draft version of your additions, without posting them, you can create a 
draft campaign or a draft account.  
 
Draft campaigns aren't posted to your account until you change the status of the campaign to 
'Active.' To create a draft campaign, go to the Data menu > Campaigns > Add Draft CPC 
Campaign or Add Draft CPM Campaign. 

AdWords Editor: Cost and Budget Settings

You can make the following changes to your cost and budget settings in AdWords Editor: 
Change your campaign budget. ■
Change your ad group CPC or CPM bids. ■
Change the CPC or CPM bids for individual keywords or placements. ■
Change maximum CPA bids for ad groups in Conversion Optimizer campaigns. ■

Note: AdWords Editor currently doesn't support changes to account-level billing preferences. 
To make these changes, please sign in to your AdWords account at 
https://adwords.google.com. 

AdWords Editor: Add Multiple Items

The Add Multiple tools enable you to add large numbers of keywords, placements, ads, or 
ad groups at once. These tools are available from the Data menu or on the tab tool bars. 
Simply type or paste a list of items into the tool to add them to the locations you specify.  
 
For example, the Add Multiple Keywords tool enables you to add keywords to a single ad 
group, to all campaigns and ad groups, or only to the ad groups you specify. From within the 
tool, you can: 

Use the drop-down menus to select a specific campaign and ad group for your 
keyword additions. 

■

Select All Campaigns to add the same keywords to all ad groups in the account. ■
Include campaign and ad group names in your keyword list. This option allows you to 
add keywords to specific ad groups in any campaigns, or to create new ad groups and 
campaigns for your keywords. If you enter campaign and ad group names that don't 
exist yet, the tool will give you the option of creating them. 

■

Replace your existing keyword list with the new keywords by checking the box labeled 
'Replace the entire contents of destination ad groups with these keywords.' 

■

After you type or paste your keyword information, click Next to review your keywords, and 
Finish to apply the changes.  
 
The other Add Multiple tools work much the same way as the Add/Update Multiple 
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Keywords tool. You can find detailed instructions for each tool in the AdWords Editor Help 
Center. 

AdWords Editor: Edit Individual_Items

To locate and edit a campaign, ad group, ad, keyword, or placement, follow these steps: 
Select the appropriate context in the tree view. This could be your account name or a 
specific campaign or ad group containing the item you want to edit. 

1.

Click the relevant tab above the data view. 2.
Select the item you want to edit in the data view. 3.
Make your changes in the edit panel or directly in the data view. 4.

For example, here's how you'd edit a keyword destination URL in your 'Chocolate Ad Group' 
in Campaign #3: 

Select 'Chocolate Ad Group' in the tree view. 1.
Click the Keywords tab. 2.
Select the keyword you want to edit. 3.
Type your new destination URL in the edit panel or directly in the data view. 4.

Here are some examples of other individual edits: 
Edit campaign settings, such as budget, status (active, paused, deleted), network 
distribution settings, start and end dates, or language and location targeting. 

■

Change an ad group's name, status, or maximum CPC or CPM bid. ■
Edit the destination URL for a text or image ad. ■
Pause a keyword. ■
Edit a negative keyword or site. ■

You can revert any change in AdWords Editor that has not been posted. Select one or more 
items in the data view and click Revert Selected Changes. 

AdWords Editor: Edit Multiple Items

AdWords Editor gives you several options for editing multiple items at once. You can enter a 
list of changes in the Add/Update Multiple tools, or you can select items and edit them 
manually or with the advanced editing tools. (Advanced editing tools will be covered in the 
next lesson.)  
 
Add/Update Multiple tools  
 
The Add/Update Multiple Keywords, Placements, and Ad Groups tools enable you to 
edit, as well as add multiple items at once. When you enter a list of keywords, placements, or 
ad groups into the appropriate tool, AdWords Editor allows you to specify additions and edits. 
These tools are ideal for making long lists of specific changes to CPC or CPM bids, 
destination URLs, or ad group settings.  
 
For example, here's how you'd update multiple ad group CPC bids using the Add/Update Ad 
Groups tool: 

Prepare a spreadsheet or a list containing your ad groups and their new CPC bids, 
separated by tabs or commas. The columns should be in this order: campaign, ad 
group, CPC bid, content CPC bid (optional) and status (optional). 

1.

Go to the Data menu > Add/Update Multiple Ad Groups. 2.
Select the second radio button to indicate you'll include columns with campaign and 
ad group names. 

3.

Select keyword or placement targeting for any new campaigns that will be added as a 
result of new ad group names in your list. (You can change individual campaigns later, 
if necessary.) 

4.

Paste your ad group list into the Ad Groups field. 5.
Click Next to review the changes. 6.
You'll see a list of new and updated ad groups. Use the radio buttons to accept or 
reject the changes. 

7.

Click Finish. 8.
Select and edit specific items 

To select more than one item, hold the Control or Command key and click the items 
you want to edit. 

■

To select a consecutive list of items, select the first item, then hold the Shift key and 
select the last item in the list. 

■

To select all items in the data view, go to the Edit menu > Select All. ■
Once you've selected the items to edit, you can edit them in two ways: 

Enter your changes in the edit panel below the data view. Any changes made to a 
given field will apply to all selected items. 

■

Use the Advanced URL Changes or Advanced Bid Changes tools. (See the next 
section, entitled 'Advanced Editing Tools.') 

■
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AdWords Editor: Delete Items

As with adding and editing, you can delete items individually or delete multiple items at once.  
 
To make individual deletions, select the items to delete in the data view. For keywords, ads, 
or negative keywords or sites, click the Delete button in the tab tool bar. For campaigns or ad 
groups, change the status to Deleted in the edit panel. A minus sign (-) will appear next to 
deleted items in the data view.  
 
To delete a list of keywords, placements, negatives, or text ads from various locations, use 
the appropriate Delete Multiple tool. These tools are available via the Data menu or in the 
tab tool bars.  
 
To find and delete a list of items that meet specific criteria (such as underperforming 
keywords or text ads that contain a certain word), use Advanced Search. You'll learn more 
about Advanced Search in the View and Sort Information lesson. 

AdWords Editor: Get Recent Changes

After you download an account to AdWords Editor, the contents of the campaigns are stored 
on your computer. Before you begin a session of editing a previously downloaded account, 
it's a good idea to make sure you're working with the most recent version of your campaign 
information.  
 
To download and review any recent changes that might have been made since the previous 
download, click Get Recent Changes in the tool bar.  
 
Here's an overview of what you'll see once the download is complete: 

Recent changes downloaded from AdWords (also called account updates) are 
highlighted in green. 

■

Unposted local changes (changes made in AdWords Editor) are highlighted in purple. ■
If your local changes conflict with the downloaded changes, these items will be 
highlighted in red. 

■

To isolate updates, local changes and conflicts, use the View menu just above the 
tabs. Here you'll find options for viewing:

■

All unposted local changes ■
Account updates only ■
Account updates with unposted changes only ■

AdWords Editor: Advanced Editing Tools

The Advanced Bid Changes and Advanced URL Changes tools enable you to change 
large numbers of CPC bids, CPM bids, and destination URLs quickly.  
 
To use the Advanced Bid Changes tool, follow these steps: 

In the data view, select the keywords, placements, or ad groups whose bids you wish 
to edit. 

1.

Click the Advanced Bid Changes link at the bottom of the edit panel. 2.
Specify your changes. The options change, depending on which kind of bid you're 
changing. Options may include the following: 

3.

Increase or decrease your bids by a percentage. ■
Remove bids at the keyword or placement level so they use the ad group 
default bid (Keywords and Placements tabs only). 

■

Constrain any of these changes so that bids do not fall below or exceed certain 
values. 

■

Click Change Bids. 4.
To use the Advanced URL Changes tool, follow these steps: 

In the data view, select the keywords, placements, or ads with URLs you wish to edit. 1.
Click the Advanced URL Changes link at the bottom of the edit panel. 2.
Specify your changes. You can: 3.

Set a specific URL for all selected keywords, placements, or ads. ■
Append text to each URL. ■
Remove a specific URL parameter. ■

Click Change URLs. 4.
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AdWords Editor: Copy or Cut and Paste

You can copy or move keywords, placements, ads, ad groups, and campaigns. For example, 
you can copy text ads into a new ad group, or move an ad group into a different campaign. 
To copy or move items from one location to another, follow these steps: 

Select the appropriate context in the tree view. This could be your account name or a 
specific campaign or ad group containing the items you want to copy or move. For 
example, to copy keywords in Campaign #4, select Campaign #4 in the tree view. 

1.

Click the relevant tab above the data view. For example, to copy keywords, select the 
Keywords tab. 

2.

Select the items to copy or cut, and go to the Edit menu > Copy or Cut. 3.
Select the destination location in the tree view, and go to the Edit menu > Paste. To 
paste items into multiple ad groups, select the destination ad groups in the data view. 
Next, go to the Edit menu > Paste Special > Paste into Selected Ad Groups. 

4.

Tip: Drag and Drop  
 
To move something quickly, select it in the data view and drag it to the new location in the 
tree view. To copy it, hold the Control key.  
 
For example, to move text ads to a new campaign, select the ads in the data view of the Text 
Ads tab, then drag your selection to the destination campaign in the tree view. The original 
campaign will show those ads as deleted, and the new campaign will show them as added. 

AdWords Editor: Find and Replace

The Replace Text feature enables you to find and replace text in keywords, placements, 
ads, and destination URLs. Simply select the items you want to search, then run the Replace 
Text tool to make your changes.  
 
For example, to find and replace a certain word in your text ads, follow these steps: 

Select your account name in the tree view. 1.
Click the Text Ads tab. 2.
In the data view, select the ads you want to edit. To search and replace text in all your 
ads, go to the Edit menu > Select All. 

3.

Click the Replace Text link at the bottom of the Text Ads tab or go to the Edit menu 
> Replace Text in Selected Items. 

4.

Enter the text to be changed, the fields to be searched, and the new text. 5.
You can select options to match case or whole words only and to preserve 
capitalization. 

6.

Click Find Matches. 7.
Click Replace All to confirm the changes. 8.

AdWords Editor: View and Sort Information 

AdWords Editor: View and Sort Information

Objective: Learn how to view, sort, and search the contents of your account. Become familiar 
with tools such as Advanced Search, the Keyword Grouper, and Find Duplicate Keywords.

AdWords Editor: Search and Custom Views

AdWords Editor provides several ways for you to search and filter the information in your ad 
groups and campaigns: 

Use the Search box above the data view to perform a simple word or number search 
within your account or a specific campaign or ad group. 

■

Use the View menu to filter the information that appears on each tab. ■
Click Advanced Search to perform a more detailed search for items that meet 
specific criteria, such as performance statistics or keyword match type. When you use 
Advanced Search, the results are called a custom view. 

■

For example, use Advanced Search to find all poorly performing keywords: 
In the tool bar, use the Choose stats interval: menu to download your recent 
account statistics. 

1.

In the tree view, select your account name. 2.
Click Advanced Search next to the search box. 3.
In the Performance Statistics section, use the drop-down menus to select specific 
metrics. For example, to find all keywords with a clickthrough rate lower than 0.5%, 

4.
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select CTR from the first drop-down menu, and is less than: from the second drop-
down menu. Then type '0.5' in the text box. 
Click Search. 5.
To view the keywords that match your search, select the account or a specific 
campaign in the tree view, then select the Keywords tab. 

6.

To view your entire keyword list again, go to the View menu > All. You can return to your 
last Advanced Search view at any time from the View menu > Items that match my 
custom view criteria. 

AdWords Editor: Symbols and Colors

Here are some important symbols, colors, and other visuals you'll see in AdWords Editor: 
Plus (+): added item ■
Delta (∆): edited item ■
Minus (-): deleted item ■
Red circle: error that will prevent posting (such as a potential advertising policy 
violation or a structural issue, such as a missing daily budget) 

■

Yellow circle: warning ■
Green circle: item that has passed AdWords Editor checks but hasn't been posted ■
Pushpin icon: item with a comment (to see all items with comments, go to the View 
menu > Items with comments) 

■

Bold: unposted change ■
Gray: paused or deleted campaign or ad group ■
Strikethrough: deleted item ■

AdWords Editor: View or Hide Deleted Items

You can set your preferences to view or to hide deleted items in your account. To change 
your preferences, go to the Tools menu > Settings. Check or uncheck the appropriate 
boxes under Hide all deleted and ended items.  
 
To view the contents of deleted or ended campaigns and ad groups, you may need to 
change your settings to download these items. In the Tools menu > Settings dialog, check 
the box next to Download deleted and ended campaigns and ad groups. The next time 
you download your account or click Get Recent Changes, the deleted items will appear in 
AdWords Editor. 

AdWords Editor: Show Performance Statistics

To download and view performance statistics such as clickthrough rate, cost, position, and 
conversion information, select a date range with the View Statistics button in the tool bar. It 
may take a few moments for the information to download.  
 
Once the download is complete, click through the tabs to see performance statistics for each 
level of your account. You can control which columns are visible with the column chooser, 
located at the top right corner of the data view.  
 
The statistics you download will remain in AdWords Editor until you select a new statistics 
interval or download your account again. You'll receive a warning before your previously 
downloaded statistics are removed. 

AdWords Editor: Sort the Data View

Sort information in the data view by clicking on the column headers. For example, to view a 
list of keywords alphabetically in the data view, click the Keyword column header. Or, to sort 
your image ads by their dimensions, click the Dimensions column header. Click again to 
reverse the order.

AdWords Editor: Add and View Comments

You can add comments to keywords, placements, ads, ad groups, or campaigns. Comments 
can be helpful personal reminders, or they can explain your changes when you share your 
changes with other AdWords Editor users.  
 
To add a comment, follow these steps: 
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In the data view, select the item on which you want to comment. 1.
Click Add comment at the bottom of the tab. 2.
Type your comment in the text box. (If you collaborate with other people, you may 
wish to include your initials to distinguish your comments from others.) 

3.

A red pushpin icon appears to the left of items with comments in the data view. Point 
your mouse at the pushpin icon to reveal the comment for view. 

4.

To view comments, follow these steps: 

Go to the View menu > Items with comments. 
Click through the tabs to view items with comments. 
To return to the normal view, go to the View menu > All. 

AdWords Editor: Find Duplicate Keywords

Use the Find Duplicate Keywords tool to locate keywords that are repeated throughout your account. To access 
this tool, follow these steps: 

Go to the Tools menu > Find Duplicate Keywords or go to the View menu > Duplicate Keywords. 1.
Select the criteria for your search, including: 2.

Word order ◦
Where duplicate keywords are located ◦
Match types ◦

Click Find Duplicate Keywords. 3.

The duplicate keywords will appear in a list on the Keywords tab, where you can edit or delete them as necessary. 

AdWords Editor: Keyword Grouper

The Keyword Grouper breaks up your keyword list into groups of related terms and allows you to automatically 
create new ad groups with the related keywords. To use this tool, go to the Tools menu > Keyword Grouper. 
When you're finished, your keywords will be copied automatically into the new ad groups and deleted from their 
original locations. 

AdWords Editor: Share and Post Changes 

AdWords Editor: Share and Post Changes

Objective: Learn how to import, export, and post your account information.

AdWords Editor: Check Changes

With the Check Changes feature, AdWords Editor reviews your changes before they're posted to your 
account, helping to ensure the changes comply with AdWords policies. To check your changes, follow 
these steps: 

Click Check Changes on the tool bar. 1.
Review the count of changes that will be checked. 2.
Click Show Details to view information for each campaign. 3.
Click Check Changes to proceed with the editorial checks. 4.

AdWords Editor will review the changes, and return the count of those keywords and text ads that pass 
checks, and those that do not.  
 
Items that fail checks will display a red circle with an exclamation mark to their left in the data view. To 
see specific errors, navigate to the keywords or text ads and select them in the data view. A red box 
below the data view will show explanations of violations as well as suggestions for how to fix them. 

AdWords Editor: Post Changes

To post your changes to your AdWords account, follow these steps: 
Click Post Changes in the tool bar. 1.
You'll see a summary of the changes that will be posted to AdWords. 2.
Click Post to upload your changes, or click Cancel to cancel the post. 3.
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If you click Post, you'll see a detailed summary, by campaign, of the progress of your post. (If you 
wish, keep a record of your post by copying this report into a separate document.) 

4.

If you need to pause while your changes are posting, click Pause in the posting dialog. Then click 
Resume Post when you're ready to begin. 

5.

Click Close when the post is complete. 6.
After you post your changes, you'll see a report of the success of the post. If AdWords Editor isn't able to 
post your changes, you'll see a summary of the errors. Any campaigns and ad groups containing 
changes that didn't post successfully will remain in bold type.  
 
The changes you've made through AdWords Editor will be reflected in your account immediately. 
However, as with any changes to your account, there may be a slight delay before the changes are 
reflected on the Google Network. 

AdWords Editor: Errors and Warnings

AdWords Editor displays red and yellow splats (circles) when it detects issues that may prevent your 
campaigns from posting properly, such as editorial issues or missing maximum cost-per-click (CPC) 
values. To review errors and warnings for your changes, follow these steps: 

Go to the View menu > Errors and warnings only, Errors only, or Warnings only. 1.
The items that match your selection will appear in the data view. Click on the tabs to see the 
errors for keywords, ads, etc. 

2.

To see details for a specific error or warning, select the item in the data view. An explanation of 
the error will appear in the edit panel. 

3.

To return to the normal view, go to the View menu > All. 4.

AdWords Editor: Export and Import Account Information

You can export a snapshot of an account, campaign or ad group any time to review or to share with 
colleagues AdWords Editor offers four export formats, each useful for different purposes. All options are 
available in the File menu.  
 
Use Export Spreadsheet (CSV) to show your account and changes to someone without AdWords 
Editor, or if you simply need access to a file with your current account data, including your unposted 
changes.  
 
Use Export Summary (HTML) to see a clean snapshot of your account with your keywords, 
placements, and ads together.  
 
Use Export Backup (AEA) to preserve a snapshot of an account, campaign or ad group in AdWords 
Editor Archive (AEA) format. The snapshot can be imported later to restore the account, campaign or ad 
group to its present state. To import an archive, go to the File menu > Import Account Snapshot, and 
open the file.  
 
Use Export Changes for Sharing (AES) to send your edits to other AdWords Editor users for review in 
the AdWords Editor Share (AES) format. They'll be able to import your changes to AdWords Editor, 
review your changes, and add comments. 

AdWords Editor: Review a Share File

To import a file containing another AdWords Editor user's proposed changes, go to the File menu > 
Import Account Snapshot.  
 
When you import a share file, the Review Proposed Changes panel appears. The panel contains a key 
to the highlighted changes in your account: proposed changes are green, unposted local changes are 
purple, and conflicts between proposed changes and unposted changes are red.  
 
To view only the proposed changes in the data views of each tab, go to the View menu > Proposed 
changes only. To view only the unposted changes that overlap with the proposed changes, select 
Unposted changes with proposed changes only. 

AdWords Editor: Accept or Reject Proposed Changes

When you review another AdWords Editor user's proposed changes, you have the option to reject any 
changes you don't like. Edits that you don't reject will automatically be accepted.  
 
To reject a proposed edit entirely, select the row containing the edit you want to reject, then click Reject 
Selected Proposals in the tab tool bar. This option is also in the Edit menu. In the case of a new 
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proposed ad group or campaign, this will also reject any of the proposed edits within that ad group or 
campaign.  
 
To reject aspects of a proposed edit that conflict with your own unposted local changes, select the row 
containing the edit you want to reject. Go to the Edit menu > Reject Selected Conflicting Proposals.  
 
If instead you want to revert your unposted change in the selected row and keep the proposed change, 
simply click Revert Selected Changes in the tab tool bar.  
 
Once you've reviewed the proposed changes, you can take the following actions to clear away the 
merge panel and signal that the merge is finished: 

Click Keep Proposed Changes to accept all proposals that you haven't explicitly rejected. 1.
Click Reject Proposed Changes to clear away every proposed change. This action won't affect 
any edits you've made since importing the proposal. 

2.

At this stage, you can either post the edits to the account, or export and share with another AdWords 
Editor user. 

AdWords - Contacting Us - Help with other Google products - Change Language: English (US)  
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Introduction to Google Analytics 

Introduction to Google Analytics

Objective: Learn about Google Analytics, the benefits of web analytics, and how to install the Google Analytics 
Tracking Code (GATC).

Google Analytics provides valuable, in-depth reports in an easy-to-use format for: 
Web designers ■
Online marketers ■
Management teams ■
Anyone with a website ■

Google Analytics gives various layers of understanding about how, why, and for whom their site is (or isn't) 
performing. 

Benefits of Google Analytics

Learning how users interact with your website and using that knowledge to make improvements is key to building 
an effective online business. Google Analytics helps answer difficult questions such as: 

Why and at what points are visitors abandoning your shopping cart? ■
Is your website design driving people away? ■
Which marketing initiatives are the most effective for your site? ■
Where are your site visitors coming from? ■
What do people do while visiting your site? ■
What keywords do people use to find your site? ■

Google Analytics reports give you thorough, easy-to-understand visual reports that: 
Track e-commerce metrics such as revenue, conversion rates and ROI ■
Define variables about users as segments and analyze the behavior of each segment ■
Help you understand how visitors navigate throughout your website  ■

One example report is the Traffic Sources Overview report. For a selected date range, it shows: 

An overview of the different kinds of traffic to your website ■
The percentage of Direct Traffic vs Search Engine Traffic ■
Top Traffic Sources ■
Top Keywords driving traffic■

Getting Started with Google Analytics

When you're ready to install Google Analytics, paste the Google Analytics Tracking Code (GATC) anywhere in to 
your page's HTML code. Place the tracking code at the bottom of your page's code (directly before the closing 
</body> tag) to avoid any possible issues with your page loading at a slower rate. If you use certain advanced 
Analytics features or want to ensure the most accurate tracking, you can place the code between the opening 
<head> and closing </head> tags of each page in your site code.  
 
We recommend you review the Setting Up Google Analytics topic later in this section. It covers the 10 basic 
steps for setting up your account. 

Setting Up Google Analytics 

Setting Up Google Analytics

Objective: Learn to install Google Analytics on any website, and decide when you need to use the help 
documentation. 

About Installing Google Analytics

If you have a simple website that is primarily HTML, getting Google Analytics running is easy. Simply install the 
Google Analytics Tracking Code (GATC) in to the HTML of each page of your website, directly above the </body> 
tag.  
 
The Google Analytics Tracking code is only a few lines long, and won't interfere with the function of your website. 
Note that your code references your unique account number, so always use the code provided to you on the 
Tracking Status page of your account. You can access the code within the Analytics tab of your AdWords 

AdWords Help
Google Analytics Basics
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account by following this path: Analytics Settings > Settings Edit > Check Status. Place the code between the 
<body> and </body> tags, preferably directly before the </body> tag. 

Installing Google Analytics on Complex Websites

Proper set up of Google Analytics is important for receiving accurate and complete reporting from the start. If your 
website is built using more than simple HTML, we recommend you follow the steps outlined in the next section to 
quickly and correctly set up Google Analytics.

You should follow these installation steps if: 

Your website contains Flash files or dynamic code■
Your content is hosted on more than one domain■
Your website contains pages with multiple frames■
You plan on altering the tracking code in order to receive advanced reporting statistics■
You want to track e-commerce■

Follow the installation process described in the next section to ensure that Google Analytics is effectively set up 
for your site. 

Steps for Installing Google Analytics

This lesson provides an overview of the process you will follow. We recommend reading through the steps before 
beginning the setup process. If you have additional questions about any of the steps, you can access the Help 
Documentation or read our detailed Google Analytics Installation Guide.  
 
There are ten basic steps to implementation. Some of these steps are optional. 
 
Step-by-step Installation  
 
1) Create your Google Analytics account by using the wizard in the Analytics tab of your AdWords account. 
Follow the installation process described in the Google Analytics Help Center Installation Guide to ensure that 
Google Analytics is effectively set up for your site.  
 
2) Create profiles. Every website has one or more Google Analytics profiles. A profile contains all the reports 
available for a site, but might only report on a limited set of data or give access to a limited group of users. For 
example, you might create a profile for your marketing department that excludes internal web pages, and only 
shows reports for customer-facing web pages. 
 
3) Edit the Google Analytics Tracking Code (GATC) to customize your set-up (optional). Please visit our Help 
Center for more information if you would like to: 

· Track multiple domains in a single profile 
· Track multiple sub-domains in a single profile 
· Track multiple domain aliases 

There are also different requirements for tracking, database driven sites, frame-based content, Flash, and 
outbound links. Step 4 is critical for reporting: Until you add the GATC to your site, Google Analytics will not 
capture data and your reports will be blank. 
 
4) Google Analytics only tracks pages that contain the Google Analytics tracking code. Copy and paste the code 
segment into the bottom of your content, immediately before the </body> tag of each page you are planning to 
track. If you use a common include or template, you can enter it there. You'll need to add this code to each page 
of your site, either manually, through the use of includes, or other methods. 
 
5) For AdWords advertisers, Google Analytics can currently import cost data from AdWords campaigns. To link 
your AdWords and Analytics accounts, log in to your AdWords account and follow the steps provided under the 
Analytics tab. 
 
6) Setting up Goals and Funnels is optional but highly recommended. Goals are pages that a visitor reaches by 
completing a conversion activity, like a purchase, sign-up, download or other important page view. A funnel is the 
path you expect visitors to take in order to reach a goal. You can use goals and funnels to determine where and 
why people drop out before completing a conversion. 
In this step, you can:

· Differentiate goal and funnel steps if your URLs are dynamically generated, or if your site has only one URL.  
· Create one funnel step that allows for diverse pathways to different pages.  
· Track outbound links as a funnel step. 
· Track downloads and other non-pageviews. 
 
Users often discover problems with their funnels only after they begin to accumulate report data, so it's important 
to spend some time reviewing the information included in the Help Center on this step. Understanding this data 
can help you significantly improve your conversion rate. 
 
7) In this step, you attach information called Campaign Tracking Variables to the hyperlinks in your ad 
campaigns. This process is called 'tagging your links,' and it enables Google Analytics to generate reports based 
on the variables you set. For example, if you have two different banner ads linking to the same web page, you 
can add unique variables to each one, and track the performance of each ad separately. You do not have to do 
this for Google AdWords ads if you have auto-tagging enabled in your AdWords account. Other cost-per-click 
programs' campaign data can be tracked after completing this step, but not cost data.  
 
8) Set up filters in the Filter Manager section of your account (Analytics Settings > Filter Manager). Filters allow 
you to include or exclude specific data from your reports. 
For example, you can filter out web traffic from your employees. Our Help Center more thoroughly describes the 
most commonly used filters and the preconfigured filters in your account. You'll also find detailed steps on 
customizing and enabling your filters. 
 
9) Add users from the Access Manager (Analytics Settings > Access Manager) section of your account. You can 
add any number of users to your account, and grant them read-only or administrative-level access for each 
profile. 
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10) If you run an e-commerce site, enable Ecommerce Reporting in your Google Analytics profile settings. 
Then, with some simple additions to your receipt page, Google Analytics can record transaction and product 
information. If your site has a third-party shopping cart with a different domain, review the Help Center 
instructions carefully to avoid common mistakes. 
 
If you have questions about your setup, please visit our Help Center at: 
http://www.google.com/support/googleanalytics. 
If you would like professional help setting up your Google Analytics reporting, you can find a Google Analytics 
Authorized Consultant here: http://www.google.com/analytics/support_partner_provided.html. 

Introduction to Google Analytics Settings 

Introduction to Google Analytics Settings

Objective: Learn to navigate the Analytics tab of your AdWords account, or view information for your Analytics 
account by visiting Google.com/analytics.

Overview of Google Analytics Settings

The Analytics tab of your AdWords account contains all of your Analytics report data, and provides access to 
account settings. In the green bar below the tab, you'll see two hyperlinks: 'Analytics Settings' and 'View Reports.' 
 
This lesson will describe the Analytics Settings page in detail. To learn about viewing reports, please see the 
Reports topics. 
 
Website Profiles  
 
To the right of the View Reports link is a drop down menu that allows you to select the profile for which you would 
like to view reports. A profile is generally one complete set of Google Analytics reports for one domain, such as 
www.google.com. Each profile contains a specific set of users, goals and filters. Goals and filters will be 
discussed later.  
 
If you are an account administrator, you can set up multiple profiles to separately track several domains, 
subdomains (like adwords.google.com), and subdirectories (like www.google.com/analytics/). You can have up to 
50 profiles in your account.

Understanding Google Analytics Settings

The remainder of this lesson will focus on the information accessible from the Analytics Settings page if you are 
an account administrator. From the Analytics Settings link you can manage your website profiles, control which 
data is included in reports, and control who can access your Analytics account.  
 
Website Profiles Area 
 
In the Website Profiles area of the Analytics Settings page, you can: 

Add new profiles ■
View reports for each profile ■
Edit profile settings ■
Delete profiles■
Check the installation status of the tracking code and conversion goals■

The status indicates whether the profile is currently gathering data, and whether goals have been set up. Goals 
are discussed later in this lesson, and in the topic on Goals and Funnels. These options are available for each 
profile in your account.

If you have more than ten profiles, there are 'Prev' and 'Next' links that allow you to move through the list. A pull-
down menu controls how many profiles are shown at a time. You can use the search box to limit the number of 
profiles you see, or to find a particular profile. For example, if you have several profiles for different web sites, but 
you only want to see the profiles for one particular web site, type the profile name, or a portion of it, in the Search 
box and click the 'plus' icon next to the Search field. Clicking the 'plus' icon will show all profile names that contain 
the searched word or phrase. Alternatively, clicking the 'minus' icon will exclude all profiles containing that word, 
and include all other profiles. This is useful if you have several profiles for one website, and want to see all or 
none of the profiles for that website. 
 
Profile Settings

When you click 'Edit' in the 'Settings' column, you are taken to a Profile Settings page.  
From here you can edit: 

Main Website Profile Information ■
Conversion goals & funnels ■
Filters ■

Edit Main Website Profile Information

When you click 'Edit' link in the upper right of this area, you are taken to a page that allows you to change the 
profile information. The Profile Name is the unique name you created to identify your profile. The Website URL is 
the primary web address that the profile is tracking; for example, www.AdWordsExample.com. 
The default page should be set to the default (or index) page of your site. For example, http://www.google.com/ 
and http://www.google.com/index.html both go to the same page, meaning that index.html is the default page. 
Without the default page information entered correctly, these would be reported as two different pages, and your 
report data would be flawed. On most sites, the default page is 'index.html', but might be 'default.htm,' 'index.htm' 
or something else.  
If your Analytics account is linked to a Google AdWords account, your time zone will be automatically set to your 
AdWords preference and you will be able to view, but not edit, the time zone in your Profile Settings. This ensures 
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accurate reporting on your AdWords campaigns. 
 
A query parameter is a special character in a URL that differentiates the main URL from a specific query. For 
example, in this URL, www.google.com/search?q=analytics, the query parameter is the "q" and the query term is 
"analytics." If your site uses unique session IDs or other query parameters in your URLs that you are not 
interested in seeing in your reports, you can easily exclude these parameters by entering them into the Exclude 
URL Query Parameters field. Separate each parameter with a comma. 

The next two options apply if you conduct commerce on your site. If you want to track transactions, check 'yes' 
here. Learn more about tracking e-commerce transactions.  
 
Next, you can specify:

The type of currency you use ■
The number of decimal places in the currency (for example 1.00) ■
And whether to show the currency symbol before or after the amount ■

Check the 'Apply Cost Data' box if you want AdWords cost data to be automatically imported into your reports. 
Click Save Changes when you're done editing these settings.  
This returns you to the Profile Settings page.

Edit Conversion Goals and Funnel 
 
The next section of the Profile Settings page allows you to edit conversion goals and funnels. A conversion 
occurs when a visitor completes an activity that you have identified as a goal of your site. This could be a 
purchase, a newsletter signup, a download, or any important page view. A funnel is a series of pages through 
which a visitor must pass before reaching the conversion goal. In your Profile Settings, you can set up and edit 
Conversion Goals and Funnels by clicking 'Edit' next to the goal name.  
For more information, please see the topic on Goals & Funnels. 

Edit Filters 

In the next profile settings section, 'Filters Applied to Profile,' you can edit the filters that are currently applied to 
the profile. Filters are a powerful tool that enables you to manipulate the data stored in your account so that the 
data displayed meaningfully depicts your reporting objectives. A commonly used filter type is an Exclude filter, 
used to exclude certain data from your reports. For example, filters can be used to exclude irrelevant pageviews 
coming from within your own company and not from your visitors, or report only on a specific subsection of your 
site. You can edit or remove existing filters. Please refer to the topic on Filters for more information. 
 
Edit User Access 
 
The last profile setting section, 'Users with Access to Profile,' allows you to manage your users. A user is a 
person who can log in to your Analytics account.  
When you edit an existing user's settings, you can change their first or last name and their Access type, which 
can be either Account Administrator or View Reports Only. 

Account Administrators can make any changes to any of your profiles. 
When you click the 'Add Users' link you are given the choice of adding a new user, or adding existing users to the 
profile. If you add a new user, you can specify their access type as previously discussed.  
 
When adding users to your Analytics profiles, it is important to understand that they cannot access your AdWords 
account using their login email. To view your Analytics reports or perform Analytics administration tasks in your 
account, they must login to the standalone Analytics product at http://www.google.com/analytics.  
Your Analytics users will not be able to access your AdWords campaigns, but will have access to your Analytics 
reports.  
 
Once you have added a new user, you can view their level of access in the Report Access column. 
 
Access Manager 
Returning to the Analytics Setting page, there are two other control areas: the Access Manager and the Filter 
Manager. In the Access Manager area, you can see your total number of users. Click on the Access Manager 
link for more information on each user's access levels. 
 
Here you can see the list of User Email Addresses, and you can use the Search field to include or exclude certain 
users. For example, entering "gmail" in the Search field and clicking the 'minus' icon will exclude all users whose 
email address contains "gmail." You can also delete users by clicking on the 'Delete' link. Clicking on the 'Edit' link 
next to a User Email Address enables you to edit the user's name and access privileges, and add or remove 
profiles which the user can view.  
 
Filter Manager 
The final section on the Analytics Settings page is the Filter Manager area, which shows you the total number of 
filters available. From the Filter Manager link you can edit or delete filters. When you click the Add Filter link to 
create new filters you can define the filter name, the filter type, and choose which profiles to apply the filter to. 
Please see the topic on Filters for more information.

Tracking Campaigns with Google Analytics 

Tracking Campaigns with Google Analytics

Objective: Learn to: 

Define and use the Google Analytics campaign tracking variables.■
Interpret the data captured by the campaign tracking variables in your reports.■

Overview of Google Analytics Tracking

To track different kinds of advertising you'll need to use campaign tracking variables. Campaign tracking 
variables are identifiers which you attach to the hyperlinks leading to your website. They enable you to uniquely 
identify all of your hyperlinks, and view reports on the activity on your website generated by those links. 
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For example, if you include links to your website in an email newsletter, you can attach variables at the end of 
each link. When a user clicks on a link, your reports will show you on which link he clicked, as well as which 
newsletter contained that link. 

The example hyperlink below has the following campaign tracking variables attached in bold ( you'll learn how 
each of these variables is used in the next section): 

Source = SE1■
Medium = CPC■
Term = tshirt■
Content = ad_version_1■
Campaign = Google_T-Shirts■

http://www.example.com/?
utm_source=SE1&utm_medium=CPC&utm_term=tshirt&utm_content=ad_version_1&utm_campaign=Google_T-
Shirts 

Including campaign variables in your hyperlinks is called tagging your links. Properly tagging your links will ensure 
that your reports include useful information about your marketing efforts. 

AdWords Auto-tagging for Google Analytics

Google Analytics makes it easy to track your AdWords referrals effortlessly using the auto-tagging feature. Auto-
tagging is enabled by default when you link your AdWords and Analytics accounts. To turn auto-tagging on or off 
at any time, update the checkbox in your Account Preferences from your AdWords My Account tab. Using auto
-tagging allows you to bypass the steps to tag the URLs of your AdWords advertisements.

Advertising Campaign Variables in Google Analytics

You can tag your links with one or more of the following campaign variables. :

Name ■
Source ■
Medium ■
Content ■
Term ■

Name : With this variable you can track the different advertising campaigns or product promotions that your 
business creates. An example of this would be a sporting goods store tracking the effectiveness of their "Spring 
Ski Sale" advertising campaign. With AdWords auto-tagging, the Name variable is the name given to the 
originating AdWords Campaign. 

Source : Visitors to your website must come from somewhere. That is, each referral to a website has an origin, or 
Source . Examples of sources are the Google search engine, an email newsletter, or a referring web site. There 
may be several Sources for each campaign. For example, the "Spring Ski Sale" is advertised in both an email 
newsletter and a banner ad. In this case, both "newsletter" and "banner ad" would be possible Sources. For 
AdWords auto-tagged accounts, the Source variable is "Google." 

Medium : The Medium helps to qualify the source. Together, the Source and Medium provide specific information 
about the origin of a referral. For example, if the Source is "Google," the medium might be "CPC," indicating a 
sponsored link. Or, the Medium might be "organic," indicating a link in the unpaid search results. In the case of a 
"newsletter" Source, examples of Medium include "email" and "print." For AdWords auto-tagged accounts, the 
medium variable is "CPC." 

Content : The Content variable indicates the version of an ad on which a visitor clicked. Labeling your content 
versions allows you to determine which one is most effective at attracting profitable leads. For example, if you 
had two versions of a banner ad, you could use the Content variable to identify which one is bringing more visits 
to your site. For AdWords auto-tagged accounts, the Content variable is the first line of the originating 
advertisement's ad text. 

Term : The Term is a keyword or phrase that matches what a user types into a search engine. For example, a 
link in a cost-per-click (CPC) ad would be tagged with the Term that triggered the ad. In our example, the Term 
might be "spring weather skis." For AdWords auto-tagged accounts, the Term variable is the keyword that 
triggered the originating advertisement. 

Advertising Campaign Variables and Reports in Google Analytics

There are several reports that allow you to view traffic from tagged initiatives (links which you have tagged with 
campaign variables). 

The All Traffic Sources report (in the Traffic Sources section) shows all the traffic that comes to your site including 
traffic from tagged links. By default, it sorts the traffic by Source and Medium together, but you can use the 'Show' 
pulldown menu to organize the traffic by Source or Medium. Your tagged sources and mediums will be included 
in this list. 

To see your traffic sorted according to Content, use the Ad Versions report (in the Traffic Sources section). Your 
tagged Content variables will be listed in the table. 

To see your tagged campaigns, look at the Campaigns report (in the Traffic Sources section). This report will 
typically list your AdWords campaigns, your tagged campaigns, and "(not set)" traffic that is not associated with 
any campaign.

To see how well your paid keywords for a particular search engine are performing, navigate to Search Engines 
and select the search engine that you are interested in. Next, select "paid" within the 'Show' menu. A report for 
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the search engine will appear and the terms (keywords) with which you tagged your campaigns will be listed in 
the table. 

Introduction to Google Analytics Reports 

Introduction to Google Analytics Reports

Objective: In this section you will learn about the five report categories and the type of data you can find in each 
report category.

Google Analytics Report Categories

With Google Analytics reports, you can determine which marketing efforts are driving the most valuable traffic to 
your site and see how visitors navigate through your site. Track the marketing initiative performance for your 
AdWords campaigns, email campaigns, search engine referrals, and even traditional media advertising. 
 
There are five report categories 

Visitors■
Traffic Sources■
Content■
Goals■
Ecommerce■

Visitors Section 

The reports in the Visitors section focus on how many visits your site received from different segments of 
visitors. For example, you can see how many visits you received from each country (Map Overlay). You can see 
how many visits you received from people whose previous visit to your site was 3 days ago (Recency, under 
Visitor Loyalty).  
 
The Visitors section is the only section in Google Analytics where you can find the number of people who came to 
your site. (See Absolute Unique Visitors in the Overview report or in the Absolute Unique Visitors report, under 
Visitor Trending.) Visits tells you the total number of visits your site received. So, if four people visited your site 10 
times each during the active time period, Google Analytics will show that your site received 40 Visits from four 
Absolute Unique Visitors. 
 
The Visitors section also contains four Visitor Loyalty reports: Loyalty, Recency, Length of Visit, and Depth of 
Visit. Instead of simply stating averages, these reports show the range of visitor interaction on your site. For 
example, the Visitor Loyalty report shows how many 1st-time, 2nd-time, 3rd-time, etc. visits your site received .  
 
Many of the reports in the Visitors section allow you to compare the overall quality of traffic from different 
segments of visitors. For example, you can compare visitors from different geographic areas based on their site 
usage, conversion behavior, and ecommerce profitability (Map Overlay). The following reports in the Visitors 
section allow you to make these kinds of comparisons: Map Overlay, New vs. Returning, Languages, the 
Browser Capabilities reports, the Network Properties reports, and User Defined.

Traffic Sources Section

The reports in the Traffic Sources section focus on comparing the quality of traffic you receive from different 
referrals, search engines, keywords, ads, and marketing campaigns. Most of the reports in this section have site 
usage, conversion behavior, and ecommerce profitability metrics to compare traffic from different sources.  
 
Direct Traffic focuses specifically on visits from people who clicked a bookmark to come to your site or typed your 
site URL into their browser. The Referring Sites and Search Engines reports allow you to compare traffic from 
sites and search engines respectively and drill down on each site and search engine to compare URLs or 
keywords from that site or search engine.  
 
The All Traffic Sources report allows you to compare all traffic across all the sources that send traffic to your 
site. For example, you can see how paid traffic compares to unpaid traffic or how traffic from Google compares to 
traffic from another web site.   
 
The Keywords report allows you to compare the effectiveness of keywords across all search engines either with 
or without regard to whether they are paid or organic (unpaid) keywords. The AdWords reports focus exclusively 
on AdWords traffic. 
 
To compare the effectiveness of AdWords campaigns and ads, use the Campaigns and Ad Versions reports. 
These reports will also include any non-AdWords campaigns and ads that you have tagged with campaign 
variables.   
 
Content Section

Content reports can help you understand how effectively your site engages visitors. The Top Content, Content 
by Title, and Content Drilldown reports allow you to see which pages on your site were most popular (and 
therefore, most important), how much time people spent on each page, how frequently people exited your site 
from each page, and how valuable each page was to your business. 
 
The Navigation Analysis reports (accessible from the Content Overview report) allow you to see how visitors 
navigate through your site. You can use this information to determine whether visitors are easily able to find what 
they are looking for or if they are getting confused and leaving your site. You can also use the Site Overlay to 
view click, conversion, and ecommerce information overlaid on each link on your site. 
 
The Landing Page Optimization reports (also accessible from the Content Overview report) can help you tailor 
landing pages for your ads and referrals. If visitors don't see information on landing pages that addresses their 
reasons for visiting your site, they will simply leave without purchasing anything or converting to your goals. You 
can also use the Top Landing Pages report to monitor the overall effectiveness of your landing pages, while the 
Top Exit Pages report displays the pages from which visitors left your site. If there are pages on this report that 

Google Analytics Reporting
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you don't consider to be logical exit points, you might try to understand why visitors leave from these pages. 
Consider how you might change the pages or redesign portions of the site so that fewer visitors leave 
unexpectedly. 
 
Goals Section

The information in the Goals reports can help you understand how visitors arrive, or don't arrive at your goals. 
For example, the Funnel Visualization report shows you the points at which visitors progress through or 
abandon the conversion steps (for example, shopping cart checkout process) you have defined. 
 
Tracking these pages reveals how efficiently your site directs visitors to your goal. If any of the funnel pages are 
overly complicated or hard to navigate, they'll show signs of significant visitor drop-off and lower conversion rates. 
This information helps you concentrate on improving the pages with the poorest performance for funneling users 
toward your site goal. 
 
In addition to tracking the funnels you have defined, you can also use the Reverse Goal Path to see if visitors 
are converting via other click paths. 

Ecommerce Section

In addition to the Ecommerce metrics (available wherever you see the Ecommerce tab on reports), there is also 
an Ecommerce section that focuses exclusively on ecommerce activity. Please note that no data will appear in 
these reports (or on the Ecommerce tab in the reports in other sections) unless you have enabled ecommerce 
reporting. 
 
These reports show revenue (the value of purchases), conversion rate (the percentage of visits that resulted in a 
purchase), transactions (the number of purchase orders) and Average Order Value (the average revenue from 
each purchase). 
 
The Product Performance reports (Product Overview, Product SKUs, Categories) show you how many different 
products generate your revenue and you can click on any product name, SKU, or category to view detailed 
information for that item. 
 
The Transactions report lists of all transactions on your site and is useful for seeing all the ecommerce 
transactions that are being used to calculate ecommerce metrics.  
 
The Visits to Purchase and Time to Purchase reports help you understand your sales cycle by showing you 
how long it takes for visitors to purchase. 

Google Analytics Report Tools 

Google Analytics Report Tools

Objective: Learn to set report date ranges, make date range comparisons, adjust the display of graphics in your 
reports, filter report data, and export and print reports.

Google Analytics Scorecards

Many reports contain a scorecard which summarizes results across several metrics. The metrics displayed on the 
scorecard change according to the tab you have selected. For example, the Site Usage tab scorecard usually 
contains the following metrics: Visits, Pages/Visit, Avg. Time on Site, % New Visits, and Bounce Rate. The 
Ecommerce tab scorecard usually contains Visits, Revenue, Transactions, Average Value, Conversion Rate, and 
Per Visit Value. 

Each scorecard box displays a number in large bold font. Comparison data is provided below the number in bold.  
The primary number in bold is the aggregate performance for the traffic segment you're examining in the report. 
For example, if you go to the Referring Sites report and then drill down on a specific referral site, the Visits box 
displays in bold the total number of visits your site received from that referral during the active time period.  
 
If no date range comparison is active, the comparison data describes how the number in bold compares to your 
site as a whole. For example, the '% of Site Total' in the Visits box shows the percentage of total traffic that came 
from the specific referral. Some scorecard boxes, such as Pages/Visit, display the site average ('Site Avg') 
followed by a percent number in parenthesis.  The percent number shows how much performance differs from the 
site average.  
If you have set a comparison date range, a 'Date Range' indicates the number of visits received during the 
comparison time period and the percentage increase or decrease that occurred from the comparison time period 
to the active time period. 

Google Analytics Report Views

Reports with tables contain 'Views' - five icons at the top right, directly above the scorecard. They correspond to 
the table view (default), pie view, bar chart view, comparison view, and sparkline view, respectively.  The 
comparison view allows you to quickly see how the performance of each item in the table (for example, referral 
site, keyword, etc) compares to the site average. The sparkline view displays the same data that appears in the 
scorecard but adds a sparkline which summarizes performance over time.  
 
Filtering and Sorting Data  
 
The 'Find' field at the bottom of many reports allows you to limit data rows to those that contain a specific word, 
phrase, or file name. For example, if your homepage is "index.html," enter this text in the 'Find URL' field of the 
Top Content report to view data solely for your homepage.  
Or, select 'excluding' from the pulldown menu that appears next to the 'Find' field. This will exclude the data rows 
that match what you type in the field.  
Data rows in a table can be sorted by clicking on the column headings. Click more than once to toggle between 
ascending and descending order.  
Many reports display a 'Segment' pulldown menu above the scorecard. This important feature allows you to 
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change the way the data is displayed in the table. For example, the table in the Keywords report lists by default 
the individual keywords that brought you traffic. However, if you select 'City' from the Segment pulldown menu, 
the table will display your keyword traffic by city.    
 
Exporting and Printing Data  
 
Most reports enable you to export data by clicking 'Export,' located at the top of the report. You can export data in 
four formats: PDF, XML, CSV (comma-separated value), and .tsv (tab-separated value), which can be opened 
with any spreadsheet program.  
To print a report, select PDF and print the resulting document. 

Google Analytics Date Ranges

You can view reports for any time period you choose by using the date selection tool.  To access the tool, click 
the date range (for example, "Apr 1, 2007 - May 1, 2007") that appears at the upper right hand corner of your 
report.    

The tool contains two tabs: Calendar and Timeline. If you want to view reports for a single day, an entire month, 
or a particular year, you can simply click on the desired day, month or year in the calendar. Alternatively, you can 
type the date range into the Date Range fields or use the Timeline tab to set a date range. The Timeline contains 
a slider (two sliders if you have selected 'Compare to past') that you can move and resize to include your desired 
date range.  
 
To compare two date ranges, select 'Compare to past.' An additional pair of date range fields will appear. Type a 
start and end date into these fields or use the additional slider on the Timeline tab to select a date range. You can 
also use the Calendar tab to select a comparison date range.  
Once you have specified your desired date ranges, click 'Apply Range' to finish. The date or date range you have 
chosen will appear in the upper right corner, above your report. 

Getting Started with Google Analytics Reports

The Dashboard 

The Dashboard contains your customized set of reports. The Dashboard is the first screen you see when 
accessing your reports. It also: 

Provides a summary of each report you've saved •
Allows you to click directly to the complete report •

Example: You want to see how much traffic you receive from different cities in California each time you access 
your reports in Google Analytics. Once you have saved the Map Overlay report for California, you will see a 
California summary on your Dashboard. You'll also be able to jump directly to the complete report on California 
instead of navigating to the Map Overlay report and then drilling down to see the California report.  
 
To save a report to the Dashboard, click 'Add to Dashboard' under the report title. To remove a report from the 
Dashboard, click the x icon at the top right of the report summary. You can also rearrange the order in which 
report summaries appear on the Dashboard. To do this, simply drag a report summary to your desired location.  
 
Embedded Help  
 
The Google Analytics interface has links to several important Help resources. 

Each metric on a scorecard has a ? icon. Click this icon to learn how the metric is calculated. •
The left navigation of Google Analytics has a box titled Help Resources. This box contains the following 
links. 

•

For a short description of the report, click 'About this Report' for a short description of the report. •
For best practice tips relating to the report, click 'Conversion University.' •
For links to Help Center articles relating to the report, click 'Common Questions.' •

Emailing Google Analytics Reports

You can email reports to others on an ad-hoc or scheduled basis. To send a report, click Email below the title of 
the report you want to send. A Setup Email screen appears: 

To email the report immediately, click the Send Now tab. Enter a list of recipients in the 'To' field. Specify 
a format for the email (XML, PDF, CSV, or TSV). Provide a subject and description and click 'Send.' 

■

To create a new regularly scheduled email, click the Schedule tab. Enter a list of recipients in the 'To' field 
and specify a format for the email (XML, PDF, CSV, or TSV). Provide a subject and description. Select 
Daily, Weekly, Monthly, or Quarterly from the drop-down menu and click 'Schedule.' 

■

To add the report to an email that has already been scheduled, click the Add to Existing tab. Select the 
email to which you'd like to add the report and click 'Add Report.' 

■

About Email Schedules 

Daily reports are sent each day (beginning the next day) and report data for the previous day. •
Weekly reports are sent each Monday (beginning the next Monday) and report data for the previous 
Monday through Sunday. 

•

Monthly reports are sent on the first day of each month (beginning the first day of the next month) and 
report the previous month's data. 

•

Quarterly reports are sent on the first day of each quarter (i.e. January 1, April 1, July 1, and October 1) 
and report the previous quarter's data. 

•

Note: Scheduling is based on timezones in the United States. The timing of scheduled reports for users outside of 
the United States varies due to timezone and may result in a significant schedule delay.
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Google Analytics Visitors and Traffic Reports 

Google Analytics Visitors and Traffic Reports

Objective: Learn which reports are most useful for tracking and maximizing the return on investment of your 
marketing efforts. 

Overview of Google Analytics Visitors and Traffic Reports

Analyze the effectiveness of your traffic sources from the standpoint of conversions, return on investment, and 
site usage.  
 
By understanding which referrals, search engines, keywords, online ads, etc., you can refer your highest-
performing traffic to your site.  

Your most rewarding traffic sources are those that refer visitors most likely to convert on the goals you have 
established for your website, become customers, or simply interact extensively with your site. 

Google Analytics Marketing Optimization Metrics

The specific metrics you use to analyze how effectively you drive traffic to your site will vary according to your 
objectives. If your primary goal is to attract visitors who will interact extensively with your site, you'll find "Site 
Usage" tab metrics such as 'Pages/Visit,' 'Avg. Time on Site,' and 'Bounce Rate useful.' 

If your primary objective is for visitors to convert on specific goals, review conversion rates under the 'Goal 
Conversion' tab that appears on most reports. 

If your objective is geared towards online sales, review the metrics that appear under the 'Ecommerce' tab that 
appears on most reports. 

Google Analytics Visitors Reports

This section provides information on the characteristics of your visitors overall. You can find out where your 
visitors come from geographically (Map Overlay), what languages they speak (Languages), and what browsers 
and computers they use (Browser Capabilities). The Visitor Loyalty reports tell you how frequently visitors return 
to your site and how much they interact with your site (Length of Visit, Depth of Visit). 

You can also find out how many unique visitors your site receives, instead of simply looking at the number of 
visits. Go to Overview and look for 'Absolute Unique Visitors' in the report. 

Google Analytics Traffic Reports

The reports in this section deal with all the different places on the web from which your site receives traffic: 
referral sites, search engines, keywords, ads, and "direct" traffic (visits from users who typed your URL directly 
into their browser).  
 
Of particular note is the Keywords report and the AdWords reports. The AdWords reports contain an additional 
tab, 'Clicks.' The Clicks tab provides ROI-based metrics for each of your AdWords campaigns, ad groups, and 
keywords. These metrics include CPC (cost-per-click), RPC (revenue-per-click), ROI (return on investment), and 
margin. 

In addition, the Keyword Positions report (under AdWords) tells you how search engine result position affects 
metrics like conversion, revenue, and average value. 

Google Analytics Search Engine Marketing Reports

The Search Engine Marketing Reports focus on keywords and their conversion metrics for CPC and unpaid 
search results. These reports are key to analyzing the effectiveness of your AdWords campaigns, and any other 
keyword-based advertising programs you participate in. Here are a few examples of the types of reports included 
in this group. 

The CPC Program Analysis report gives you the following data on each CPC program you run: 

Clicks ■
Transactions ■
Cost ■
Revenue ■
Clickthrough rate ■
Conversion rate ■
Cost per click ■
Revenue per click ■

The Overall Keyword Conversion report lists metrics by keyword, such as the number of visits and pageviews per 
visit. By clicking on the plus (+) icon next to any keyword, you can see these same metrics broken down for each 
Source[Medium]. For example, by drilling down on the keyword "google for kids," you might see the number of 
visits resulting from searches on this keyword coming from "yahoo[cpc]," "google[cpc]," and "msn[organic]. " 
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The Keyword Considerations report gives you data on keywords that are bringing visitors to your site from search 
engines, but which you're not using in your CPC advertising. You can use this information to find additional 
keywords on which you may want to bid.

Google Analytics Content and Goals Reports 

Google Analytics Content and Goals Reports

Objective: Learn how to improve your website's usability with the Content and Goals reports. 

Overview of Google Analytics Content and Goals Reports

The following reports can help you understand how effectively your site maintains visitor interest and how 
effectively it converts visitors to the goals you have defined: 

Content reports show you which pages are most popular on your site. •
Top Landing Pages helps you identify and examine the effectiveness of the pages through which visitors 
enter your site. 

•

Use Top Exit Pages to identify the pages from which visitors exit your site. By examining report metrics for 
these pages, you can determine whether these pages are logical exit points for visitors or whether you 
might be able to improve them and keep visitors engaged with your site. 

•

Visualize how page layout influences visitor navigation choices with Site Overlay. •
Goals and Funnels Process helps you understand how effectively your site converts visitors to the goals 
you have defined. If many of your visitors abandon their shopping carts or leave your site before 
converting, you can study your site funnel processes to learn why. 

•

Let's take a closer look at the types of reports included in each of these groups. 

Google Analytics Content Reports

The Top Content, Content by Title, and Content Drilldown reports show which pages on your site are most 
popular. For each page or grouping of pages you can see pageviews (Pageviews and Unique Pageviews), the 
average amount of time visitors spent on the page (Time on Page), how frequently visitors left your site after 
viewing the page (Bounce Rate and %Exit), and the '$ Index,' which measures the value of conversions (in terms 
of ecommerce revenue and/or goal value) made after a visit to the page. 

Google Analytics Top Landing Pages Reports

The Top Landing Pages report lists all of the pages through which visitors entered your site. For each page, you 
can see the number of entrances, the number of bounces, and the bounce rate. 

Google Analytics Top Exit Pages Reports

The Top Exit Pages report lists each page and the activity that occurs on the page. Learn the number of exits 
that occurred from the page and the percentage of pageviews that resulted in a site exit.  
  

Google Analytics Site Overlay Reports

The Site Overlay allows you to view click, conversion, and ecommerce information, which is overlaid directly on 
to your website.  

Google Analytics Goals and Funnels Process Reports

 
Total Conversions shows how many conversions your site received over time for each goal.  
 
Conversion Rate shows your site conversion rates over time for each goal.  
 
Goal Verification shows the pages that count towards the goal and the number of times each of these pages 
was viewed. This report is useful for verifying the specific goal pages that were logged.  
 
Reverse Goal Path report shows the path that converted visitors actually used to arrive at the goal.  
 
The Goal Value report shows the value of the conversions your site received over time.  
 
Abandoned Funnels and Funnel Visualization both describe the effectiveness of the funnels you have 
specifically designed. For example, if you have a specific check out or registration process and you have defined 
the pages that make up this process, the Abandoned Funnels report will tell you how many visitors who start the 
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process actually complete it. The Funnel Visualization report shows exactly where visitors who abandon the 
funnel go and how many visitors remain in the funnel after each step.

Google Analytics Ecommerce Reports 

Google Analytics Ecommerce Reports

Objective: Learn how to use the Ecommerce reports to collect data on your product sales. 

Overview of Google Analytics Ecommerce Reports

The term e-commerce refers to the transaction of goods or services online. While other reports can provide 
ecommerce metrics (see the Ecommerce tab in most reports), the Ecommerce reports in Google Analytics are 
particularly useful for reviewing site transactions (Transactions report), identifying best selling products (Product 
Performance reports) and studying sales cycle data (Visits to Purchase and Time to Purchase reports). 

Understanding Google Analytics Ecommerce Reports

The Total Revenue, Conversion Rate, and Average Order Value reports show your ecommerce revenue, 
conversion rates, and average order value from purchases over time.  
 
There are three types of Product Performance reports: Product Overview, Product SKUs, and Categories. 
These reports show transactions, revenue, average price and average quantity for each product, SKU, and 
product category. You can click on any product, SKU, or category to see detailed information about that product 
or product grouping.    
 
The Transactions report is a list of all the transactions on your site, useful for tracking the vast majority of visitors 
to your site. Please note that this report isn't able to track 100% of all visitors, so the financial information should 
be used to track and analyze trends - not as a precise measure for accounting purposes..  
You can click on any transaction to view when it occurred.    
 
The Visits to Purchase and Time to Purchase reports can help you understand purchase latency. 
 
The Ecommerce section is not the only place in Google Analytics to view ecommerce information. Most reports 
in the Visitors section and the Traffic Sources section provide an Ecommerce tab. The metrics in this tab show 
how profitable a traffic source or visitor segment is. For example, you can compare revenue across geographic 
locations or ecommerce conversion rates across search engines. The ecommerce tab shows the following 
metrics: 
 
Revenue allows you to compare ecommerce revenue from ecommerce transactions. This number includes tax 
and shipping. Revenue does not include value from ordinary (non-ecommerce) goal conversions. 
Transactions is the total number of ecommerce transactions (purchases). 
Average Value is the average value of an ecommerce transaction (purchase).  
Conversion Rate is the percentage of visits that resulted in an ecommerce transaction (purchase). This is 
different from the Conversion Rate displayed on the Goals tab which includes only non-ecommerce conversions. 
Per Visit Value is the average value of a visit to your site and is calculated as (ecommerce-only) Revenue 
divided by Visits. It is different from the Per Visit Goal Value displayed on the Goal tab which is based only on the 
value of non-ecommerce conversions.

Google Analytics Loyalty and Latency Reports

The reports in the Loyalty and Latency section answer the questions: 

How do new visitors compare to returning visitors with respect to the number of visits, number of 
transactions, total revenue, average visit value, and average transaction value? 

■

Should you invest more in acquiring new customers or in generating new value for your existing 
customers? 

■

How many visits, and how much time, elapses before customers make a purchase? ■
For example, the New vs. Returning report in the Loyalty and Latency section enables you to see how valuable 
each type of visitor is to your site. Using this report, you may find that your returning customers are far more 
valuable than your new customers. By cross segmenting this data by campaign, you can see which campaigns 
are successfully bringing your existing customers back to your website. You can then continue to fund and 
improve on those campaigns.

Google Analytics Revenue Sources Reports

The Revenue Sources reports answer the questions: 

Which referral sources (such as search engines, newsletters, and referral sites) result in the most 
revenue? 

■

Which visitor language preferences account for the most revenue? ■
Where do my best customers live? ■

One powerful feature that can be useful in analyzing your revenue sources is custom segmentation. This feature 
allows you to identify a specific group of your visitors. For example, if your users identify themselves by age group 
on your site, you can use the User-defined report to determine conversion metrics for each age-group segment 
(it's called the User-defined report since you define the variable on which you segment your visitors). As a result, 
you can see which age group generates the most revenue. 

Page 11 of 17خدمات تبليغات در گوگل www.BERTINA.us

خدمات تبليغات در گوگل www.BERTINA.us



Learn more about how to set up user-defined classifications.

Google Analytics Product Merchandising Reports

The Product Merchandising reports answer the questions: 

How much of each product and product category do I sell? ■
How popular is each product with customers who searched on each keyword? ■
How popular is each product with customers referred from each source? ■

One example is the Product Keyword Correlation report, which links product purchases back to the keywords 
originally used in a search. This information provides insight into which products you should be promoting in 
creative ad content and landing pages to drive the most business through your site. It shows the number of items 
sold, the total revenue, the average price, and the average order quantity for each product you sell online. 

Another example of a Product Merchandising report is the Product Source Correlation report. This report links 
product purchases on the site back to the source from which the sale came, such as cost per click ads or search 
engine referrals. This report shows the number of items sold, the total revenue, the average price, and the 
average order quantity for each product you sell. 

To begin collecting e-commerce data for your site, you must add some code to the receipt page in your checkout 
process. 

Google Analytics Goals and Funnels 

Google Analytics Goals and Funnels

Objective: After completing this topic, you will be able to: 

Explain what goals are■
Identify when goals should be used■
Explain what the most common goals are■
Set up a goal ■

Overview of Google Analytics Goals and Funnels

A goal is a webpage which a visitor reaches once they have completed an action that you desire. In the Analytics 
tab of your account, you define your goals based on the purpose of your website, and the actions you want your 
visitors to take.

Examples of common goals include:

A receipt page after placing an order ■
A "subscription confirmation" page after a newsletter sign-up ■
A download of a whitepaper ■
The completion of a form requesting follow-up from a salesperson ■
Or any other page to which you are trying to drive your visitors ■

Goals are often called conversions, because on ecommerce sites, visitors are converted to customers 
 
Funnels 
 
A funnel path is a series of pages through which a visitor is expected to pass before reaching the conversion 
goal. A graph showing the number of visitors to each of these pages is usually shaped like a funnel. Typically the 
first page counts the most visitors, with additional visitors dropping out at each successive page before reaching 
the final goal. This is where the name "funnel" comes from.  
 
For example, more visitors may view a product page than enter a shopping cart, and even fewer still may 
complete the order. 
 
Goals enable you to easily see how many visitors reach a certain page, and understand where visitors may be 
losing interest and falling off the path along the way.  
 
You can use this information to improve your site's content and design.  
 
Goals help you make smarter decisions about your marketing efforts by telling you:  

Which marketing campaign or referral results in the most conversions ■
The geographic location of visitors who reach the goal ■
The keywords that lead to conversion■

Using Google Analytics Conversion Goals and Funnels

Under the 'Conversion Goals and Funnel' section, select one of the four goal slots available for that profile, and 
click 'Edit.' 

In the Goal URL field, type the web address that marks a successful conversion when reached. Make sure 
to specify the full URL, including the 'http' prefix.

1.

In the Goal Name field, give the goal a name as you want it to appear in your Goal and Funnel reports. 
The name should be one you will easily recognize; for example, Checkout Complete or Registration 
Confirmation. 

2.

Then choose whether to activate the goal. Turn the goal On or Off depending on whether you want Google 
to track the goal at that time. This setting allows you to configure your goal ahead of time, and simply turn 

3.

Google Analytics Goals and Filters

Page 12 of 17خدمات تبليغات در گوگل www.BERTINA.us

خدمات تبليغات در گوگل www.BERTINA.us



it On when you're ready. Notice that after you enter the goal URL and name, they appear grayed-out in the 
fields below the last funnel step to remind you that your goal is the last step in the funnel.
The next step is to define your funnel path: the pages you expect visitors to click through to reach a goal.  
For each funnel step, enter a full URL (including the 'http' prefix), and give the step a name such as 
"Product Page" or "Check Out Page."

4.

 
While creating these steps is optional, it is strongly recommended, since the Funnel Visualization report will 
show you how effectively you retain visitors throughout the conversion process. When you define steps, you can 
see if visitors are taking the path you expect, and where they may be losing interest.  
 
For example, if you run an ecommerce site, a recommended funnel would define the checkout steps that lead up 
to a completed purchase. In this example, the funnel generally would not include individual product pages -- 
rather, it would consist only of those final pages that are common to all transactions.  
 
The final step is to configure additional settings: 

If the URLs entered in the funnel or goal are case sensitive, select the checkbox that has the correct 
version of your URL. 
For example, if home.htm is a different page than Home.htm with a capital 'H', check this option.

1.

If you are using dynamic URLs, you may wish to make use of the matching options when entering funnel 
or goal URLs.  
<a href= "http://www.google.com/support/googleanalytics/bin/answer.py?answer=55">Read more</a> 
about our matching options. 

2.

The goal value is used in Google Analytics' return on investment calculations. If you wish to set a value, 
enter the amount in the 'Goal value' field. You will see your goal value calculations in the Goals > Goal 
Value report.

3.

Click Save Changes to create this Goal, or Cancel to exit without saving 4.

 
With some advanced set up, you can take advantage of some additional important features of goals: 
 
First, you can create funnel steps for Flash pages or other pages where the URL doesn't change. 
 
Also, in one single step of your funnel path, you can gather data on traffic to a whole category of pages. For 
example, you could configure a funnel path like this: 

Homepage ■
Shirts Page or Pants Page or Hats Page ■
Check Out Page ■
Goal: Thank You Page ■

Learn more about these goal functions. 

Google Analytics Filters 

Google Analytics Filters

Objective: After completing this topic, you will be able to: 

Define what filters are ■
Explain when filters should be used ■
Identify the most common filters ■
Explain how to use the predefined filters ■

Overview of Google Analytics Filters

A filter can be applied to modify data in your Analytics reports. They enable you to customize your reports so that 
data that you deem useful is highlighted in interesting ways. 
 
Filters can also help you clean up your data so that it is easier to read. 
 
Below are some examples illustrating how you can use filters: 

If you only want to report on a specific section of your website, create a filter that only includes data on 
visits to a specific subdirectory

•

If in your reports you want to exclude pageviews of your site that come from your employees to make your 
data better reflect your actual customer traffic, create a filter that excludes pageviews coming from specific 
IP addresses 

•

If your pages are named in a manner that's hard to read - for example, if your page filenames are numbers 
- design a custom filter to replace these numbers in your reports with more easily read labels

•

 
Filters are not retroactive. Therefore all historic data in your profile will not be affected by a filter, only new data 
will be affected. 

Google Analytics Predefined and Custom Filters

There are three types of predefined filters built into your account to help you complete common tasks.  
The predefined filters allow you to: 

Exclude all visits from your reports that come from a specific domain. For example, you can exclude all 
visits from links on the comp.xyz.net domain. Use this filter to exclude visits that originate from a specific 
network, such as your internal company network.

■

Exclude all visits from an IP address or range of IP addresses. ■
Include only traffic from a subdirectory. Use this filter if you want to report only on a particular subdirectory. 
For example, if your website is www.example.com, a subdirectory may be www.example.com/motorcycles.

■

In addition to using predefined filters, you can also create custom filters. Creating custom filters gives you 
complete control over the data on which you report.  
 
For example, if your URLs contain long strings of hard to read characters, you can use a custom filter to make 
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your reports much more readable. Using a relatively simple filter, you can take a URL that looks like this... 
 
www.trinkets.com/store/shoes.php?item=sneakers&sku=135483&color=white 
 
...and make it appear in your reports looking like this: 
 
/store/shoes/sneakers/white 
 
In brief, the steps for getting started using filters are: 

Create the filter via the Filter Manager link on the Analytics Settings page.1.
Apply the filter to your profile.2.
Allow time for data to be gathered. 3.
View the profile's reports.4.

Filters act on data gathered after the filter is applied. Reports that include dates before the filter was applied will 
not be built using filtered data. It is not possible to reprocess historical data at this time. Therefore, if you begin 
filtering out traffic from your employees on Wednesday, but you're looking at reports that include Monday and 
Tuesday in the date range, your employees' traffic will still be reflected in the reports.  
 
If you want to become an advanced user of filters, visit the following links to learn more about these topics. 

Learn which fields can be filtered. Google Analytics stores data in a database. Databases are made up of 
fields, so understanding which fields you can filter will enable you to create better, more powerful filters.

1.

Learn how to use Regular Expressions, or RegEx for short. RegEx is used to match text using wildcards. 
RegEx is useful because you can filter out (or in) many different items at once. For example, you could 
filter out two different pages from your reports using only one filter. RegEx is a powerful tool and should be 
fully understood before use.

2.

Finally, visit our Help Center to learn more about filters.3.

Improving Revenue and Profit with Google Analytics 

Improving Revenue and Profit with Google Analytics

Objective: Learn to use the reports in the Ecommerce Analysis section to identify opportunities to increase 
revenue and profit.

Evaluating Overall Revenue with Google Analytics

A pharmacy takes orders online and via phone. Often online traffic will lead to phone sales. To determine when 
online traffic is creating offline sales, the marketing manager charts spikes of phone sales against online traffic to 
the Order by Phone page using the Content Drilldown report (in the Content section). He then determines the 
source of the referrals to the Order by Phone page and targets his campaigns accordingly. 
 
Recall that a source is the web page from which your visitor was referred to your site. You can use the All 
Traffic Sources report to find out how effectively each source drives ecommerce revenue. The Ecommerce tab 
tells you: 

The total revenue that resulted from the source ■
The number of transactions from each source ■
The average value of each transaction from each source ■

Use the Referring Sites report to identify your top e-commerce drivers, and build on your success on these sites. 
For example, by sorting on the Average Value column, you might identify a source that contributes a small 
percentage of your total revenue, but shows a high average value per transaction. Knowing this, you may want to 
increase your ad buys on this site. If it's a ratings site, you might want to ask your best customers to write a 
review on this site. 
 
Use the Map Overlay in the Visitors section and click the Ecommerce tab to see which cities your revenue comes 
from. As with the Referring Sites report, you may wish to identify high 'Average Value' cities and increase your 
advertising targeted to those cities. 

Please note that, while Google Analytics can track the vast majority of visitors to your site, it is not able to track 
100% of visitors. Financial information should not be used for accounting purposes, but rather used as a measure 
to trackand analyze trends.

Identifying Revenue-Driving Keywords with Google Analytics

The online pharmacy loves to be able to directly track online sales back to the specific keywords on Google. To 
do this, they use the Search Engines report in the Traffic Sources section. From this report, they can select 
'Google' from the table to get a report that shows all keywords from Google. The Ecommerce tab shows how 
much each keyword contributed to overall online sales.

Evaluating the Performance of Specific Products with Google Analytics

The Product Performance reports in the Ecommerce section are designed to help you understand and explore 
how each product contributes to your online sales. There are three reports: Product Overview, Product SKUs, 
and Categories. From these reports, you can click on any entry (product, SKU, or category) to see:

Items: Total number of units sold■
Transactions: Total number of e-commerce transactions that included a purchase of this product■
Product Revenue: Revenue earned from sales of this product■
Average Price: Average price of the units sold■
Average QTY: Average number of units sold per transaction■

Driving Improvements with Google Analytics
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Optimizing Regional Marketing for Products with Google Analytics

The online pharmacy uses the Product Performance reports in the Ecommerce section to target ads to regional 
markets. These reports lend a compelling argument for local campaigns.

You can focus your product marketing by looking at the regions where each product does best. To to this, use the 
Product Overview report (under Product Performance, in the Ecommerce section). Click on one of the products 
shown in the report and you will see a Product Detail report for that product. Then, from the Segment menu, 
select 'Country/Territory,' 'Region,' or 'City.' The resulting report lists the geographic areas of where the buyers of 
that product originated.

Optimizing Product Advertising

The online pharmacy also uses the Product Overview report to find out which keywords result in sales of its top 
performing brands of medication. By clicking on one of the products shown in the report, they can see a Product 
Detail report for that product. Then, from the Segment menu, they select 'Keyword.' The resulting report shows 
which keywords resulted in sales of the product.

This technique can be useful if you are trying to sell more of a specific product. You can find out which keywords 
resulted in the most sales of the product and then increase your spend on those keywords.

Improving Your Content and Site with Google Analytics 

Improving Your Content and Site

Objective: Learn to use Google Analytics Content reports to: 

Evaluate your visitors' overall interest in your site ■
Identify the most popular and valuable pages of your site ■
Evaluate and improve the effectiveness of landing pages ■
Evaluate and improve the effectiveness of funnels ■

Evaluating Page Popularity with Google Analytics

You can use the Top Content report in the Content section to find out which pages are most popular on your site. 
Included in this report are: 

Pageviews: The total number of times the page was viewed across all visits. 
 

■

Unique Pageviews: Unlike Pageviews, Unique Pageviews does not count repeat visits to a page. So, if 
page A was viewed twice during a single visit, Unique Pageviews will only count it once. Pageviews, 
however, will count it twice. 
 

■

Time on Page: The average amount of time that visitors spent on the page is useful for learning if visitors 
are looking at the content or if they immediately clicked to go somewhere else. If they're leaving quickly, 
ask yourself: 

■

What information is missing from the page? ■
Is that information on the pages they go to? ■
Can you move more important information onto pages with short average times?  ■

Bounce Rate: The percentage of entrances on the page that result in the person immediately leaving the 
site. Non-entrance pages always have a Bounce Rate of 0.00%. A high bounce rate indicates that the 
page is not well matched to the ad or link that is driving traffic to the page.  

■

% Exit: Tells you the percentage of visitors leaving your site immediately after viewing that page. For 
example, if a page received 100 pageviews and 20 of them were the last pageviews on your site, the % 
Exit would be 20%. A high % Exit may indicate that something about the page turns your visitors off or it 
could simply mean that visitors are leaving after concluding their business on your site. Things that might 
turn away visitors include: 

■

A product price that is uncompetitive ■
A landing page that doesn't match well with the advertising that directed the visitor to it  ■

$ Index: If you have assigned values to your goals, or if you have an e-commerce site (learn more about 
tracking ecommerce transactions), the $ Index indicates how often a page was visited prior to the visitor 
reaching a goal. The $ Index will be higher when the value of the goal is higher, and when the the page is 
visited frequently prior to goal completion. If you sort on the $ Index column, the top listed pages will show 
which pages are most valuable on your site . You can then analyze what's working well with these pages, 
and perhaps add the same characteristics to your other pages. 

■

Evaluating Directory Content with Google Analytics

If you have organized your site content into directories, use the Content Drilldown report (in the Content section) 
to evaluate the popularity and value of each directory's content. Identify poorly performing directories as 
candidates for improvement, based on Pageviews, % Exit, and $ Index. 
 
Use the Content by Title report (in the Content section) to see the same information aggregated by page title. 
The Page Title appears at the top of the browser and is written into the page's HTML code. This is useful if you 
have groups of pages that share the same page title, such as 'Catalog.' 
 
One large company used Analytics to restructure their website to determine which method for navigating their site 
was the easiest to use and resulted in the most goal conversions. They compared four different methods and 
learned which performed best using the Content by Title report and the $ Index. 
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Evaluating Site Interest with Google Analytics

Use the Depth of Visit report (under Visitor Loyalty, within the Visitors section) to find out how deep the visits to 
your site were. If all of the visits are clustered at the top of the graph, visitors are leaving your site after viewing 
only a few pages - you may wish to enhance your content or find ways to keep visitors on your site. This may 
require getting feedback from your visitors and asking specifically what they are looking for or would like to see. 
For more information about enhancing content, refer to the articles available in our Conversion University. 
 
Use the Length of Visit report (also under Visitor Loyalty, within the Visitors section) to find out how long visitors 
are spending on your pages. Similar to the Depth of Visit report, the distribution of visits across this graph can 
give a good indication of how interesting your site is to visitors. 

Evaluating Landing Page Effectiveness with Google Analytics

Use the Top Landing Pages report in the Content section to evaluate how effectively your landing pages keep 
visitors on the site: 

Entrances: Shows the number of times a visit began with a view of the page. ■
Bounces: Shows the number of times the visitor left without viewing any other pages. ■
Bounce Rate: Shows the percentage of visits the visitor left without viewing any other pages. ■

A high bounce rate indicates that the landing page is not enticing visitors to click further into the site. This might 
indicate a mismatch between ad and landing page, or a page design that doesn't make visitors confident of a high
-quality online-shopping experience. 
 
Again, use the Top Content report (also in the Content section) to review the Average Time and the $ Index of 
your landing pages. Your most effective landing pages will have the highest $ Index. 
 
It is important not to confuse the bounces listed in the Bounce Rate report with the % Exits listed in the Top 
Content report. The bounce rate is the rate at which people leave your site after viewing only a single page. The 
% Exit is the percentage of people ending their visit to your site on that page. 

Evaluating Funnels and Goals with Google Analytics

Is your site achieving its goals? If you have not defined goals for your site, see the topic on Goals. 
 
Visitors drop off the path before completing a goal for many reasons. They may get confused if the steps are too 
complicated, or they may want to go back and get more information before moving forward. 
 
The abandonment rate is the percentage of visitors who begin down the path to a goal (the funnel), but drop out 
before reaching the goal. For example, if Goal 1 has abandonment rate of 90%, only 10% of visitors who begin 
the funnel process actually reach the goal. Use the Abandoned Funnels report in the Goals section to evaluate 
the abandonment rate for each of your funnels. 
 
Use the Funnel Visualization report in the Goals section to identify the steps where you lose most of your 
visitors. In the center of the report, you'll see one box for each step you have defined. The box at the bottom is 
the goal. Each box shows the percentage of visits that remain in the funnel at each step. 
 
The Abandonment Points shown at the right hand side of the report show where visitors went when they 
abandoned the funnel: either a page or "exit", which indicates that they left the site. 
 
For example, the right hand side of the Funnel Visualization report may show that many of your visitors are 
returning to your 'product information pages' after beginning the checkout process. By including the product 
information on your checkout pages, you may be able to keep more visitors in the funnel on their way to 
becoming customers. 
 
Carefully consider how you can re-design the pages in your funnel to keep more visitors. Do visitors drop out 
immediately or on one of the subsequent steps? Do you do a good job of showing visitors where they are in the 
process and what they need to do next? Consider:

Consolidating steps into fewer pages•
Enabling visitors to go back and get information without leaving the funnel by opening pages in new 
windows

•

Reducing the amount of input you require from customers (for example, requiring customers to create a 
login is known to drive down conversions)

•

Improving Your Marketing Initiatives with Google Analytics 

Improving Marketing Initiatives with Google Analytics

Objective: Learn to use Google Analytics Traffic Sources reports to evaluate conversions and ROI for marketing 
initiatives and keywords.

Evaluating Marketing Initiatives with Google Analytics

The reports in the Traffic Sources section are designed to help you evaluate the value of your marketing 
initiatives. You can see which marketing initiatives, such as paid keywords, unpaid keywords, paid ads, and 
referrals from other sites, generate the most business for your site. 
 
Most of the reports in this section include three tabs: Site Usage, Goal Conversion, and Ecommerce. 
The Goal Conversion tab focuses specifically on conversions. The tab includes the following metrics: 
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Visits: the number of visits from each campaign or source, etc. Note that this is different than the number 
of visitors. For example, the report might show 3 visits, but the site may have only received 2 visitors 
(since one visitor may visit twice). 

■

Goal1, Goal2, etc.: These columns show your conversion rates for each goal that you have defined. ■
Conversion Rate: The percentage of visits which resulted in a conversion to at least one of your goals. ■
Per Visit Goal Value: Non-ecommerce revenue divided by Visits. For example, if Goal 1 has an assigned 
value of $10 and there were two conversions, the total revenue is $20. If there were 20 visits, the revenue-
per-visit would be $1. This metric will always be 0 unless at least one of the goals has an assigned value. 
You can assign values to each goal in the Conversion Goals and Funnel settings, from the Analytics 
Settings link. 

■

Note: If you have an ecommerce site and you have added the appropriate ecommerce transaction code to your 
web pages, you will see Per Visit Value on the Ecommerce tab instead of Per Visit Goal Value on the Goal 
Conversion tab. Per Visit Goal Value is the average of total goal revenue across all visits; Per Visit Value is the 
average of total ecommerce revenue across all visits. 
 
Use the Goal Conversion tab metrics to determine which marketing initiatives are most effective. For example, 
you can stop paying for ads which have low conversion rates. You may also find it interesting to compare your 
unpaid referrals to each other and to your paid initiatives. 

Examples of Evaluating Marketing Initiatives with Google Analytics

One large online electronics company uses the All Traffic Sources report to evaluate which online marketing 
program is working best. By selecting 'Medium' from the Show menu within the report, they can compare the 
effectiveness of CPC traffic (i.e. AdWords and other cost per click traffic), online ads, an email newsletter and an 
extensive affiliate advertising network.  Because they are most interested in conversions, they use the Goal 
Conversion tab on the report to evaluate the traffic. 
 
One major web property owner has 15 different sites and relies heavily on affiliate marketing. The owner likes to 
see which landing pages work best for each affiliate. To see the landing pages to which a specific affiliate is 
driving traffic, she uses the Referring Sites report and, in the report table, clicks on the affiliate site for which she 
wants data. Once the Referring Site report for that affiliate appears, she selects 'Landing Page' from the 
Segment menu. This displays a list of the landing pages to which the affiliate sent traffic. The metrics on the 
Ecommerce tab allow her to quickly see which landing pages are working best for that affiliate.

Evaluating Keyword Performance with Google Analytics

You will typically use the Keywords report or the AdWords reports to evaluate keywords. The Keywords report 
allows you to evaluate traffic for both paid and unpaid keywords. You use the Show links (directly above the 
scorecard) to select "paid", "unpaid", or "total" (both paid and unpaid) keywords.  The Keywords report shows all 
of your keywords across all search engines. As with most other reports in the Traffic Sources section, you can 
use the Site Usage, Goal Conversion, and Ecommerce tabs to assess the quality of the traffic. 
 
The AdWords reports are provided specifically to help you evaluate and optimize the traffic you receive from 
AdWords. AdWords Campaigns (and the two associated detail reports: AdWords Ad Groups and AdWords 
Keywords) have an extra tab called Clicks which provides ROI metrics. You will see data on the Clicks tab as 
long as you have properly linked your AdWords and Analytics accounts. Impressions, Clicks, Cost, CTR (Click 
Through Rate), and CPC (Cost Per Click) are imported automatically from your AdWords account. RPC 
(Revenue Per Click), ROI, and Margin compare your AdWords costs with your revenues. Comparing the ROI of 
different keywords, for example, enables you to determine where you get the best value. 
 
One large shoe seller uses the data from the Goal Conversion tab in the AdWords Campaigns (and the two 
associated detail reports: AdWords Ad Groups and AdWords Keywords) reports to identify the keywords that 
convert most effectively to the "purchase complete" goal. The marketing manager places the top performing 
keyword in a preferred campaign with a higher budget and moves the lower performing keywords into a lower 
spending campaign. 
 
The Keywords Positions report shows how position on the search engine result page correlates with Visits, 
Pages/Visit, Per Visit Goal Value, Revenue, and other metrics. For example, you can find out whether your site 
received more traffic from the keyword "running shoes" when your ad was in position 2 versus when it was in 
position 3. You can also find out whether conversion rates are higher for position 2 than position 1. If you notice 
that, for specific keywords, your conversion rates are the same for all positions, but that you receive less traffic 
and revenue for the lower positions, you may wish to bid for the lower positions but increase your spend so that 
your ad is displayed more frequently. 
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 Search Help  

Complete Learning Center Path - Lesson 9 of 9 
Managing Multiple Accounts 

Return to the Complete AdWords Learning Center Lesson Index 

 

Introduction to My Client Center (MCC) 

Introduction to My Client Center

Objective: With My Client Center, client managers (such as agencies, 
search engine marketers, and automated bid managers) can more 
efficiently manage multiple AdWords accounts or large campaigns. Learn 
more about My Client Center, including steps to setting one up.

What is My Client Center?

Your My Client Center account, also called a client manager account or 
MCC, is an umbrella account containing access to individual AdWords 
accounts and other client manager accounts. It acts as a shell account that 
links individual AdWords accounts in one location. The look and feel of My 
Client Center is very similar to individual AdWords accounts, with greater 
functionality.

My Client Center Benefits

With My Client Center, you can access multiple AdWords accounts via the 
client manager account login - no more logging in and out to switch 
between AdWords accounts. In addition, client managers can see all their 
individual and client manager AdWords accounts in one place via the My 
Client Center view. With a My Client Center account, you can:

Easily view all linked accounts, including other client manager 
accounts, via the My Client Center view. 

■

See relevant information for all linked AdWords accounts in one 
place. 

■

Use a single login to access all AdWords accounts.■
Generate reports across multiple client accounts at once, or 
download the client "dashboard" into a .csv file. 

■

Invite a client to be managed through an automated message.■
Create AdWords accounts in your MCC, and automatically link 
them to your master account upon creation.

■

Manage clients running on the same keywords under different 
accounts.

■

Signing up for My Client Center

You can gain your own My Client Center by signing up for the Google 
Advertising Professional program. This program provides training and 
resources for third-party providers (such as agencies and resellers) that 
support Google advertisers by managing their AdWords accounts and their 
online advertising needs. 

Visit the Google Advertising Professionals homepage to become a Google 
Advertising Professional for free. Upon enrollment, you'll receive your free 
My Client Center account to help you manage client accounts. 

AdWords Help
My Client Center
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To learn more about this program, visit the Google Advertising 
Professionals Help Center.

Linking AdWords Accounts to My Client Center

You can easily link an existing or new AdWords account to yours.

Linking an existing AdWords account 
Retrieve your client's AdWords external Customer ID and account 
password (which establishes your client's permission to link the 
account to yours). 

1.

Log in to your MCC. 2.
Click the Link existing account link above your client accounts 
table. 

3.

Enter your new client's Customer ID and account password into the 
appropriate fields. 

4.

Click Submit. 5.
Alternatively, if you don't have your client's login password, you can simply 
enter his/her login email into the corresponding field for Link existing 
account. When you hit Submit, the client receives a notification that 
invites him/her to link to your account. During this process, you'll see a 
pending notification for the client account in your MCC. Upon the client's 
acceptance, you'll receive a confirmation notification and the client account 
will be automatically linked to your account. 
 
Linking a new AdWords account 

Log in to your MCC.1.
Click the Create new account link above your client accounts 
table.

2.

Complete the form, and click Create Account.3.
Click Create a campaign to create your client's campaign in the 
AdWords sign-up wizard. Then, return to your MCC to enter your 
client's billing information. You'll need to enter this information to 
activate your new client account. You can also return to this step 
later by clicking the client's account in your main MCC view.

4.

Accessing Client Accounts in My Client Center

When logged in to your My Client Center account, you can navigate to any 
linked accounts by using the Jump to client drop-down menu located at 
the top the page. This will show you all the accounts linked to your My 
Client Center account. 

Alternatively, you can select an account by clicking on the account name in 
your My Client Center view. To return to your main view, click on the My 
Client Center link at the top of any page in your account. 

My Client Center Dashboard, Alerts and Reporting

Your My Client Center (MCC) not only allows you to manage multiple 
accounts easily: It also features a "dashboard" view of your managed 
client accounts, with alerts for important account issues, and provides 
easy access to robust performance reporting tools.

When you log in to your MCC account, you'll see an overview of your 
managed client account information. Performance and budget statistics 
for managed accounts are shown on separate tabbed pages, providing a 
top-level view of key stats across accounts.

On the Performance page, you'll find stats on clicks, conversions and 
conversion rates, as well as separate columns for Search and Content 
CTR, allowing for easier comparison of performance based on network 
placement. On the Budget page, you'll find information about start- and 
end- dates, percent of budget spent and total spend for each account.
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You may filter your view of managed client account data by selecting 
time periods for viewing statistics, making it easier to limit your view of 
account statistics to a particular week, month, year or date range.

Your MCC Dashboard also includes an Alert box telling you about any 
current alerts associated with your managed accounts. You can view all 
alerts for your managed accounts by clicking the 'Alerts' link at the top of 
your MCC; from there, you can search among alerts by selecting 'Refine 
Search' on the MCC Alerts page. Please read our MCC Alerts FAQ to 
learn more about this important feature.

Your MCC also lets you run reports for multiple clients through your 
Client Reports tab. Using this feature, you can generate many different 
report types, including Account, Campaign, Ad Group, Keyword, URL 
and others. You can also run individual reports for a client by clicking the 
Reports tab from within the client's account. For more details on reports, 
see the Reports lesson. 

My Client Center Limitations

Although My Client Center offers similar functionality as your AdWords 
account, you currently cannot edit your clients' login information. If you'd 
like to edit your client's information, you'll need to first log in to your 
client's individual account via adwords.google.com using the account's 
associated email and password. Then, you can change individual login 
preferences from the client's My Account tab.

Communicating the Benefits of AdWords 

Communicating the Benefits of AdWords

Objective: Learn how to explain the advantages of Google search, 
distinguish search results from AdWords ads, and outline key points for 
making a successful AdWords sale. 

About the Google Search Experience

Search results on Google are generated automatically. No company 
can buy placement in Google's search results (also known as the 
'natural search results'). AdWords ads, which companies can purchase 
on a cost-per-click (CPC) basis, are clearly marked as 'sponsored links' 
and appear above and beside the search results. These ads are ranked 
by performance - that is, their positions are determined by both cost-per
-click amounts and clickthrough rates. Therefore, advertisers can't 
remain in the top position(s) unless their ads are relevant. (For more 
information on this topic, please see the Ad Ranking lesson.) 

About AdWords Targeting

With traditional advertising and most forms of online advertising, ads 
are simply broadcasted to a wide range of audiences. Google AdWords 
ads, however, are targeted to people's specific interests. 

When a user enters a search query on Google, they'll see the natural 
search results for that query, along with AdWords ads that are highly 
targeted to the search topic. Thus, AdWords ads are as relevant and 

Selling AdWords
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useful as Google's search results. Your ads will reach users at the 
precise moment when they're looking for your product or service. 

About AdWords Marketing Reach

Targeted, relevant AdWords ads appear on Google properties, 
thousands of partner search sites and content sites (such as How Stuff 
Works and the New York Times) in the Google Network, and 
newsletters and email. These ads are seen by over 80% of internet 
users in the United States alone, and our global network provides 
extensive ad exposure across the world. (Please see the Google 
Network lesson for more information about where AdWords ads 
appear.) 

About AdWords Costs

AdWords advertisers can choose cost-per-click (CPC) or cost-per-
impression (CPM) pricing, whichever best suits their needs.

Under the Google AdWords CPC pricing model, advertisers pay for ad 
clicks, not impressions. If an advertiser's ads appear 50 times and 
receive five clicks, the advertiser is charged only for those five clicks. 
With CPM pricing, advertisers who prefer impression-based pricing can 
set their own price and receive traditional CPM metrics.

AdWords advertisers enjoy a tremendous level of control over their 
costs. They can set a maximum daily budget and specific amounts 
they're wiling to pay per click or per thousand impressions, which the 
AdWords system will never exceed.

AdWords advertisers can also set up Google's free conversion tracking 
tool and receive account reports by email so they can monitor their 
sales conversions and return on investment. (Please see the Reports 
and Understanding ROI lessons for more information.)

About AdWords Versatility

Because Google AdWords offers such a high degree of flexibility and 
control, it's an especially effective marketing tool to help advertisers:

Generate leads■
Generate sales or conversions■
Create brand awareness■

The Basic Google AdWords Sales Pitch 

The Basic Google Sales Pitch

Objective: Learn how to explain how to get started with the AdWords 
program, how Google advertising can drive profits, and what steps 
constitute a successful sale. 

About AdWords ROI

Here's an example of how AdWords ads can pay for themselves and 
eventually lead to increasing returns:
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Your client invests US$1,000 in AdWords ads with a US$1 maximum 
CPC. Because your client only pays for ad clicks, he or she is assured 
of receiving at least 1,000 clicks (with the AdWords Discounter, your 
client may receive substantially more clicks at a lower CPC). 

If 10% of these clicks result in sales, your client would have made 100 
sales. If the average sale amount is one hundred dollars, your client's 
initial US$1000 investment will have returned US$10,000 in sales. In 
these cases, your client should advertise on a larger scale and reinvest 
the profits into his or her AdWords budget, which can increase potential 
profits even more. 

Making AdWords Profitable for Clients

You can design a profitable AdWords program for your clients in four 
simple steps: 

Identify your client's advertising goals, then create relevant 
keywords and ads for each of these goals. 

1.

Run 'pilot' campaigns to test the ads and keywords. 2.
Set up the AdWords conversion tracking tool and reporting tools 
to analyze the performance of your client's ads. 

3.

Modify and test your client's campaign until you reach a desired 
ROI. Retain only the most successful ads.

4.

Sample Account Planning Milestones

Here's a sample timeline of events that should occur as you and your 
client plan to start using AdWords:

Action Item Owner Completion 
Date 

1. Identify client and opportunity with 
Google.

You Day 1 

2. Define marketing objectives, metrics, and 
budget. 

You & 
Client Day 7 

3. Deliver a written proposal, including 
sample ads, keywords, and daily budget 
options. 

You Day 14 

4. Client approval and sign-off. Client Day 21 

5. Launch, monitor, & modify campaigns to 
meet objectives.

You Day 28 

6. Report findings regularly to your client, 
and expand and refine their campaigns to 
increase their ROI

You On-going

Addressing Common Client Questions and Concerns 

Addressing Common Client Questions and Concerns

Objective: Learn how to describe Google's position in the marketplace, 
explain the effectiveness of search advertising compared to other types 
of advertising, and address common questions and sales objections. 
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Why Choose Google AdWords?

With one Google AdWords media buy, your client can single-handedly 
accomplish what used to take a whole team of media planners. 
AdWords ads can appear virtually anywhere online worldwide, yet 
remain targeted and relevant. And because your clients can view, 
monitor, measure, and edit their AdWords campaigns at any time on 
their own, they can enjoy unprecedented levels of control over their 
advertising spending and reach. 

Explaining Search Marketing to Clients

Your clients may ask why search marketing is appropriate for them. 
Search marketing offers significant advantages over other media, such 
as outdoor, radio, TV and print, particularly in the areas of customer 
education/information (for branding purposes) and direct response. If 
your clients are interested in targeting specific audiences and tracking 
advertising effectiveness more precisely, it's clear that AdWords is right 
for them. 

Responding to Common Client Concerns

Before beginning your sales process, you can prepare to address 
common concerns or objections from potential clients. Here are a few 
examples:

'I don't have the budget' or 'I don't need to advertise.'

You can address this concern by offering to start your client's 
advertising on a smaller scale. For example, you can start a test 
campaign with a budget as low as just one dollar per day, then monitor 
the results to show your client how they can achieve significant ROI 
without incurring high costs. 

You may also inform them about AdWords Smart Pricing, which lowers 
CPCs to the expected value of a click. Please refer to the AdWords 
Pricing lesson to learn more about how AdWords pricing works. 

'This sounds too complicated.'

If your client is concerned that search marketing sounds too 
complicated, offer to design an AdWords marketing program for them. 
Use conversion tracking and AdWords reporting to show the progress 
they're making. You can manage a client's account continually, or, once 
the account is running smoothly, transition the account management to 
your client. 

AdWords API Overview 

AdWords API Overview

Objective: Learn about the API and whether or not it's for you. We'll 
cover some basic features and benefits of using it. We recommend that 
only developers or advertisers with a solid understanding of AdWords 
follow this lesson. 

The AdWords API
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AdWords API Defined

To access AdWords accounts programmatically, the developer builds 
web service clients that connect to one or more of the standardized 
AdWords API Web Services. Developers must have both an approved 
Developer Token and Application Token to access the API.

Programming Languages Supported

The AdWords API utilizes SOAP and WSDL, which support a growing 
number of languages - including Java, .NET, Perl, PHP, and XML.

Code samples for each of these languages are available on the 
AdWords API homepage. 

Who Should Use the AdWords API?

The AdWords API is designed for developers representing large, tech-
savvy advertisers and third parties who want to automate reporting or 
campaign management. This includes SEMs (search engine 
marketers), agencies, and other online marketing professionals who 
manage multiple client accounts and/or large campaigns. 

Since the AdWords API takes technical know-how and programming 
skills, advertisers with programming knowledge, or who employ 
developers, will achieve the best results.

To access the AdWords API, you must be an AdWords advertiser, or a 
developer who represents one, with a My Client Center account. 

AdWords API Benefits

The AdWords API is extremely flexible and functional. It gives you the 
ability to design new and creative ways to use AdWords. What you can 
do with the AdWords API depends on your programming skills and 
advertising needs. Here are just some of the possibilities:

Create and manage campaigns, ad groups, keywords, and ad 
text (creatives)

■

Get traffic and performance estimates■
View clicks, clickthrough rates, and your ad's average position■
Retrieve reports on account performance■
Access and modify ad syndication preferences and login 
information

■

View basic API usage information■
Generate custom, keywords, ad text, and URL reports 
automatically 

■

Integrate AdWords data with databases, such as inventory 
systems 

■

Develop additional tools and applications to help you manage 
accounts

■

In addition, the API is a great substitute for screenscraping, which 
eventually won't be allowed.
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Getting Started with the AdWords API 

Getting Started with the AdWords API

Objective: Learn how to sign up for the AdWords API and receive a 
Developer Token and an Application Token for use in accessing the 
AdWords API.

Signing up for the AdWords API

To sign up for the AdWords API, you'll need a My Client Center (MCC) 
account (if you don't have one, you'll create one during the sign-up 
process). You'll register for the API by providing information about your 
company, applications and clients. You will also be asked to agree to 
the AdWords API Terms & Conditions, and to provide payment 
information for billing purposes.

Here's how to sign up and register for the AdWords API:

Visit https://adwords.google.com/select/ApiWelcome and log in 
with your MCC account information or, if you don't have one, 
with another Google Account. If you don't yet have a Google 
Account, you can create one from this page as well.

1.

If you don't already have an MCC account, you'll be taken to a 
page where you can create one. After signing in with your MCC 
account information, you'll then go to a page where you provide 
information about your company, clients, and the applications 
with which you'll be accessing the API. Please provide as much 
information as possible, as we'll be reviewing your input during 
our approval process.

2.

Next, you'll agree to the AdWords API Terms & Conditions and 
provide your billing information. Though some advertisers may 
be eligible for free quota, we still need you to complete this 
process so we can approve your tokens and allow you to access 
the API.

3.

After registration, you'll be taken to your new AdWords API Center 
within your My Client Center. Here, you can view status messages 
about your token approval, see your Developer Token and Application 
Token information, and view API usage stats. 

After we have reviewed your registration information, we'll inform you of 
your approval status for a Developer Token and Application Token. 
Both tokens are required to access the AdWords API.

About Developer and Application Tokens

To access the AdWords API, you need two tokens: A Developer Token 
(which identifies an approved developer for the API) and an Application 
Token (which identifies an approved application for API usage). Each 
token is a unique text string of letters, numbers and symbols that you'll 
need to include in the header of all your API requests in order to talk to 
the AdWords server. 

All tokens are subject to approval by the AdWords API teams. Once 
your tokens have been approved, you'll find them listed at your 
AdWords API Center page in your My Client Center. You should treat 
your tokens with at least the same level of security as your account log-
in and password information.

If you need additional Application Tokens because you plan to access 
the API with more than one application, you can apply for additional 
tokens by clicking the 'add' link in the Application Tokens section of 
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your AdWords API Center. Only one Developer Token will be assigned 
to each developer, however.

With your approved Developer Token and Application Token, you can 
start writing programs. To get started writing programs in compliance 
with API standards, refer to the sample code and Developer's Guide, 
available on the Google AdWords API homepage.

About AdWords API Units

The AdWords API manages traffic through our fee-based API unit 
system. Developers are charged a rate of $0.25 per 1,000 API units 
consumed. Some advertisers who access the API solely to manage 
their own accounts may be eligible for free API unit allocations

API operations consume varying amounts of API units, based on the 
complexity of each operation (an operation is considered a single 
action taken upon an AdWords account). For example, requesting the 
status of a single ad group would be considered one operation. In this 
case, this operation would consume one API unit. Requesting the 
status of 1,000 ad groups would therefore utilize 1,000 API units (and 
cost a developer $.25).

Please review the AdWords API Operations Rate Sheet to learn more.

About AdWords API Fees and Billing

Developers are charged at a rate of $0.25 per 1,000 API units 
consumed for their AdWords API usage. The AdWords API system 
assigns different API unit values to different types of operations. While 
some types of operations may consume just one API unit, others may 
consume more. Please view our rate sheet for specific charges per 
operation. And please read our FAQ about credit card billing for the API 
to learn about API billing cycles.

Advertisers who develop API applications solely to advertise their own 
businesses may be eligible for a limited allocation of free API units. API 
developers will be notified if they qualify for the free API unit allocation 
after their registration information has been reviewed.

AdWords API Web Services 

AdWords API Web Services

Objective: Get an overview of the AdWords API data web services. 
While this information will help you develop programs, more 
comprehensive documents can be found on the Google AdWords API 
homepage.

Overview of AdWords API Web Services

The AdWords API provides a set of web services that give 
programmatic access to AdWords accounts. To access AdWords 
accounts programmatically, you build web service clients that connect 
to one or more of the AdWords API Web Services.

AdWords provides the following API Web Services:

CampaignService■
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AdGroupService■
AdService■
CriterionService■
KeywordToolService■
AccountService■
InfoService■
SiteSuggestionService■
TrafficEstimatorService■
ReportService■

AdWords API Campaign Data Services

The CampaignService, AdGroupService, AdService, and 
CriterionService and are collectively known as campaign data services. 
They have operations that let you manage your AdWords campaigns, 
ad groups, ads, keywords, and targeting by making requests using data 
objects, or a list of data objects. In turn, the service typically returns a 
data object or a list of data objects. When creating the data object, you 
set fields on it.

Using batch operations (lists) is more efficient than using a single 
operation. Therefore, we encourage you to use the batch operation 
wherever possible. For example, the CreativeService provides the 
addCreative operation for adding a single creative and the 
addCreativeList operation for adding a batch of creatives. 

Campaigns, Ad Groups, Keywords, and Creatives all have IDs that are 
set by the AdWords API Web Services. Keyword and Creative IDs are 
unique only within their Ad Group, while Campaign and Ad Group IDs 
are globally unique.

About the CampaignService

A campaign is represented by a campaign data structure that has fields 
describing the campaign, such as startDate, endDate, name, status, 
dailyBudget, and so on. To use the CampaignService, you should send 
requests that pass in or return a single Campaign data object or any 
array of them.

The CampaignService lets you create, update, access, list, and perform 
campaign-wide operations such as pausing a campaign or adding new 
ad groups to a campaign. To make updates or perform operations for 
an ad group, use the AdGroupService.

About the AdGroupService

An ad group is represented by an ad group data structure that has 
fields describing the ad group, such as name, status, and maxCPC. In 
addition, it includes an ID that uniquely identifies it.

An ad group consists of a set of keywords and one or more creatives 
(ad text) that are triggered by those keywords. The AdGroupService 
handles all operations that pertain to an ad group as a whole, such as 
creating ad groups, updating ad groups, adding keywords and 
creatives, and getting information from ad groups.

About the CriterionService

The Criterion Service lets you get information about targeting criteria. 
For example, you can get the keywords for a keyword-targeted 
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campaign or the websites for placement-targeted campaigns. You can 
create and modify keyword and webplacement targeting criteria.

About the AdService

The AdService provides operations for accessing, creating and 
modifying ads in an AdGroup. Each ad object is the visual 
representation of an ad. Each ad group has one or more ads, where an 
ad can be of many different formats (such as text ad or an image ad). 

An ad can be in the following serving statuses: enabled, disabled, or 
paused. Only enabled ads will be served; a disabled or paused ad will 
not be served.

Other AdWords API Web Services 

Other AdWords API Web Services

Objective: In addition to the campaign data services,the AdWords API 
offers utility services to help you manage AdWords accounts and to 
assist you in editing campaigns. These utility services are the 
AccountService, InfoService, KeywordToolService, 
TrafficEstimatorService, ReportService, SiteSuggestionService, and 
TrafficEstimatorService. Learn about these services and where to find 
additional help resources. 

About the AccountService

The AccountService provides operations for creating and modifying 
AdWords accounts. The AccountService lets you:

Create and change your login information■
Set the email and language preference ■
Return the billing and currency information of an account■
Set the credit card information ■
Create new AdWords accounts■

For billing and currency information, credit card numbers are not 
returned. You will need explicit permission from Google to make credit 
card edits and to create new AdWords accounts.

About the InfoService

The InfoService allows you to obtain basic information about your API 
usage, including method and operation costs and unit counts.

About the TrafficEstimatorService

The TrafficEstimatorService provides operations that allow you to 
estimate traffic for various components of your AdWords account. 
Using this service, you can estimate traffic for keywords, campaigns, 
and ad groups. 
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About the ReportService

The ReportService allows you to request a report about the 
performance of your AdWords campaigns. It currently supports 
Keyword, Ad Text, URL, and Custom Reports.

The ReportService generates and stores a report in XML format and 
returns the URL of the report. The report is available in the Report 
Center of the AdWords user interface. You can also programmatically 
get the report by downloading the given URL.

Help Resources

The AdWords API homepage provides helpful documentation for 
getting started. This page is constantly refreshed to keep you updated 
on new web services, features, and more. The following resources are 
accessible on this page:

Developer's Guide: Provides information about the AdWords 
API Services, SOAP requests, and more.

■

Developer's Forum: Gives AdWords API developers a place to 
share thoughts, questions, and read posts. 

■

Sample Code: Offers code samples in five programming 
languages. 

■

AdWords API FAQ: Provides answers to commonly asked 
questions about the AdWords API.

■

AdWords API Blog: Used by the AdWords API team to make 
announcements to the AdWords development community.

■

Featured Use Cases: Highlights popular uses for the AdWords 
API.

■

About the KeywordToolService

Each ad group has one or more keywords that are used to trigger an 
ad. The Keyword Tool Service lets you generate keywords based on a 
seed keyword or on the words found on a web page or web site that 
you provide.

About the SiteSuggestionService

The SiteSuggestionService provides operations for getting web site 
suggestions four different ways: by category, topics you define, URLs 
or demographics. For each call, the service returns an array of 
SiteSuggestion data objects; each object includes the URL of the 
suggested site, the approximate number of impressions per day, and 
which types of ads the site accepts (text, image, video). You can then 
target your ads to these URLs by creating placement-targeted 
campaigns. 

Categories are diverse, pre-defined areas, such as "Book Retailers" or 
"Veterinarians." Topics are any words or phrases you specify. 
Demographics target sites for age, household income, gender and 
ethnicity. For example you can ask for sites that target females from 18 
to 34 with incomes over US$24,000. 

AdWords - Contacting Us - Help with other Google products - Change Language: English (US)  
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